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1-1

Introduction

The UNIVERGE OW5000 Configuration Guide provides the information
you need to configure the OW5000 and how to operate the OAI Server,
WatchDog, Log Viewer, and Database operation.

The following topics are included in this chapter:

Chapter Topics o UNIVERGE OW5000 Configuration Guide Overview
e How This Guide is Organized

UNIVERGE OW5000 Configuration Guide Overview

OWS5000 is a collaboration middleware allowing easy application

development in which to communicate with the IP Telephony
environment.

Figure 1-1 OW5000 Applications
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1-2 Introduction

How This Guide is Organized

Chapter 1
Introduction

Chapter 2
OW5000 Configuration

Chapter 3
WatchDog

Chapter 4
Log Viewer

Chapter 5
IM Archive Viewer

Chapter 6
Database Operations

Chapter 7
OW5000-MA4000 Integration

Appendix A
Acronmys and Descriptions

Appendix B
Regular Expressions

Appendix C
Specifications for OW5000
Admin

Appendix D
OW5000 Administrator
Configuration Specification

This chapter outlines how to use the manual including the organization
and chapter layout of the UNIVERGE OW5000 Configuration Guide.

This chapter describes how to operate the OW5000 Administrator
component of UNIVERGE OW5000. The OW5000 Administrator is used
to configure and maintain settings for OW5000 tools and applications.

This chapter describes how to operate the WatchDog component of
OW5000. WatchDog is used to restart OW5000 applications when you
have a failure.

This chapter describes how to operate the Log Viewer component of
OW5000. Log Viewer is used by administrators to view traces of
information produced by OW5000 applications. This includes errors,
warnings, OAI packets, and debug information.

This chapter describes how to manage the Instant Message archive files.

This chapter describes how to operate the database Import Tools for
OW5000. This utility is employed to import ASCII data into the
database.

This chapter describes how OW5000 will integrate with MA4000. The
fields and entities that are imported from MA4000 to OW5000 and the
rules that are applied are also described.

This appendix describes some of the terms used in this manual.

This appendix provides the steps needed to install and uninstall
Microsoft SQL 2008 R2 Express Edition.

This chapter lists the specifications for OW5000 Administrator.

This chapter lists the specifications for OW5000 Administrator
Configuration.

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



2-1

OWS5000 Configuration

Chapter Topics

OW5000 Administrator is a robust OW5000 tool used to configure
OW5000 applications, PBX configurations, and utilities without using the
Windows registry editor directly. It also provides a graphical user
interface to modify OW5000 user account information, PBX
configurations, and database entries. The functions and associated
screen displays for configuring user account information in OW5000
Administrator are described in this chapter.

Specific OW5000 application configurations performed by OW5000
Administrator can be found in each application's installation guide.

OW5000 Administrator provides a view of application information,
database information, and platform information.

The following topics are included in this chapter.

o Verifying the OW5000 Administrator Status
e Logging into OW5000 Administrator
e Maintaining the OW5000 Platform

e Maintaining the OW5000 Applications
e Maintaining the OW5000 Directory

e Application Data Management

e Settings Configuration

e Schedule Configuration

e Template Management

e MA4000 Integration

e Version Information

e Exiting OW5000 Administrator

After changing an OW5000 Configuration, it takes some time before the modification
is available depending on the parameter. Refer to Appendix B for details.

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



2-2 OW5000 Configuration

Verifying the OW5000 Administrator Status

Use the following steps to check the availability of Administrator and to
confirm that the Web server and OW5000 application is running.

Microsoft Windows Server 2003

Step 1 From the desktop, click the Start button and then select Control Panel >
Administrative Tools > Internet Information Services (1IS) Manager.

A Control Panel—Administrative Tools—IIS Manager window displays
(Figure 2-1).

Figure 2-1 Control Panel—Administrative Tools—IIS Manager window

—
E Manage Your Server :gjﬂ My Computer @ Component Services
o Q Computer Management
I Conmiand Prompt g’ Contral Panel U 'i Configure Your Server Wizard

Fﬂf’ Administrative Tools Data Sources (ODBC)
.E Distributed File System
2| Ewent Viewer

1
[/ windows Explorer :
= 7y Printers and Faxes

all Frograms b ( Internet Information Services (II15) Manager
- & Licensing
Log Off E Shut Down @ Local Security Policy

Step 2 Select Web Sites under the (IIS) Manager. A Web Sites Window
displays (Figure 2-2).
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Figure 2-2 Web Sites Window

‘fg File  Action Yiew ‘Window Help

2-3

t Internet Information Services {IIS) Manager M= E3

JREDS]

¢ | AmEFRB(2[(2]r 50

?.5 Internet Information Services
= -1‘5 ADAMA {local computer)
[#-_J Application Paols

B
- - Default web Site

‘] Web Service Extensior

4 |

Description

| Identifier

| state

| Host header value | 1

Default Web Site

1

Running A

2

Step 3

menu.

If the Default Web Site is not Running, select Start from the right-click

Microsoft Windows Server 2008

Step 1

Step 2

From the desktop, click the Start button and then select Control Panel >
Administrative Tools > Internet Information Services (lIS) Manager.

Figure 2-3 Sites Window

Step 3

File  View Help

- A s
' Start Page
-85 GALACTICA32 (GALACTICAZ2\A

----- ‘;? Application Pools
B8]
21§ Default Web Site
¥ {ID_STRING142} O

| aspnet_dient
F-1S# CYGMUS
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Select Sites from the (IIS) Manager. Figure 2-3 displays.

Ggl Sites

Filter: - Go - s
| -~}

Name - | o | status | Bindi

€)Default WebSite 1

Started (htt... *80

If the Default Web Site is not Started, select Default Web Site and click
Start on the right pane under Manage Web Site(Figure 2-4).
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Figure 2-4 Sites Window—Start
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P P51000
3 VCMWebService X =
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« | » E Features View (; \E_ Content View 8 stop -

Logging into OW5000 Administrator

Each time you work with OW5000 Administrator, log in with your
OW5000 login ID and password. If this is the first time you are logging
in to the OW5000 Administrator, use the default login ID admin and the
default password for admin is admin.

When you have finished using the application, you can either log out or
just close your browser.

Step 1 From the desktop, click the Start button and then select All Programs >
NEC OW5000 > Runtime Platform > OW5000 Admin. An OW5000
Admin Login screen displays (Figure 2-7).

= If the screen shown in Figure 2-7 does not display, refer to “Verifying the OW5000
%/ﬁ;\ Administrator Status” on page 2-2, to confirm that the proper services are running.
=
REFERENCE
paad The following security settings for Internet Explorer 6 and 7 are required to use
.;E_P OWS5000 Administrator. The default is Enable for all items.
NOTE

« ActiveX controls and plug-ins - Binary and script behaviors: Enable
» Miscellaneous - Submit non-encrypted form data: Enable
« Scripting - Active scripting: Enable

If you are running Microsoft Windows Server 2003, and you have not added your
—— OWSb000 Server to the Trusted sites zone, a Website Blocked dialog box displays
(Figure 2-5).
IMPORTANT
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Figure 2-5 Website Blocked dialog box

Internet Explorer |
Cantent fram the ‘web zite lizted below iz being
° blocked by the Internet Explorer Enhanced =08

Security Configuration.

http: #feed2owx 2003

[v iCantinue to prompt when Web site content is blocked

Learn more about [nternet Explorer's Enhanced Security Configuration...

IF pou truzt thiz Web site, you can lower security zettings for Add.
the site by adding it ta the Trusted sites 2ane. [F pou khow =
thiz Web site iz on your local intranet, review help for

inztructions on adding the site to the local intranet zone

instead.

Impartant; adding thiz web site to the Truzted sites zone will lovser the security
zettings for all content from this web site for all applications, including Internet
E «plorer.

Step 2 Click Add. A Trusted Sites dialog box displays (Figure 2-6).

Figure 2-6 Trusted Sites dialog box

‘ou can add and remove Web sites From this zone, All Web sites
in this zone will use the zone's security settings,

Add this Web site ko the zone:
| http: fised2owx2003

Web sites;

hktps f ¥, update, microsoft, com - REmOyE |
https: (. update. microsoft.com

hktp: * windowsupdate, microsoft, com
http:ffoca.microsoft.com

https: ffoca, microsoft, com

httos ffupdate  microsoft, com LI

¥ Require server verification fhttps: For all sites in this zane

Close |

Step 3 Uncheck Require server verification (https:) for all steps in this zone
and then click Add to include this Web site in the Trusted sites zone.

Step 4 Click Close. An OW5000 Administrator Login dialog box displays
(Figure 2-7).
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Figure 2-7 OW5000 Admin Login screen

OW5000 Administrator

Laogin 1D:

Password:

Step 5 Enter your login ID in the Login ID field.

gonss The login ID is admin.

Step 6 Enter your password in the Password field.

P37 The password for admin is admin. This password can be changed. Refer to “User
= Management Configuration” on page 2-100.
NOTE

Step 7 Click Login.

= If an error message describing a problem connecting to the OW5000 Administrator
S\/?;‘/é Service displays, refer to “Verifying the OW5000 Administrator Status” on page 2-2, to
= confirm that the proper services are running.
REFERENCE
P33 If there is no activity for 15 minutes (default), the Administrator login page displays
é and re-login is required. After login, a pre-configured page displays.
NOTE

After the initial login, you are required to change your password to a strict
password (Figure 2-8).
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Figure 2-8 Change Password

Change Password

* New Password: | |

* Confirm New |
Passwaord:

(Hint: The Password must be at least 8 characters long, must have
at least 1 Uppercase lefter, 1 Lowercase lefter, 1 digit and 1 special
character (excluding space, square brackets, backslash and
single/double quotes.)

Change P:

Notice: In instances where OWS000 exists in an environment with other UCE
products, please note that this enly changes the Admin password for the
OWS000 platferm. For environments requiring the unified configuration of the
Admin accounts, please see the documentation that pertains to NEC CAS.

Step 8 Enter a new password in the New Password field. The length of the
password must be at least eight characters long and include the
following rules:

—1 Uppercase letter (A-Z)

—1 Lowercase letter (a-z)

—1 Digit(1-9)

—1 Special Character (excluding a space, square brackets, backslash,
and single or double quotes)

Step 9 Enter the new password again in the Confirm New Password field and
click Change Password. Figure 2-9 displays.

Figure 2-9 New Password Login

OW5000 Administrator

Login ID: |admin |

Password: | |

Step 10 Enter the new password and click Login. Figure 2-10 displays.
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Figure 2-10 OW5000 Administrator Control Panel

NEC %5355 s

OW5000

Trial Period

Selecting OW5000 from the OW5000 Administrator Control Panel
displays an OW5000 Options dialog box (Figure 2-12).

After installing the OW5000, almost all of the licenses are available on a
trial basis for 90 days after adding the first extension information in
OW5000 Administrator. The following applies to the trial license.

e The expiration date is displayed beside the OW5000 Administrator
Control Panel (Figure 2-11).

o All trial licenses are inactivated once the expiration date has passed.
e All trial licenses are inactivated once the official license is installed.

Figure 2-11 Trial Period dialog box

NEC 3&‘5000 OWS000 Administrator is running under Trial License period valid until: 7/24/2009 9:55:18 AM

Log Out

OWws000

Figure 2-12 OW5000 Options dialog box

NEC 85355

Platform

Applications
Directory
Application Data
Settings
Scheduler

Templates
MA4000 Integration

Version Information

P If your sales region is outside the U.S., Figure 2-12 may look different for your sales
= region.
NOTE
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Refer to the following sections for more information on configuring
OwW5000.

Maintaining the OW5000 Platform
Maintaining the OW5000 Applications
Maintaining the OW5000 Directory
Application Data Management
Settings Configuration

Schedule Configuration

Template Management

MA4000 Integration

Version Information

Exiting OW5000 Administrator

The parameters described in OW5000 Administration may be different depending on
= your sales region settings.

The table below describes icons used in the OW5000 Administrator
(Table 2-1).

Table 2-1 Icon Descriptions

Icons Description

5? Edit the current data
ﬁ, Delete the current data

Assign/Update the data without leaving the current page.

Assign/Update the data and continue to assign another entry
Apply & Add Mew without leaving the current page.

Cancel all non-updated data and return to the list page

Assign/Update the date and return to the list page

Sort by ascending order for the parameter

Sort by descending order for the parameter
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Icons Description

H Sets the display page number/display lines in a page.

Up priority.

el

Down priority

¥
% Do not use the Back, Forward, Refresh button, or the Enter key after logging into
OW5000 Administrator.
NOTE
pa33) If an error displays while using OW5000 Administrator, read the information carefully.
§ If necessary, please go back to the login window and log in again.
NOTE
gonas) An asterisk (*) indicates a mandatory parameter.
NOTE
gonss By default, 20 items are listed on one page. This can be increased to a maximum
= 100 items per page.
NOTE

Only the Version Information page can show a maximum of 600 items.

Maintaining the OW5000 Platform

Selecting Platform from the OW5000 Options dialog box

(Figure 2-12), displays an OW5000 Platform Configuration dialog box
(Figure 2-13).

The following topics are included in this section:

e Access Control Management

e Conference Bridge Management
e Extension Management

e [icense Management

e Configuring the Pager Providers
e PBX Configuration

e Routes/Trunks Configuration

e Serial Ports Configuration

e Configuring Voice Mail Servers
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Figure 2-13 OW5000 Platform Configuration dialog box

NEC W55

Platform »
Applications 3
Directory 3
Application Data

Settings

Scheduler

Templates
MA4000 Integration

Version Information

Access Control
Conference Bridge
Extensions
Licenses

Pager Providers
PBXs
Routes/Trunks
Serial Ports

Voice Mail Servers

The parameters described in OW5000 Administration may be different depending on

your sales region settings.
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Access Control Management

Selecting Access Control from the OW5000 Platform Configuration
dialog box (Figure 2-13) displays an Access Control dialog box
(Figure 2-15).

Use this option to configure or add a SIPUA Group, to configure Group
Access Control, and to configure PBX Access Control. This functionality
is available only for the SIP Presence feature. By using this
configuration, the access control of presence can be assigned per SIPUA
group or PBX(Office Code).

An example of SIP Group Access Control is shown in Figure 2-14.

Figure 2-14 SIP Group Access Control

PBX #1 PBX #2
Office Code : 20 | T,
.“llllll-. - “ .‘ .}\ E
H g [ = P H . &0
R = = & &
E OfficeCoge:21 EPBX#3 ;
HNE K¢ : 0N
0.-----:---" \ Executive
Engineer Group
Watcher Group Presentity Group Access
Engineer Group Executive Group Deny
Executive Group Engineer Group Allow

Watcher means the user who refers to the presence of others.
Presentity (Presence Entity) means the user who provides its
presence. As shown in Figure 2-14, the presence of users belonging to
the Executive Group cannot be seen from the Engineer group users.

All access between each person is available if they are in the same
SIPURI Group.

If access is set to denied as the Office Code based access control, the
user cannot see the presentity, even if the Group based access control
is set to allow.

If the terminal does not belong to a group, the terminal accepts
reference from all other terminals.

If access is set to denied as the Group based access control, the user
cannot see the presentity, even if the Office Code based access control
is set to allow.
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o If the terminal does not belong to a group, the terminal accepts
reference from all the other terminals.

¢ In federation environment, all OW5000 systems should have the
following settings. If not, Access Control may not work correctly.

e Use same SIPUA group name
¢ Access Control between SIPUA group should be the same
¢ Do no use PBX Access Control

SIPUA Group

Figure 2-15 Access Control dialog box

Access Control Management

SIPUA Group Group Access Control PBX Access Control
Add New Group
1-1of 1 records[10 B Results per page Page[1 | of1
Group Name & Default Denied
;7 jim) Burnz I}
1-1of 1 records[10 B Results per page Page[1 |l of1

To add a new SIPUA Group, click Add New Group. A SIPUA
Group—Add New dialog box displays (Figure 2-16).

Step 1

Figure 2-16 SIPUA Group—Add New dialog box

* Group Name:

Deny as Default: []

Step 2 Type the Group Name in the text box.

Step 3 Click the checkbox to select Deny as Default if you do not want to
display the presence of the user who belongs to this group.

Step 4 Click Apply to accept the new group or Cancel to exit without adding a
new group.

Step 5 To edit or delete a SIPUA Group, click the Pencil # icon or the

Trashcan @ icon. A delete confirmation dialog box displays to confirm
deletion.
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Group Access Control

Selecting Group Access Control from the Access Control dialog box
displays a Group Access Control dialog box (Figure 2-17).

Figure 2-17 Group Access Control dialog box

SIPUA Group Group Access Control PBX Access Control

& Show Allow List
" Show Deny List

1-100f12 records Results per page

Watcher Group Name &

Page(t JEorz > =

Presentity Group Name

jim) Barney Service King
jim) Barney Mot &ssigned
jim) Barney Jenny
jim) Jenry Service King
jim) Jenry Mot Assigned
jim) Jenry Barney
jim) Mot Assigred Service King
jim) Mot Assigred Jenny
jim) Mot Assigred Barney
jim) Service King Mot &ssigned

1-100f12 records Results per page

Page(t JEorz > =

Step 1  Select the desired radio button to Show Allow List or Show Deny List.

Step 2 To delete a Group Access, click the Trashcan @ icon next to the desired
group. Confirm the deletion when the dialog box displays. If a watcher

group is deleted in the Allow List, the group moves to the Deny List. If a
watcher group is deleted in the Deny List, the group moves to the Allow

List.

PBX Access Control

Selecting PBX Access Control from the Access Control dialog box
displays a PBX Access Control dialog box (Figure 2-18).

Figure 2-18 PBX Access Control dialog box

SIPUA Group Group Access Control PBX Access Control

@ Show Allow List
(O Show Deny List

Step 1

1-20f2 rec-:rdS!Zn_] Results per page

1-2 of 2 records 20 B Results per page Page:llEﬂ of1
Watcher PBX Name & Presentity PBX Name

jinj Dallas PEX SVTK-44

i SVTK-44 Dallas PBX

Page]1 |Eof1

Select the desired radio button to Show Allow List or Show Deny List.
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Step 2 To delete a PBX Access Control, click the Trashcan @ icon next to the
desired PBX Name (Figure 2-18). Confirm the deletion when the dialog
box displays. If a watcher PBX is deleted which is in the Allow List, the
PBX moves it to the Deny List. If a watcher PBX is deleted which is in
Deny List, the PBX moves it to the Allow List.

Conference Bridge Management

Selecting Conference Bridge from the OW5000 Applications Options
dialog box (Figure 2-13) displays a Conference Bridge Management
dialog box (Figure 2-19).

A conference bridge allows users to conference with more than three
parties. The conference bridges are typically 8 or 16 ports and one caller
can be on each port.

Special Conditions of Conference Server

Please note the conditions below for Conference Server when
programming the PBX to conference with four or more parties.

There are several ways to configure the bridges for conference, but
these are the operations the Conference Manager requires and the
conditions it expects them to work under.

e Do not allow the PBX to move a caller to another port when the port is
busy.

e Turn off the ringback suppression feature of the PA-CFTB conference
card by setting Element 3 to the off position on Switch 1.

If the PBX is programmed for four or more parties to be used for
OW5000 UC Conference Server, the application must be used; it cannot
be done manually. If the bridge is not setup this way, the Conference
Server will not work for a conference of four or more parties. For more
information on how to program the PBX for four or more parties, please
refer to the PBX programming guide for each PBX type.

Follow the steps below to configure Conference Bridges:

Figure 2-19 Conference Server Options dialog box

Conference Server

PBX: I SV7000-44 'l

BRIDGES:

Add New Bridge

here are no bridges for this PBX.
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Conference Bridges

Step 1 To add a bridge, click Add New Bridge. Step 1 displays.

Figure 2-20 Conference Bridges dialog box

Conference Server

PBX:

ADD BRIDGE

* Bridge Name: |ConfBridge
*Tenant: 1~
Is Host Controlled:

pOlEY Add Port

Ports Pilot Number
1000 Set Pilot Number

i)
W 1o0m Set Pilot Number
T 1002 Set Pilot Number

Cancel

Step 2 Enter the Bridge Name.

Step 3 In the Tenant field, enter the number of the new tenant.

Only one tenant number is allowed per bridge. So, this Tenant number is applied to
all conference bridge ports for this bridge.

Step 4  If this conference bridge is used with the UC700 host controlled voice
conference feature, click the check box for Is Host Controlled.

Is Host Controlled parameter displays only when UC700 server is installed

Step 5 If there are no ports available, enter the port number and then click Add
Port. All ports for the PBX conference bridge must be configured.

Step 6 Select at least one Pilot number from the assigned ports by clicking the
Set Pilot Number link. The first assigned port is selected as the pilot
number as the default.

Step 7 Do one of the following:

—Click Apply to save the changes.
—Click Done to save the changes and exit the dialog box.
—Click Cancel to exit without saving the changes.
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Extension Management

Selecting Extensions from the OW5000 Platform Configuration dialog
box (Figure 2-13) displays an Extensions Management dialog box
(Figure 2-21).

Figure 2-21 Extensions Management dialog box

Extension Management

Add New Extension

Filter: PBX: <All>

1-10 0f 505 records |10 | Results per page

J @
J &
J @
4@
J &
J @
J @
J &
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4@

PBX

SVT000-4
SWT000-4

= 8

SWT000-44
SVT000-44
SWT000-44
SWT000-44

SVT000-4
SWT000-4
SVT000-4
SVT000-4

5 5 5 &

1-10 of 505 records |1p

Range Delete

Extension &
10M

1002

1906

1807
2000
2001
3000
3001

3992

B Results per page

URI format

*  Number: Stars With «

Tenant

1
1
1
1
1
1
1
1
1
1

Page{1 |[@of51 > >»

SIP URI E164 Humber
1001 @sip.necinfrontia.com

1002@sip.necinfrontia.com

2000@necinfrontia.com

2001 @necinfrontia.com

3999@sip.necinfrontia.com

Page[1 |@ors1 » >

From the Extensions page, you can search for an extension, add a new
extension, edit an existing extension, or delete an existing extension. To
sort the columns in ascending or descending order, click the column

headings.

Searching for Extensions

Step 1  Select a PBX from the drop-down list in the Filter field and click Search.

You can also search by Number by clicking in the drop-down list and
choosing Starts with, Contains, Ends With, or Equals, and then
entering a value in the text box and pressing Search.

Wild card “*” is not required. To display all extensions after you have
filtered them, leave the text box blank and click Search again.
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Adding Extensions

Step 1 To add an extension, click Add New in the Extensions dialog box
(Figure 2-21). An Add New Extension dialog box displays (Figure 2-22).

Figure 2-22 Add New Extension dialog box

Extension Management

*PBX: SVT000-44 -
* PhoneType: DTerm -

*Tenant: 1 ~
Country: United States of America (1) -
DID Mumber: |
telURI:
SIPURI:
SIP Access Server Mot Assigned -
Collaboration:
Is Monitored: [7]
Sublines: I:l

here are no sublines defined |

Apply & Add New Apply Cancel

Step 2 Enter the Extension number.

P33 Fields which must be completed are designated with an asterisk (*).
NOTE
gonss) Enter a private number for an IP Centrex environment.
NOTE
Step 3 Select a PBX from the drop-down list.
Step 4 Select the PhoneType from the drop-down list. PhoneType options are
listed below:
—Dterm
—Analog
—Mobility
—PS
—SIMPLE (used for SIMPLE terminal)
—SP30(SIP) (used for SIP protocol softphone)
—VOoWLAN (used for MH2XX terminal)
gonss Select Dterm as a Phone Type in the case of a Dterm (Protims Mode, SIP Mode) and
= a SP30 (Protims Mode).
NOTE
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Select the Tenant number from the drop-down list.

Select the Country from the drop-down list.

Step 7 Enter the DID Number.

pA3%) Country and DID Number is for the US Market only.

Step 8 Enter the telURI (used for LCS/OCS Integration only). Refer to the
UNIVERGE OW5000 Installation Guide, OW5000 Remote Call Control
Service, or related documentation for more information.

If the URI format in set in the URI format page, the telURI is generated
automatically by clicking the Auto Input button.

If the URI format is not configured, nothing displays, even if you click the
Auto Input button.

Step 9 Enter the SIPURI for this extension.

pa33) This field is required if you are using the SIP presence feature. It is unique per PBX
= and consists of XXXX@domain name. Normally, XXXX is the same as the extension
number and the domain name must be the same as the name, which is assigned by
the PBX. For example, 12345@unified.com.

If the URI format in set in the URI format page, the SIPURI is generated
automatically by clicking the Auto Input button.

If the URI format is not configured, nothing is displayed even if you click
the Auto Input button.

Step 10 Select the SIP Access Server from the drop-down list. Select the proper
Access Server for the SP30 (SIP) and the VoWLAN terminal, and select
Presence Gateway for any other type.

P This field is required if you are using the SIP presence feature. If the SIP presence
= feature is not required, select Not Assigned.

Step 11 Select whether or not Collaboration is enabled for your phone to be a
handset of the Dterm SP30. If this flag is set, the presence for this
terminal is aggregated with the terminal selected from the drop-down list.
Please do not configure when the Microsoft LCS/OCS Integration and
SOAP (Call Control) APl is used.

P33 Before setting the Collaboration, the Extension configuration for the handset must
= be configured.
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Step 12 Select whether or not this extension Is Monitored by clicking in the
check box.

Is Monitored must be checked in the following case:

= * Use presence for non SIP terminal
« Get history via OW5000 API (Call Control), OW5000 API (Call Notification), and
NOTE OWS5000 (Information API)

Refer to the documentation for each OW5000 related application.

Step 13 Enter the number for a subline, then click Add Subline to assign a
subline.

Step 14 Do one of the following:

—Click Apply to save the new extension.

—Click Apply & Add New to save the new extension and keep adding
another extension. (PBX, Phone Type, Tenant, and the SIP Access
Server configuration, used in the previous data, are continuously
displayed.)

—Click Done to save the new extension and return to the list page.

—Click Cancel to discard all changes and return to the list page.

If IsMonitored is enabled for an extension that does not exist, it causes extra traffic
between the PBX and the OW5000 system. When the PBX setting is changed,
please update the OW5000 configuration also.

IMPORTANT
Table 2-2 describes the required parameters for each function.

Table 2-2 Parameter Requirements

OW5000 API  OW5000 API

OWS5000 API e . LCS/OCS  SIP Presence
(Call Control) teal !‘lotlflca- fiteimaten Integration Configuration
tion) API)
Extension X X X X X
PBX X X X X X
Phone Type X X X X X
Tenant X X X X X
Country X X X X
DID Number
telURI X
SIPURI X
SIP Access X
Server
Collaboration
Is Monitored
Sublines
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Note: Is Monitored must be checked in the following case.
-Use presence for non SIP terminal
-Get history via OW5000 API (Call Control), OW5000 AP (Call Notification), and OW5000
(Information API). Refer to the documentation for each OW5000 related application.

= A subline must be configured only when the call log for subline is required.

Editing or Deleting Extensions

Step 1 To edit an extension, click the Pencil / icon next to the desired
extension (Figure 2-21).

Step 2 After making the necessary changes, do one of the following:

—Click Apply to save the new extension.

—Click Apply & Add New to save the new extension and keep adding
another extension. (PBX, Phone Type, Tenant, and the SIP Access
Server configuration, used in the previous data, are continuously
displayed.)

—Click Done to save the new extension and return to the list page.
—Click Cancel to discard all changes and return to the list page.

Step 3 To Delete an extension, click the Trashcan @ icon next to the desired
extension.

Range Delete

Use the following steps to delete a range of extensions.

Step 1 Click Range Delete from the Extension Management dialog box
(Figure 2-21).

Figure 2-23 Range Delete dialog box

SELECT THE RANGE OF EXTENSIONS TO DELETE

* PBX: INECF'EIJ‘H vl
* Tenant: |1 "I

* Starting Extension:

* Ending Extension:

Step 2 Select the PBX and Tenant number from the drop-down list.

Step 3 Enter the Starting Extension and Ending Extension in the text boxes.
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Step 4 Click Delete. Depending on the number of extensions you are deleting,
this may take several seconds or minutes.

A maximum of 500 extensions can be deleted at a time.
During business hour, some extensions may not be deleted if the extension is in use.
In this case, try Range Delete again after business hours.

URI format

Selecting URI Format from Figure 2-21 displays a URI Format dialog box
(Figure 2-24).

Figure 2-24 URI Format dialog box

URI Format Configuration

TELURI FORMAT

Extension Pattern
regular expression (50) :

([0-9*#]{1.16})5
Translation pattern :

SIPURI FORMAT

Extension Pattern
regular expression (50) :

([0-9°]{1,161)3

Translation pattern :

By configuring this translation rule correctly, telURI and SIPURI can be
created easily using the Auto Input button.

Extension pattern regular expression (for telURI)

Defines the target extension range using the regular expression. Default
is ~([0-9,#,*]{1-16})%$and indicates that all extensions are allowed by
the PBX. Refer to Appendix C for more information on the regular
expression.

Translation pattern regular expression - (for telURI)

Defines the translated pattern (telURI) in this filed. The extension is
treated as $0.

Example of setting:
Extension pattern regular expression: ~([0-9,#,*]{1-16})$
Translation pattern regular expression: $0:phone-context=nec.com
Extension number: 5000
Translation result of telURI: 5000:phone-context=nec.com
Extension pattern regular expression (for SIPURI)
Translation pattern regular expression - (for SIPURI)

Auto translation configuration for SIPURI. All specifications are the same
as telURI.
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License Management

Selecting Licenses from the OW5000 Platform Configuration dialog box
(Figure 2-13) displays a License Management dialog box (Figure 2-25).
Use this option to Enable PBXs, to Enable Extensions, and to display
the Licensed Information.

paY PBX Configuration and Extension configuration must be done before this license
= configuration.
NOTE

For the US, Australian and European markets, you must first configure
the License Manager IP Address and the Port information in the

OW5000 Administrator, on the OW5000 > Settings page, General
Settings tab. Refer to the OW5000 Installation Guide for more details.

Enable PBXs

Follow the steps below to enable PBXs.

Figure 2-25 License Management dialog box

License Management

Enable PBXs Enable Extensions Licensed Information

Total  Ent.
Installed 21 21
Current 0 0
1-10f 1 records[10 [ Results perpage Page[y | of1
PBX Hame & IP Address Enabled Is UGN
SVT000-44 172.24.133.44 r No

1-10f 1 records[10 | Results per page Page[t @ of1

Step 1 Click the Enable PBXs tab to select the desired PBX.

Step 2 To disable a PBX that is enabled, click to remove the check mark.
Step 3 Click Apply.

gonss « If the PBX license is inactivated, the Extensions license belonging to the PBX is
= also inactivated.
NOTE

« Installed and Current license is displayed at the top of the Enable PBX dialog box

(Figure 2-26). Ent. license indicates the number of licenses not used by SV8300/
IPS.
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Enable Extensions

Selecting Enable Extensions from Figure 2-25, displays a License
Management—Enable Extensions dialog box (Figure 2-26).

Figure 2-26 License Management—Enable Extensions dialog box

Enable PBXs Enable Extensions Licensed Information

PRESENCE APl
Total Ent. Total Ent.

Installed 10000 10000 10000 10000
Current 0 0 0 0

PBX: SV7000-44 ~«

Search:| |
Check All: [[] PRESENCE [C] API
1-40f4 recordsa Results per page Page B of 1
Extension & PRESENCE API
4000 =] [
4001 ] O
4002 =] [
4005 O [
1-40f4 recordsa Results per page Page B of 1
Please note the license type below:
API Client license. Set for all extensions that are controlled by

the OW5000.
PRESENCE SIP Presence
Refer to the Getting Started Guide.

Step 1  Select the PBX from the drop-down menu or enter a PBX name and then
click Search.

Step 2 To enable extensions, click in the desired PBX check box.

Step 3 Click Apply to save the changes.

gonss In Figure 2-26, the Current row displays the number of licenses already assigned.
é The Ent. (Enterprise) row displays the licenses, except for those assigned to the
IPS.
NOTE
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Licensed Information

This page displays the current number of licenses in a system and only
the region using License Manager.

Selecting Licensed Information from Figure 2-25, displays
Figure 2-27.

Figure 2-27 does not display when Asia is selected as the Sales Region.

NOTE

Figure 2-27 Licensed Information dialog box

Enable PBXs Enable Extensions Licensed Information

1-200f31 remrdsﬂ Results per page Page.ﬂ of2 » >>
License A Code Total Licenses(PBX) Total Licenses(Server) Used Licenses{Server)
5000 CLUSTER License CLSTER 0 0
5000 LCS/OCS System License RCCZ45 o o
5000 PBX2000 APl License APCL20 0 0
0WS5000 PBX2000 ICA License ICARZ0 0 0
W5000 PBX2000 ICA Multi Mode License ICHLZ20 0 0
5000 PBX2000 LDAP License LDAPZ0 0 0
5000 PBX2000 LSI License LSIR20 0 0
W5000 PEX2000 LS| Mutti Node License LSML20 0 0
0WS5000 PBX2000 Multi Node License APML20 0 0
W5000 PBX2000 USP System License UsP20s 0 0
5000 PBX2400 APl License APCL24 15000 0
5000 PBX2400 ICA License ICARZ4 1 0
5000 PBX2400 ICA Mulii Node License ICML24 0 0
5000 PBX2400 LDAP License LDAP24 1 1
5000 PBX2400 LSl License LSIR24 1 0
5000 PBX2400 LS| Multi Node License LSML24 0 0
5000 PBX2400 Multi Node License APMLZ4 20 0
5000 PBX2400 SOAP License SOAP24 0 0
5000 PBX2400 USP System License USP245 0 0
0W5000 Platform License RUNTIM 1 1
1-200f 31 rec-:r-jsﬂ Results per page Page‘ﬂ of2 » =

Licenses - This field is sortable.

Total Licenses (PBX) - This field is sortable and indicates the total
licenses in a system using the same PBX as the LMS host PBX. For
example, if three OW5000 servers are connected with the same LMC, all
administrators can see the same number of total licenses from the
Admin License Management page.

Total Licenses (Server) - This field indicates the total number of
licenses assigned to this server. This is assigned at the LMC web page.

Used Licenses (Server) - This field is sortable and indicates the used
licenses in a system using the same PBX as the LMS host PBX. For
example, if three OW5000 servers are connected with the same LMC, all
administrators can see the same number of used licenses from the
Admin License Management page.

X Record - This sets the maximum record on a page.
X Page - This sets the target page to be displayed.
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Configuring the Pager Providers

The Pager Providers option allows a user to receive a real page on
their pager. Each provider has their own settings in order to contact
their subscribers. Use the steps below to setup Provider information:

Step 1 Select Pager Providers from the OW5000 Platform Configuration dialog
box (Figure 2-13). A Pager Providers Management dialog box displays
(Figure 2-28).

pa3%) Displays only when the United States is selected as the Sales Region.

NOTE

Figure 2-28 Pager Providers Management dialog box

Fager Provider Management

Add MNew Pager Prowvider
1-10f1 recards Results per page Page[1 | of1
Name & TAP Dialup (1-Way) TAP Dialup (2-Way) SNPP Host Name Port Message Length
;5? M Sky Link 4444 240
1-10f1 recards Results per page Page[r [ or

Step 2 Click Add New Pager Provider. A Pager Provider—Add New dialog box
displays (Figure 2-29).

Figure 2-29 Pager Providers—Add New dialog box

Pager Provider Management

* Name: ||

TAP Dialup (1-Way): | |

TAP Dialup (2-Way): | |
SNPP Host Name: | |

Port (Mumber):
Message Length:

Cancel

Step 3 Enter the Name of the Provider (required).
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Step 4 Enter the number in the TAP Dialup (1-Way) field.

gonas) If you use TAP (Telocator Alphanumeric Protocol), either a customer provided TAP
é Server must be attached to the OW5000 Server via a serial connection; or a modem
attached to a serial port is needed. Using either option, a serial port must be
NOTE configured.

Step 5 Enter the SNPP Host Name.
Step 6 Enter the Port (Number).
Step 7 Enter the Max Length.

Step 8 Click Apply to save the information and then click Done to close the
dialog box, or click Cancel to exit without saving the information.

Step 9 To Edit or Delete a Provider, click the Pencil / or Trashcan @ icon.

PBX Configuration

Selecting PBXs from the OW5000 Platform Configuration dialog box
(Figure 2-13) displays a PBX Management dialog box (Figure 2-30). If
PBXs have previously been added, a list of all configured PBXs displays.

Figure 2-30 PBX Management dialog box

FEX Management

Add MNew PBEX

1-10f1 records |20 |l Results per page PagelT |l ot
PBXName & |IP Address Office Code PBX Type Split Call Forward RMI Bind Name

ﬂ M NECPEX1 1722413344 30 UNIVERGE SwFoon [T QAlServer MECPERX1

1-10f1 records |20 |l Results per page PagelT |l of1

The PBX Management dialog box allows you to add, edit, or delete
PBX Settings, Locations, Area Code Rules, PBX to PBX Dialing, and
Reserved Numbers.

The PBX must be configured based on the following rules:

¢ Assign per PBX in the case of the CCIS network

e Assign only one PBX (OAI node) for a fusion network environment
(non IP Centrex)

¢ Assign per UGN for an IP Centrex environment, even a fusion network
environment

¢ Assign only one PBX (OAI node) in the case of a LCS/OCS integration
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Adding a PBX Configuration

Clicking Add New PBX from the PBX Management dialog box displays a
PBX Configuration—Add New dialog box (Figure 2-31).

Figure 2-31 PBX Configuration—Add New dialog box

99 Current:

* PBX Name: | |
* IP Address: Ii |
* Office Code (PBX Id):
* Client/Server Port: 44002 ~

* PBX Type: MNEAX 2400 IMS - Internal =
Special Dial Code: Mone -
Split Call Forward: []
Locations: | Mo Locations
Pbx Reconnect Delay: 30 ~
Heartbeat Timeout: 128 -
UGN (User Group Number): [
Prefix

SIP SewverIP Address | |[5060 |

PBX Settings

When adding a new PBX Configuration, the first dialog box to display is
PBX Settings.

Step 1 Enter a Name for the PBX in the PBX Name field. This is a label used to
identify the PBX. It is displayed in various list boxes to identify the
location of extensions, and therefore should most likely be made to
describe the site where it is located. Once the PBX name is saved, it
cannot be changed.

Step 2 Enter the IP address of the PBX in the IP Address field (XXX.XXX.XXX.XXX.
If you do not know the PBX IP address, contact your local PBX system
administrator. Determining the IP address of your PBX depends on the
particular type of PBX selected, as shown in (Table 2-3). If you are using
a NetFusing system, enter the IP Address where IP (OAl Interface
Processor) is enabled.
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Table 2-3 PBX IP Address Locations

PBX Type IP Address Location

NEAX 2000 IPS CM0B00
NEAX 2400 IMS - Internal ADTM command
NEAX 2400 IPX ADTM command
SV7000 ADTM command (TP server address)
SV7000 MPS ADTM command
UNIVERGE SV8300 CM0B00
UNIVERGE SV8500 ADTM (LAN2:default)

Table 2-4 Region-based PBX Name

Japan United States Europe Australia Asia (other)
UNIVERGE UNIVERGE UNIVERGE UNIVERGE
UNIVERGE SV7000| g\, 7000 SV7000 SV7000 SV7000
UNIVERGE SV7000|{UNIVERGE ) UNIVERGE UNIVERGE
TypeSS SV7000 MPS SV7000 MPS SV7000 MPS
UNIVERGE UNIVERGE NEAX _ UNIVERGE NEAX |UNIVERGE NEAX
APEX7600i 2400 IPX 2400 IPX 2400 IPX
UNIVERGE UNIVERGE NEAX |UNIVERGE NEAX |UNIVERGE NEAX |UNIVERGE NEAX
APEX3600i 2000 IPS 2000 IPS 2000 IPS 2000 IPS

NEAX 2400 IMS -
Internal

UNIVERGE SV8300|UNIVERGE SV8300UNIVERGE SV8300|UNIVERGE SV8300{UNIVERGE SV8300
UNIVERGE SV8500|UNIVERGE SV8500[UNIVERGE SV8500[UNIVERGE SV8500{UNIVERGE SV8500

Step 3 Enter the PBX ID for the PBX in the Office Code (PBX Id) field. This is
the PBX’s office code. This ID is used by applications to match
extensions provided in OAI messages sent from the PBX with a given
extension in the OW5000 Database. This ID uniquely identifies the PBX
and is critical in a CCIS environment that does not have a unique
numbering plan (where extensions can have the same number in more
than one networked PBX). If you are using a Stand-alone system, 1 is
recommended as the Office Code.

Step 4 Select an available Client/Server Port from the drop-down list. This port
is used by remote applications to communicate with the OAI Server
using TCP/IP. Choose a value in the range 44000-44099, that does not
conflict with other programs or configured PBX's using that value. It is
possible to type 'netstat -a -n' from a DOS command prompt to see ports
already in use.

Step 5 Select the PBX Type from one of the options in the PBX Type drop-down
list. It is important to select the correct type because applications rely on
this information for both licensing and functionality.
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Step 6

Step 7

Step 8

Step 9

Step 10
Step 11

Step 12

Step 13

Select the Split Call Forward check box if this feature is configured on
your PBX. Split Call Forwarding enables Dterm telephone users to set
different call forwarding patterns for internal versus external calls.

Select a Location from the drop-down list. The location must be
configured before this step. For more information, see “Locations” on
page 2-32.

Select the proper Pbx Reconnect Delay time from the drop-down list.
This parameter is a delay timer and determines how much time should
pass until the next reconnect request is sent to the PBX when the
OW5000 realizes a disconnection between the server and the PBX.
Default value is 30 seconds.

Select the proper Heartbeat Timeout value from the drop-down list. This
is a parameter which indicates the heartbeat timeout between the server
and the PBX. Default value is 128 seconds.

Check the UGN (User Group Number) if the IP centrex feature is used.

Enter the Prefix number. This parameter typically consists of Access
Number + Office Code (PBX ID). This parameter is mandatory in multi-
PBX systems to identify the same extension number. This parameter is
not required for a closed network system.

Enter the SIP Server IP Address (Port). The IP Address of SP must be
assigned in this edit box for SV7000 and SR-MGC. Enter the SIP-BOX
IP address for the IPX and IPS. All SIP Server IP addresses must be
entered if there is more than one SIP Server. In the VRRP environment,
both physical and logical IP addresses must be entered. The Default Port
number is 5060 for SP. Set Act side IP Address of LAN1 for SV8500
system. Set 3 IP Addresses (Act type,type 0 and 1) of IP Address for a
redundancy system.

Click Add to add a port, or Remove to remove a port.

UGN, Prefix, and SIP Server IP Address (Port) fields are needed for the SIP
Presence function.

Step 14

Do one of the following:

—Click Apply to save the information.
—Click Done to add the PBX Configuration and close the dialog box.
—Click Cancel to exit without saving the new PBX configuration.
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Editing PBX Configurations
Use the following steps to edit an existing PBX configuration.
Step 1 Click the Pencil / icon next to the desired PBX configuration

(Figure 2-30). A PBX Configuration—Edit dialog box displays
(Figure 2-32).

Figure 2-32 PBX Configuration—Edit dialog box

a’ Current: SV7000-44

PBX Settings

Locations AreaCode Rules PBX — PBX Dialing Reserved Numbers Voice Mail Pilot Numbers

L
* PBX Mame: [
*IP Address: m
* Office Code (PBX Id)- 30
* Client/Server Port: 44000 =
*PBX Type: UNIVERGE SV7000 -
Special Dial Code: Mone -
Split Call Forward: [7]
Locations: | No Locations
Pbx Reconnect Delay: 30 ~
Heartbeat Timeout: 128 ~
UGN (User Group Number): [7]
Prefix
SIP Server IP Address ][5060

Step 2 The PBX Name is displayed for informational purposes only and cannot
be changed because it is a unique identifier for the PBX.
Step 3 After changing the parameter, do one of the following:

—Click Apply to save the information.

—Click Done to add the PBX Configuration changes and close the
dialog box.

—Click Cancel to exit without saving the changes.

Ifthe UGN (User Group Number) is set with the same SIP Server which has the

= same IP Address for multiple PBXs having the same IP Address, the IP Address for
the PBX cannot be changed. To change the IP Address, delete all IP addresses of
NOTE the SIP Server IP Address and then change the PBX IP Address.

Deleting PBX Configurations
Use the following steps to delete an existing PBX configuration.

Step 1 Click the Trashcan @@ icon next to the PBX configuration you wish to
delete (Figure 2-30). A Delete PBX Configuration Confirmation dialog
box displays (Figure 2-33).
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Figure 2-33 Delete PBX Configuration Confirmation dialog box

Windows Internet Explorer [ x|

:‘.’/ Are wou sure you wank to delete this PBX Configuration? Warning!! deleting this PEX will delete all items associated with it

Cancel |

Step 2 Do one of the following:

—Click OK to delete the configuration.
—Click Cancel to close the dialog box without deleting the PBX

configuration.

Locations

Locations must be configured for each PBX if outbound dialing and
inbound parsing of numbers is to work correctly.

Location is used only for OW5000 API (Call Control) and LCS/OCS Integration.

Adding Locations
Use the following steps to add a Location for a given PBX.

Step 1 Click the Locations tab to display a Locations Configuration dialog box
(Figure 2-34).

Figure 2-34 Locations Configuration dialog box

% Current: OW5000PBX

Reserved Numbers VoiceMail Pilot Numbers

AreaCode Rules

PBX Settings Locations PBX — PBX Dialing

Add New Location

LocationName AreaCode CountryCode LD Access Code

57 T Irving 214 1 9

Step 2 Click Add New Location. An Add New Location dialog box displays
(Figure 2-35).
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Figure 2-35 Add New Location dialog box

9@ Current: SV7000-44

Reserved Numbers Voice Mail Pilot Numbers

AreaCode Rules

PBX Settings PBX — PBX Dialing

* Location Name: |

* Country Code: .
City/Area Code: :

Long Dist Access Code:
Local Access Code:

Int. Direct Dial Code: [ National Code]|

Cancel

Step 3 Enter a descriptive identifier for the location in the Location Name field.
This is a label used to identify this Location configuration and its
associated dialing rules. It is viewable on various list boxes to identify the
location associated with this PBX, and it is selectable for other PBXs
sharing the same dialing properties for this geographic area. Enter
something descriptive such as the city name that will allow yourself and
other administrators to infer associated rules for this locale.

Step 4 Enter the Country Code for this location in the Country Code field. This
value will be used when deciding whether or not a called destination is in
the same country. Called destinations outside the configured country will
be dialed as: long distance access code + international direct dial code +
country code + number or E.164 format. E.164 format is used for LCS/
OCS integration and OW5000 API (Call Control) makeCallWithDialNum
method (dialAslIs=false).

Step 5 Enter the City/Area Code used by the PBX in the City/Area Code field.
This value will be used when deciding whether or not a called destination
is local or long distance. By default, called numbers within the same city/
area code will NOT have the city/area code inserted between the local
access code and the number to dial unless a City/Area Code rule has
been defined to change this behavior. Also by default, called numbers to
destinations with different city/area codes will automatically have the
national direct dial code inserted between the long distance access code
and the number unless a separate City/Area Code rule has been defined
to prevent this.

Step 6 Enter the PBX access code needed to dial Long Distance from the PBX
in the Long Dist Access Code field. Long distance is defined in
OW5000 as callls to city/area codes different than the city/area code of
the location for the calling extension. The national direct dial code will
automatically be inserted after the Long Dist Access Code prior to the
city/area code, so it is not necessary to enter the national direct dial code
as part of the Long Dist Access Code. If this PBX is in a metropolitan
area with multiple city/area codes that should not be treated as long
distance, use a City/Area Code Rule to differentiate other local city/area
codes so the national direct dial code will not be inserted after the Local
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Step 7

Step 8

Step 9

Step 10

Access Code (note that the Local Access Code is used in place of the
Long Distance Access Code in this instance).

Enter the PBX access code needed to dial local calls from the PBX in the
Local Access Code field. This should include the code to dial out of the
PBX along with any digits that are required to place local calls by the
local carrier and/or central office switch.

Enter the direct dial code for dialing international numbers in the Int.
Direct Dial Code field. This is the code required to dial an international
number, which will be inserted between the long distance access code
and the country code. If you are not making an international call with an
E.164 format, configuration is not needed.

Enter the direct dial code for dialing numbers inside the country but
outside the current city/area code in the National Code field. This code
will be inserted between the long distance access code and the city/area
code.

After the Location is saved, assign the location to the PBX in the PBX
Setting page and do one of the following:

—Click Apply to add the Location

—Click Done to add the Location and close the dialog box.

—Click Cancel to exit without saving the changes.

Editing Locations

Use the following steps to edit Locations of configured PBXs using this
location and the associated area code rules.

Step 1

Select the PBX Configuration from those listed in the Locations

Configuration dialog box (Figure 2-34) and click the Pencil / icon. An
Edit Location Configuration dialog box displays (Figure 2-36).

Figure 2-36 Edit Location Configuration dialog box

9@ Current: SV7000-44

PBX Settings

Locations

* Location Name: IRVING
* Country Code: [01
City/Area Code: |
Long Dist Access Code: |1

|
|
Local Access Code: ,9 |
Int. Direct Dial Code: | |

Reserved Numbers

AreaCode Rules Voice Mail Pilot Numbers

PBX — PBX Dialing

National Code:i:

Step 2

After changing the configuration, do one of the following:

—Click Apply to save the information.
—Click Done to save the information and close the dialog box.
—Click Cancel to exit without saving the changes.
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Deleting Locations

Use the following steps to permanently delete a Location so that it may
not be reselected by this PBX or other PBXs.

pA3%) A location can only be deleted if it is not used by other PBXs. If it is currently in use
= by other PBXs, these other PBX configurations must first be modified to use a
different location or no location before this location and its associated area code
rules can be deleted.

Step 1  Select the desired location from the Locations Configuration dialog box
(Figure 2-34).

Step 2 Once the desired Location is selected, click the Trashcan @ icon. A
Delete Location Confirmation dialog box displays (Figure 2-37)

Figure 2-37 Delete Location Confirmation dialog box

Microsoft Internet Explorer x|
9

~.._‘/ Are you sure you want to delete this Location?

Cancel |

Step 3 Click OK to delete this location or Cancel to exit the dialog box and keep
this location configuration.

Area Code Rules

If special rules exist for this location; such as requiring dialed numbers
to the same city/area code have the city/area code inserted (10 digit
dialing in United States), treating numbers with a different city/area
code as local, or treating certain numbers within the same city/area
code as long distance, click AreaCode Rules from the PBX
Configuration dialog box (Figure 2-31). An Area Code Rule dialog box
displays (Figure 2-38).

Without special rules, OW5000 will assume dialed numbers to the same
city/area code as the location are local, and dial the local access code
plus the number (with city/area code removed). Calls to numbers
outside the given city/area code are treated as long distance such that
the Long Dist Access Code is dialed followed by the national direct dial
code + area code and phone number. You will be prompted to save the
changes you have made thus far for the Location before proceeding.

P339 The Area Code Rule is used for OW5000 API (Call Control) and LCS/OCS
= Integration only.
NOTE
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Figure 2-38 Area Code Rule dialog box

& Current: SV7000-44

Voice Mail Pilot Numbers

Reserved Numbers

PBX Settings Locations AreaCode Rules

PBX — PBX Dialing

Add New AreaCode Rule

here are no area code rules configured for the selected location

Cancel

Step 1 To add a rule, click Add New Area Code Rule. An Area Code
Rule dialog box displays (Figure 2-39).

Figure 2-39 Area Code Rule—Add New dialog box

PBX Settings Locations AreaCode Rules PBX — PBX Dialing Reserved Numbers Voice Mail Pilot Numbers

* Target |
City/Area Code:

Target ‘ |

Exchange:

The appropriate local or long distance access code will be
prepended before the following.

Direct Dial
Code:

Clinclude City/Area Code

Step 2 Inthe Target City/Area Code field, enter the area code that should have
a special rule when dialed. This field is required.

Step 3 If a specific exchange within the target city/area code requires a special
dialing rule, enter this number in the Target Exchange field. For
example, if most numbers within the 214 area code are considered local,
but a number such as (214) 335-1234 is long distance, enter “335” for
the target exchange. If this rule applies to all exchanges within the city/
area code (as can be the case for 10-digit dialing), leave this field blank.

Step 4 If the rule you are adding requires a direct dial code access code to be
added between the local or long distance access code for this location
and the number to dial, enter this code in the Direct Dial Code field. If no
special digits are required, leave this field blank. The Local or Long
Distance Access Code for the location will always be dialed regardless of
the value in this field, so do not include these as part of the Direct Dial
Code.

Step 5 If the target city/area code is to be inserted when dialing this area code,
check the box Include City/Area Code. This box is needed to specify
10-digit dialing for local calls in United States.
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Step 6 Do one of the following:

—Click Apply to save the area code without exiting the dialog box.
—Click Done to save the Area Code Rule and exit the dialog box.
—Click Cancel to exit the dialog box without saving the Area Code Rule.

Area Code Rule is used for OW5000 (Call Control API) and LCS/OCS Integration
= only.

PBX to PBX Dialing

If you have an environment with multiple PBXs using a non-unique
numbering plan, if you require inserting an access code in front of an
extension before dialing, or if you receive an access code together with
the calling party's extension, you must specify the rules needed by
OW5000 to build up dialable strings and break apart incoming numbers
into their core components of PBX and extension. Using these rules,
OW5000 knows how to dial from one PBX to another when access codes
must be used, and it knows how to interpret what part of an incoming
number is the actual extension when an office or access code is received
before the extension.

pa3%) PBX to PBX Dialing is used for multiple PBXs environment of OW5000 (Call Control
é API) and LCS/OCS Integration feature.
NOTE

Step 1 Click PBX -> PBX Dialing from the PBX Configuration dialog box
(Figure 2-29). A PBX > PBX Dialing Configuration dialog box displays
(Figure 2-40).

Figure 2-40 PBX -> PBX Dialing Configuration dialog box

PBX Settings | Locations | AreaCode Rules [ EALHAVENIIN Reserved Numbers | VoiceMail Pilot Numbers

Add New Destination PBX

Destination PBX Dialing Prefix Extension
J & owswoex 9 2

Add New Source PBX

Source PBX Incoming Prefix

J @ owsoooeex o

The Destination PBX section describes how various PBXs in the CCIS
network may be dialed by the current PBX. The Destination PBX is
identified along with the prefix needed to be inserted before the
extension. It may be necessary to specify the first digit of the extension
range if the destination PBX has extensions of varying lengths. For
example, a PBX may require dialing ‘8782’ before four digit extensions
beginning with *3’, but ‘78’ before five digit extensions beginning with
‘2’. In the case of four digit extensions, the ‘2’ belongs to the access
code, but in the case of five digit extensions, the ‘2’ is part of the
extension. Using these tables, you can identify these types of conditions
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so that OW5000 can properly dial and interpret incoming numbers
across the CCIS network.

The Source PBX section describes how incoming numbers from these
source PBXs to the current PBX should be disassembled to find the
actual extension of the calling party. This is done by entering the
Incoming Prefix that should be removed to find the extension. It is
possible to have more than one entry per source PBX in case numbers
can arrive in various formats from this PBX.

A Prefix is not required for the PBX(UGN), which uses the IP Centrex Feature,
because the Extension has its prefix as part of the extension number.

Step 2 To add a new Destination PBX, click Add New Destination PBX. An
Add Destination PBX dialog box displays (Figure 2-41).

Figure 2-41 Add Destination PBX dialog box

90 Current: OW5000PBX

PBX Settings Locations AreaCode Rules PBX — PBX Dialing Reserved Numbers VoiceMail Pilot Numbers

PBX: OWS5000PBX
Destination PBX: OW5000PBX

Dialing Prefix: IQ

Extensions beginning with: |g

Step 3  Select the desired Destination PBX from the drop-down list.
Step 4 Enter the Dialing Prefix number.

Step 5 Enter the Extensions Beginning with number in the text field. This
parameter is used only when different access codes need to be applied
for each beginning number. This configuration is not often required.

Step 6 Do one of the following:

—Click Apply to save the Destination PBX without exiting the dialog
box.
—Click Done to save the Destination PBX and exit the dialog box.

—Click Cancel to exit the dialog box without saving the Destination
PBX.

Step 7 To add a new Source PBX, click Add New Source PBX. An Add Source
PBX dialog box displays (Figure 2-42).
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Figure 2-42 Add Source PBX dialog box

& Current: OW5000PBX

PBX Settings Locations AreaCode Rules PBX — PBX Dialing Reserved Numbers VoiceMail Pilot Numbers

PBX: OW5000PBX
Source PBX. QW5S000PBX

Incoming Prefix: |9

Step 8 Select the desired Source PBX from the drop-down list.

Step 9 Enter the Incoming Prefix in the text box. An Incoming Prefix must be
configured for each PBX, including its own PBX.

A Prefix must be set when the current PBX and the Source PBX are the same.

-y —

Step 10 Do one of the following:

—Click Apply to save the Source PBX without exiting the dialog box.
—Click Done to save the Source PBX and exit the dialog box.
—Click Cancel to exit the dialog box without saving the Source PBX.

Step 11 To modify a Destination or Source PBX, select the desired PBX and then
click the Pencil / icon and make the necessary changes.

Step 12 To delete a Destination or Source PBX, select the desired PBX and then
click the Trashcan @ icon.

Reserved Numbers

Selecting the Reserved Numbers option from the PBX Configuration dialog box
(Figure 2-31) displays a Reserved Number dialog box (Figure 2-43). This option
allows you to add or edit one or more Dterms that can serve as a shared pool for
applications requiring temporary use of a Dterm for complex call processing
scenarios.

Figure 2-43 Reserved Number dialog box

& Current: NECPBX

PBX Settings Locations AreaCode Rules PBX — PBX Dialing Reserved Numbers Voice Mail Pilot Numbers

Add New Monitored Number

1-2of 2records |20 [ Results per page Page[1  |@of1
Monitor Number Reserved Type Tenant Owner

f i 5555 Monitored Number 1 OWS000 APl

y jinf Monitored Number 1 QWs000 API

1-2of2records (20 | Results per page Page|1 [@of1

Step 1 Click Add New Monitored Number to add new Reserved Numbers. An
Add Reserved Number dialog box displays (Figure 2-44).
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Figure 2-44 Add Reserved Number dialog box

9@ Current: SV7000-44

PBX Settings Locations AreaCode Rules PBX — PBX Dialing Reserved Numbers Voice Mail Pilot Numbers

PBX: 8V7000-44

* Number: |

*Tenant: 1 =
* Reserved Type: Monitored Mumber -
Application:  n-assigned -

Step 2 Enter the number to reserve in the Number field.

Enter a private number for an IP centrex environment.

) —

Step 3  Select the Tenant from the drop-down list.

Step 4 Select one of the Reserved Type options from the drop-down list.

Dummy DTerm Number - it is only necessary to allocate Dummy
Dterms if you are so instructed by an application installation. This is not
required unless United States is selected as the Sales Region.

Monitored Numbers... to enter one or more monitored numbers (AMNO
assigned on the NEAX 2400) that can serve as a shared pool for
applications requiring monitored numbers. It is only necessary to allocate
Monitored Numbers if you will be running an application such as the
UNIVERGE UA5200, which requires such numbers in its configuration.

Monitored Numbers are mandatory for LCS/OCS Integration.
Step 5 Choose the Application from the drop-down list.

OWS5000API must be assigned for LCS/OCS integration. The ACD,
Incoming Call Assistant, Location Status and the Oai Server are not used
if only the OW5000 platform is used.

Step 6 Do one of the following:

—Click Apply to save the Reserved number without exiting the dialog
box. Click Apply & Add New to save the Reserved Number; the
Extension is increased automatically.

—Click Done to save the Reserved number and exit the dialog box.

—Click Cancel to exit the dialog box without saving the Reserved
Number.

Step 7 To Edit existing numbers, click the Pencil / icon.
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Step 8 To delete a Reserved Number, click the Trashcan @ icon.

Be sure to change or delete the related configuration before deleting a reserved

number.
IMPORTANT
Voice Mail Pilot Numbers
Step 1  Selecting the Voice Mail Pilot Numbers option from the PBX
Configuration dialog box (Figure 2-13) displays a Voice Mail Pilot
Numbers dialog box (Figure 2-45). This option allows you to add or edit
one or more Voice Mail pilot numbers; which is used for voice mail
integration, such as UM8500.
P33 Figure 2-45 displays only if the United States is selected as the Sales Region.
NOTE

Figure 2-45 Voice Mail Pilot Numbers dialog box

& Current: OW5000PBX

PBX Settings Locations AreaCode Rules PBX — PBX Dialing Reserved Numbers VoiceMail Pilot Numbers

Add Mew Pilot Number

1-10f1 rec-:rdsn Results per page Page:ﬂ of 1

Pilot Humber A
i} 8500

1-10f1 rec-:rdsn Results per page Page:a of 1

Step 2 Click Add New Pilot Number to add a new Voice Mail pilot number. An
Add Voice Mail pilot number dialog box displays (Figure 2-46).

Figure 2-46 Add Voice Mail pilot number dialog box

90 Current: SV7000-44

PBX Settings Locations | AreaCode Rules PBX — PBX Dialing Reserved Numbers Voice Mail Pilot Numbers

“PiotNumber [ ]

Step 3 Enter the pilot number to reserve in the Pilot Number field.

Step 4 Do one of the following:

—Click Apply to save the Voice Mail pilot number without exiting the
dialog box.

—Click Done to save the Voice Mail pilot number and exit the dialog
box.

—Click Cancel to exit the dialog box without saving the Voice Mail pilot
number.
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NOTE

Step 5 To change the default Voice Mail pilot number, click Set Default of the
proper pilot number. The Default pilot number is displayed as bold. This
number is used when a client does not specify the Voice Mail pilot
number.

Step 6 To delete a Voice Mail Pilot Number, click the Trashcan @ icon.

Routes/Trunks Configuration

Selecting Routes/Trunks from the OW5000 Platform Configuration
dialog box (Figure 2-13), displays a Route/Trunk Management dialog
box (Figure 2-47).

Figure 2-47 displays only if the United States is selected as the Sales Region.

Figure 2-47 Route/Trunk Management dialog box

Add New Trunk

1-1of1records|2p  [E Resutts perpage Page]1 6 of 1
Route Hame A PBX Route Number Beqin Trunk Ending Trunk Tenant

57 i CCISNWA NECPBX. 1 1 10 1

1-10f1records|20 [ Resutts per page Page|1 [Eof1

Use the following steps to add, edit, or delete a Route Trunk:

Adding a Route Trunk

Step 1 Click Add New Trunk from the Route Trunks dialog box. A Route
Trunks—Add dialog box displays (Figure 2-48).

Figure 2-48 Route Trunks—Add dialog box

Step 2 Enter the number for this trunk in the Route Number field.

Fields which must be completed are designated with an asterisk (*).

Step 3 Enter the Name associated with this trunk number.

Step 4 Enter the Beginning Trunk and the Ending Trunk number.
Step 5 Select the PBX from the drop-down list.

Step 6 Select the Tenant Number from the drop-down list.

Step 7 Enter the desired number in the four UserDefined fields.
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Route/Trunk Management

* Route Mumber: l:l

* Name:

* Beginning Trunk: l:l
* Ending Trunk: l:l

*PBX: SV7000-44 ~

* Tenant Number: 1~

UserDefined 1: |

UserDefined 2: |

|
|
UserDefined 3: | |
UserDefined 4: | |

Apply Cancel
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Step 8 Do one of the following:

—Click Apply to save the information without closing the dialog box.
—Click Done to save the record and exit the dialog box.
—Click Cancel to exit the dialog box without saving the record.

Step 9 Click the Pencil # or Trashcan @ icon to edit or delete a Route/Trunk.

Serial Ports Configuration

Selecting Serial Ports from the OW5000 Platform Configuration dialog
box (Figure 2-13), displays a Serial Port Management dialog box

(Figure 2-49).

Figure 2-49 displays only if the United States is selected as the Sales Region.

NOTE

Figure 2-49 Serial Port Management dialog box

Serial Port Management

1-10f1 recordsﬂ Results per page Page:ﬂ of1
Serial Port & Baud Rate Data Bits Parity Stop Bits Flow Control

;7 jim} 1 300 7 Even Maone Harchare

1-10f1 recordsﬂ Results per page Page:ﬂ of1

Step 1 To add a serial port, click Add New Serial Port. A Serial Port
Management dialog box (Figure 2-49).

Figure 2-50 Serial Port Management dialog box

Serial Port: m
Baud Rate: Im
DataBits ID: [7]
Parity: Im
Stop Bits: l@
Flow Contral: lm

Coopyy ] oore |
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Step 2  Enter the information in the following fields:

—Serial Port
—Baud Rate
—DataBits ID
—Parity
— Stop Bits
—Flow Control
. ‘@» Select the HardWare Flow Control option for TAP page support.
4 ~
TIP
Step 3 To edit or delete a serial port, select the Pencil # icon or the Trashcan @
icon.
Step 4 Do one of the following:
—Click Apply to save the information.
—Click Done to save the information and exit the dialog box.
—Click Cancel to exit without saving the information.
Configuring Voice Mail Servers
Selecting Voice Mail Servers from the OW5000 Platform Configuration
dialog box (Figure 2-13) displays a Voice Mail Server Management
dialog box (Figure 2-51).
P33 Figure 2-51 displays only if the United States is selected as the Sales Region.
NOTE

Figure 2-51 Voice Mail Server Management dialog box

Voice Mail Server Management

1-1of1 records |20 (Bl Results per page Page|1 [Edof1
Name Type System ID Mailbox Count VoiceMail Count Base URL

;7 jim) Messages ME& XMzl A0-120 u] u]

1-10of1 records |20 B Results per page Page]1 |[Elof1
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Adding a Voice Mail Server

Step 1

Click Add New Voice Mail Server. A Voice Mail Server—Add dialog box
displays (Figure 2-52).

Figure 2-52 Voice Mail Server—Add dialog box

Voice Mail Server Management

* Mame: ||

Type: |NEAXMail AD-120 |

System ID:
Base URL:
Example: http:/server.30807

Fields which must be completed are designated with an asterisk (*).

Step 2
Step 3
Step 4
Step 5

Step 6

Enter the Name for the Voice Mail Server.
Select the Type from the drop-down list.
Enter the System ID. (optional)

Enter the Base URL for the Voice Mail Server.

To edit or delete a Voice Mail Server, click the Pencil # or Trashcan @
icon.
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Maintaining the OW5000 Applications

OW5000 Applications are installed as part of the OW5000 platform in most cases.
Each module supports a specific feature such as SIP Presence, and LCS/OCS
Integration. Selecting Applications from the OW5000 Options dialog box
(Figure 2-12), displays an OW5000 Applications Configuration dialog
box (Figure 2-53).

Figure 2-53 OW5000 Applications Configuration dialog box

NEC 83555

OW5000
Platform
Applications Access Server
Directory ACD
Application Data Application Message Service
Settings Dialer
Scheduler Email Notification

Templates Incoming Call Assistant

MA4000 Integration Location Status Information
Version Information MC550 Server

Nurse Call

OAIl Server

Remote Call Control

Short Text Message

PR3 Figure 2-53 is an example when the United States is selected as the Sales Region.

The following topics are included in this section:

Access Server Configuration

Application Message Service Configuration
Email Notification Configuration

Incoming Call Assistant Configuration
Location Status Information Configuration
OAI Server Configuration

Remote Call Control Configuration
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Access Server Configuration

Selecting Access Server from the OW5000 Applications Options dialog
box (Figure 2-53) displays an Access Server List Manager dialog box
(Figure 2-54). Follow the steps below to add, edit, or delete an access
server.

One PSGW (Presence Gateway) and more than one Access Server
configuration is required for the SIP presence feature.

pa3%) PSGW is set as the default. Do not delete this configuration. (Port 6061 is assigned)

NOTE

Figure 2-54 Access Server List Manager dialog box

General Settings Routing Info

Add New Acce

e
1-10f1 rec-:r-jsﬂ Results per page Page B of1

Server Name P Address Listen Port  Legacy Port  RPC Listen Port TOS KeepAlive TimerT1 IsPSGW  Binding Type
j i) PSGWLocal 17224 13373 6061 00 1800 500 PSGW

1-10f1 recardsﬂ Results per page Page B of 1

Adding an Access Server

Step 1 Clicking Add New Access Server from Figure 2-54 displays an Add
New Access Server dialog box (Figure 2-55).

Figure 2-55 Add New Access Server dialog box

Access Server

General Settings Ruuting Info

* Server Name:

* P Address: | |

* Listen Port: (6060 |
Legacy Port: 60002
* RPC Listen Port: [2000

*TOS: |00

|
|
* Keep Alive: [1500 |

* Timer T1 [500 |

Is PSGW: []
Binding Type: | TCP/IP

Step 2 Enter the Server Name. This name is used as a unique ID. Once the
Access Server is defined, you cannot change the Server Name. The
values in Step 3 to Step 9 do not have to be changed from the default of
the parameter is not in conflict with another application.
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Step 5

Step 6

Step 7

Step 8
Step 9

Step 10

Step 11

Step 12

Step 13
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Enter the IP Address for the server. Use the same address as where the
OWS5000 Platform is installed. Only one Access Server can be assigned
per server.

Enter the Listen Port number of the Access Server. (accepts 1025 to
65535 only.) Default is 6060. A Listen Port is not required for PSGW.

Only one Access Server is available (except PSGW) per server.

Enter the listen port in the Legacy Port field. Accepts 1025 to 65535
only. Default is 60002. This parameter is not used for OW5000 R4.
(Future use).

Enter the RPC Listen Port number. If PSGW is checked, this value is
not required. Accepts 1025 to 65535 only. Default is 62000.

Enter the TOS value. This field accepts HEX only, but Ox is not needed.
Default is 00. This value can be changed. Only Access Server works on
the Microsoft Windows Server 2003. To enable this configuration,
change the registry modification as shown below.

Based on the following URL, add a registry key named
"DisableUserTOSSetting" under
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\
Parameters then set 0.

http://technet.microsoft.com/en-us/magazine/2007.02.cableguy.aspx
Enter the Keep Alive interval (in seconds). Default is 1800.

Enter the Timer T1 Value (in milliseconds) which means the first retry
timer of the SIP request packet from the Access Server to the terminals.
Default is 500 milliseconds. Usually no configuration change is required.

Check Is PSGW if the server is PSGW. PSGW can only be installed on
the same box as the OW5000 Platform. OW5000 Platform installer
automatically creates the PSGW configuration (PSGWilocal). The
PSGWiIocal settings do not need editing unless this configuration is
deleted accidently.

Select the Binding Type from the drop-down list. Available options are
Named Pipe, TCP/IP, and HTTP. If PSGW is not checked, this value is
disabled. Only TCP/IP is available for this version.

After changing the configuration, do one of following:

—Click Apply to save the Access Server information.

—Click Done to save the Access Server information and close the dialog
box.

—Click Cancel to exit without saving the changes.

To edit Access Server, click the Pencil icon on the Access Server List
Manager dialog box (Figure 2-54).
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Step 14 To delete Access Server, click the Trashcan icon on the Access Server
List Manager dialog box (Figure 2-54).

P33 If the Server Name or IP address is duplicated in the database, an error message
= displays.
NOTE

Routing Info

Selecting the Routing Info option from the Access Server dialog box
(Figure 2-54) displays a Routing Info dialog box (Figure 2-56). This
option allows you to add or edit a routing rule which is used for SIP
presence federation. Multiple routing rules can be assigned. The

OW5000 system checks the routing based on priority (the first line is the
highest priority).

Figure 2-56 Routing Info dialog box

General Settings Routing Info

Add New Routing Rule

1-30f3 rec-:ur-is Results per page F'GQ-BZ of1
Routing Rule RegEx TranslationPattern IP Address Port Humber Reorder Priority &

f jing AT10([0-9°#H5} @ +5 T1081@sv7 100 172.24 130,165 5060 1

'J jimj 820([0-9 +5 22051@svE200 172.24.130.188 5080

2

» » »
€ "«

+§ 73051@sv7300 172.24.130.154 5060 3

1-3of3records[10 B Results per page Page[1  |Eof1

Test Routing Rule

Adding a Routing Rule

Clicking Add New Routing Rule from the Access Server dialog box
displays an Access Server—Routing Rule Info page (Figure 2-57).

Figure 2-57 Access Server—Routing Rule Info page

General Settings Routing Info

ROUTING RULE INFO

* Routing Rule:
Translation Pattern:
*IP Address:| |
* F'ort:| |

Cancel

Routing Info
Use the information below to add a new Routing Rule.

Step 1 Enter a regular expression of the target SIPURI in the Routing Rule
field. Configuration examples are listed below:

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



OWS5000 Configuration 2-51

Step 2 Enter the translation format in the Translation Pattern field. $1 must be
there in this filed. Refer to Appendix C for details on the Regular
Expression.

Step 3 Enter the target access server in the IP Address field. This Access
Server belongs to a different OWS5000 system so the Access Server
name is not available.

Step 4 Enter the target access server port number in the Port field.

Example1:

Routing Rule: A710([0-9*#]{5})@.+$

(SIPURI start from 710 and 5 digits (total 8 digits) before @ mark and
store that 5 digits as $1)

Translation Pattern: $1@sip.com

IP Address: 192.168.0.10

Port: 5060

Input SIPURI: 71012345@necinfrontia.com

Result:
12345@sip.com is sent to 192.168.0.10 port 5060 using TCP session.

Testing a Routing Rule

Clicking Test Routing Rule from the Access Server dialog box displays
an Access Server—Test Routing Rule dialog box (Figure 2-58). The Test
Routing Rule button is displayed when more than one Routing Rule is
assigned.

Figure 2-58 Access Server—Test Routing Rule dialog box

General Settings Routing Info

TEST MATCHING

Test Routing Rule:

This page provides test functionality for a routing rule.
Step 1  Enter the test SIPURI in the Test Routing Rule field and then click Test.

If a matching routing rule is found in the system, the routing rule and
target information displays on this page.

If a matching rule is not found in the system, the Routing Rule Info field is
blank and an error box displays. The rule is checked from the top routing
rule so if multiple rules are matched for the test value, the highest priority
rule displays.
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Application Message Service Configuration

Selecting Application Message Service from the OW5000 Applications
Options dialog box (Figure 2-53) displays an Application Message
Service dialog box (Figure 2-59).

Figure 2-59 Application Message Service dialog box

Application Message Service

TCP Service Port: 5425

Step 1  Enter the TCP Service Port for the application message and then click
Apply. Default port is 5425.

Email Notification Configuration

Selecting Email Notification from the OW5000 Applications Options
dialog box (Figure 2-53) displays a Distribution List dialog box

(Figure 2-60). This configuration is available only when the appropriate
service is installed.

Figure 2-60 Distribution List dialog box

Distribution List

" There are not any events available for configuration

Available Applications:
<<Mone=»

In the Available Applications drop-down list, there will be
<<None>> if only the OW5000 platform is installed.

Refer to each application's documentation for more details.
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Incoming Call Assistant Configuration

The following options are originally configured during the OW5000
Platform installation. They may be reconfigured through OW5000
Administrator by completing the steps below.

Step 1 Login to the OW5000 Administrator program. Once you are logged into
OWS5000 Administrator, follow this path to open the ICA configuration
options: OW5000 > Applications > Incoming Call Assistant. An ICA
General Settings dialog box displays (Figure 2-61).

Figure 2-61 ICA General Settings dialog box

Incoming Call Assistant

Server Settings Redirect Configurations PBX Settings

ICA Name
* Legacy TCP/IP Port 5424
Options
¥ Name Display Enabled in PBX
Show External Number
Show DID Information
Password Required
¥|Chime on Incoming Call to Subline
Cutbound Call Log Size: 100
Inbound Call Log Size: 100

Max Idle Time (seconds): 30

MName Display Format for Employee Match
Employee Display Name -

Cancel

Step 2  Enter information in the following fields for Server Settings.

—Legacy TCP/IP Port

The TCP/IP Port is the port number used by external applications to
connect to the LS| Service. The default number (5424) need only be
changed if the external applications cannot connect to the ICA Service
due to a conflict with other programs on the OWS5000 Server already
using this port.

Step 3 Review the Options information.

—Name Display Enabled in PBX

If your PBX is currently configured to use the built-in Name Display
Feature, check the box Name Display Enabled in PBX. This ensures
that ICA will not display redundant information about calling
employees that the PBX is already displaying to your Dterm.

When checked, ICA will not display a caller's name if the caller is an
employee, and they are calling your prime line. External numbers to
your prime line will still be displayed by ICA as well as all calls to your
sublines, employee included. Also, ICA will not show a called
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employee's name on placed calls. If the call you are placing is to a
non-employee number, ICA will display the dialed number or name.

If Name Display Enabled in PBX is not checked, ICA will always
attempt to reconcile the caller or called party number to names in the
employee, external, or personal directories and display this
information on your Dterm, with one exception. If you are placing a call
to an employee who has set their status through the Location Status
application (LSI), and LSl is configured to flash the status to your
phone, ICA does not display the employee name. Instead, it gives
control to LS| so that you can see the person's status, return date,
time, and alternate number, if any.

—Show External Number

If this item is checked, ICA will always display the ANI information for
an external call unless a name match is found. If a name match is
found, ICA will display the name. If this item is not checked, ICA will
only display a name if a name is found, or if the incoming line is a sub
line. Otherwise, nothing is displayed.

—Show DID Information

Select this check box to configure ICA to show the name of the called
number as it is found in the OWS5000 DID (Direct Inward Dial)
Database. This DID number must be configured as a virtual number in
the PBX and all calls forwarded to the user's extension. This box is
typically NOT selected in order to always show the caller's ANI
instead.

—Password Required
Select this check box to require users to enter a password when
accessing Incoming Call Assistant.

If this check box is not selected, the user will be allowed to choose not to use a

password when accessing Incoming Call Assistant. If the check box is selected, they

will be required to enter a password before they can access Incoming Call Assistant.
—Chime on Incoming Call to Subline

If your PBX is configured so that incoming calls to sublines do not ring,
you may desire to check this box so that ICA users are alerted with a
Dterm chime when receiving an incoming call on one of their sublines.

—Outbound Call Log Size

Specifies the number of records that will be stored for each user's
outbound call history. This value also affects other applications that
view the history.

—Inbound Call Log Size

Specifies the number of records that will be stored for each user's
inbound call history. This value also affects other applications that view
the history.

—Max Idle Time (seconds)

Specifies the number of seconds that ICA waits for user input before
exiting on that person’s Dterm.
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In the Name Display Format for Employee Match section, select one
of the following ways to display employee names from the drop-down list.

—Employee Display Name

—Last,First
—First Last

This option allows the user to select how names are displayed on the
Dterm when ICA finds an employee match to an incoming or outgoing
call. This name can be the display name, which is configured in the
OW5000 Administrator for that employee, or it can be a combination of
first and last name. If “last, first” or “first last” are selected and either
first name or last names are blank, the default will be the display

name.

You can modify the amount of time that ICA waits for user input before
exiting on that person’s Dterm in the OAI Timeout field.

Click Apply to accept the configuration or Cancel to discard the

changes.

Redirect Configuration

Selecting Redirect Configuration displays an ICA Redirect Configuration
dialog box (Figure 2-62).

Figure 2-62 ICA Redirect Configuration dialog box

Step 1

Incoming Call Assistant

Redirect Configurations PBX Settings

Add New Redirect Configuration

1-100f12 records[10 B Results per page
M

325

325

325

425
Conf2 PEX
DonTest2
IPS

LIBRA
PETPEX44
POE

El E} E} E E) E) E E} & E}

1-100f12 records[10 B Results per page

Redirect Number

1235
1236
1237
2222
21345
243
4070
G900
3455
642

Page[1 |[Edof2 = ==

Page[1 |[Edof2 = ==

Click Add New Redirect Configuration. A Redirect Configuration—Add
New dialog box displays (Figure 2-63).
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Figure 2-63 Redirect Configuration—Add New dialog box

Incoming Call Assistant Redirect Configuration Manager

PB: INECF‘EI)(1 vl
Redirect NumherISBDD 'l

Step 2 Select the PBX from the drop-down list.

Step 3 Select the Redirect Number from the drop-down list.

Step 4 Click Done to accept the changes or Cancel to exit without saving the
changes.

PBX Settings

Selecting PBX Settings from the ICA General Settings dialog box
(Figure 2-61) displays an ICA PBX Settings dialog box (Figure 2-64).

Figure 2-64 ICA PBX Settings dialog box

Incoming Call Assistant

Server Settings Redirect Configurations PBX Settings

F'EIX:I 325 'l
IP Address: 108.120.131.21
PEX 1D:857

Rl Bind Narne: OAIServer. 325
Client Server Port: 44046
PEX Type: UNIVERGE 5%7000 Typess
Split Call Forward: Mo
Port: 60030
Force Port: ®yes Tno
Heartbeat: ®yes Tno
Selected [~

Incremental Retry Delay:| 30 seconds 'l
OAl Timeout: 1SSeconds'l
Max Retry Delay:| 10 minutes 'l

Use OAl Server: No
Data Mode:| 128 IncomingCaIIAssistanj
LED Mumber:| 1 |IncomingCaIIAssistanj

Cancel

Values in gray are the read-only values assigned at the time the PBX
was configured for use with the OW5000 Platform. Changes to these
values can only be made by modifying the global PBX configuration
under OW5000 Platform. Such changes will affect every application
using that PBX. To specifically modify the PBX settings used only by ICA,
use the following steps.

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



OWS5000 Configuration 2-57

Step 1 Verify the value for Force Port.

This field has the following settings:

—Yes specifies that the application uses the same port each time it runs.
This should be selected to avoid problems with clearing Dterm
displays and monitoring equipment.

—No specifies that the application will retry one of the other port
numbers when the application fails to connect to the PBX because the
port may be in use by another application. This setting has no effect
when the PBX Type is NEAX 2400 IMS Internal IP, UNIVERGE
SV7000, or NEAX 2000 IPS.

You should normally select Yes for the Force Port field.

Step 2 \Verify the setting for Heartbeat.

This field has the following settings:

—Yes specifies that the application checks approximately every 20
seconds to make sure the PBX connection is still alive and
operational.

—No specifies that the application will not check the PBX connection.
You should normally select Yes for the Heartbeat field.

Step 3 Check the Selected checkbox if you would like ICA to attempt to connect
to this PBX the next time it is restarted.

Consider enabling the Selected checkbox for ICA's PBX Settings, soon after
= installation of OW5000 Platform. This is not enabled as a default, on a fresh install.

Step 4 If needed, you can modify the Incremental Retry Delay. The
Incremental Retry Delay designates the amount of time the application
waits to attempt to reconnect to the PBX after the connection is lost. If
the connection to the PBX is lost, ICA waits for the amount of time
specified in the Incremental Retry Delay field before attempting to
reconnect the first time. If the connection still cannot be made, the
specified amount of time will be added to the delay period before the next
attempt. For example, if the Incremental Retry delay is set to 30
seconds, ICA waits 30 seconds before attempting to reconnect. If that
first attempt fails, the application waits 60 seconds before making a
second attempt to connect, then waits 90 seconds before making a third
attempt, and so on. When the application successfully reconnects to the
PBX, the delay time goes back to the amount of time set in the
Incremental Retry Delay Value field. Incremental Retry Delay Value is
typically set to 30 seconds.

Step 5 You can modify the amount of time that ICA waits for the user input
before exiting on that person’s Dterm in the OAI Timeout field.

Step 6 The Max Retry Delay specifies the maximum amount of time the
application waits between attempts to reconnect to the PBX after the
connection is lost. This is used in conjunction with the Incremental Retry
Delay and ensures that the application will try to re-establish a
connection to the PBX within a certain amount of time. The Max Retry
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Delay Value is typically set to 1 hour to make sure that the application
will attempt to reconnect to the PBX at least once an hour.

Step 7 You can change the Data Mode that ICA uses to communicate with
Dterm users by selecting an available Data Mode from the drop-down
list. The data mode you select must be programmed for use with OAl in
the PBX, and it must be assigned to a function key button on each user's
Dterm in order for ICA to be available to the user.

The value ranges from 128 to 191 and should match the OPCODE in the
AOKC command on the NEAX 2400 IMS and UNIVERGE SV7000, or
the D70 command if using the NEAX 2000 IPS.

Step 8 You can change the LED Number that ICA lights when active on the
Dterm.

Step 9 Do one of the following:

—Click Apply to save the information.
—Click Cancel to exit without saving the information.

Location Status Information Configuration

The Location Status Information (LSI) options are originally configured
during the OW5000 Platform installation process. They may be
reconfigured through the OW5000 Administrator by completing the
steps below.

Step 1 Login to the OW5000 Administrator program. Once you are logged in to
OWS5000 Administrator, follow this path to open the LSI configuration
options: OW5000 > Applications > Location Status Information. An
LSI General Settings dialog box displays (Figure 2-65).

Figure 2-65 LS| General Settings dialog box

Location Status Information

Server Settings Message Settings PBX Settings

LSl Mame: | *Unnamed*

* Legacy TCP/IP Port:| 5241

Options

Display Status
Password Required

Max Idle Time (seconds): |15

Apply Cancel
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Step 2  Enter information for the Server Settings.

—Legacy TCP/IP Port

The TCP/IP Port is the port number used by external applications to
connect to the LSI Service.

Step 3 Review the Options information.

— Display Status

Select this check box to configure LSI to show the name of the called
number.

— Password Required
Select this check box to require users to enter a password when
accessing LSI.

—Max Idle Time

Specifies the number of seconds that LSI waits for user input before
exiting on that person’s Dterm. The default value is set at 15 seconds.

Step 4 Do one of the following:

—Click Apply to save the information.
—Click Cancel to exit without saving the information.

Message Settings

Selecting Message Settings displays an LSI Message Settings dialog
box (Figure 2-66).

Figure 2-66 LS| Message Settings dialog box

Location Status Information

Server Settings Message Settings PBX Settings

Add New Message

1-10of 12records[10_|EB Results perpage Page[1  |@of2 > »= Default O”“”93| Available 'l
System Presence & SIP Presence Default Ofﬁine:l Offline :I'

i i At Lunch meal Default |d|e:lm

i i Avaiable no_plan(oning}) Default BUSYZW

i i} Away from Desk step_out Default Out of Oﬂ’lce:lm

i jin} Busy no_plan(absence) Default DTErmilm

i i} Gone Home go_home .

i i} In a Meeting meeting Default Wobility: | Available j‘

J @ Offiine

i i On Break break

i jin} On Business Trip biz_trip

i i On Wacation vacation

1-100f12 reccrds Results per page Page: of2 = ==
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Step 1

—System Presence
The default values are reconfigurable.

—SIP Presence
This is a fixed list and cannot be reconfigured.

—Default Online
Use the drop-down list to change the System Presence status.

—Default Offline
Use the drop-down list to change the default offline status. Max 16
characters.

—Default Idle
Use the drop-down list to change the System Presence status.

—Default Busy
Select the desired option from the drop-down menu.

—Default Out of Office
Select the desired option from the drop-down menu

— Default Dterm
Select the desired option for the default status when a new non SIP
presence is used for extension.

—Default Mobility
Select the desired option for the status related to the mobility feature

To add a new message, click Add New Message. An LS| Message
Settings—Add New dialog box displays (Figure 2-67).

Figure 2-67 LS| Message Settings—Add New dialog box

Step 2
Step 3
Step 4

Location Status Information Message Manager

* System Presence:
SIP Presence NONE -

Enter a new message in the System Presence text box.
Select the SIP Presence from the drop-down list.
Do one of the following:

—Click Done to save the information.
—Click Cancel to exit without saving the information.
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PBX Settings

Selecting PBX Settings from the LSI General Settings dialog box
displays a PBX Settings Configuration dialog box (Figure 2-68).

Figure 2-68 PBX Settings Configuration dialog box

Location Status Information

Server Settings Message Settings PBX Settings

PBX: SV7000-44 ~
IP Address: 172.24 133.44
PBX ID: 30
RMI Bind Name: OAIServer. SVT000-44
Client Server Port: 44000
PBX Type: UNIVERGE SWV7000
Split Call Forward: No
Port: 60030

Force Port: @ yes ) no
Heartbeat: @ yes @ no
Selected: []
Incremental Retry Delay: 30 seconds -
OAl Timeout: 15 seconds

Max Retry Delay: 10 minutes -
Use OAl Server: No
Data Mode: Mone -

LED Mumber: Mone -

Apply Cancel

Values in gray are the read-only values assigned at the time the PBX
was configured for use with the OW5000 Platform. Changes to these
values can only be made by modifying the global PBX configuration
under OW5000 Platform. Such changes will effect every application
using that PBX. To specifically modify the PBX settings used only by LSI,
use the following steps:

Step 1  Verify the value for Force Port.

This field has the following settings:

—Yes specifies that the application uses the same port each time it runs.
This should be selected to avoid problems with clearing Dterm
displays and monitoring equipment.

—No specifies that the application will retry one of the other port
numbers when the application fails to connect to the PBX because the
port may be in use by another application. This setting has no effect
when the PBX Type is NEAX 2400 IMS Internal IP, UNIVERGE
SV7000, or NEAX 2000 IPS.

You should normally select Yes for the Force Port field.
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Step 2

Step 3

Verify the setting for Heartbeat.

This field has the following settings:

—Yes specifies that the application checks approximately every 20
seconds to make sure the PBX connection is still alive and
operational.

—No specifies that the application will not check the PBX connection.
You should normally select Yes for the Heartbeat field.

Check the Selected checkbox if you would like LS| to attempt to connect
to this PBX the next time it is restarted.

Consider enabling the Selected checkbox for ICA's PBX Settings, soon after
installation of OW5000 Platform. This is not enabled as a default, on a fresh install.

Step 4

Step 5

Step 6

Step 7

If needed, you can modify the Incremental Retry Delay. The
Incremental Retry Delay designates the amount of time the application
waits to attempt to reconnect to the PBX after the connection is lost. If
the connection to the PBX is lost, LS| waits for the amount of time
specified in the Incremental Retry Delay field before attempting to
reconnect the first time. If the connection still cannot be made, the
specified amount of time will be added to the delay period before the next
attempt. For example, if the Incremental Retry delay is set to 30
seconds, LSI waits 30 seconds before attempting to reconnect. If that
first attempt fails, the application waits 60 seconds before making a
second attempt to connect, then waits 90 seconds before making a third
attempt, and so on. When the application successfully reconnects to the
PBX, the delay time goes back to the amount of time set in the
Incremental Retry Delay Value field. Incremental Retry Delay Value is
typically set to 30 seconds.

You can modify the amount of time that LSI waits for user input before
exiting on that person’s Dterm in the OAI Timeout field.

The Max Retry Delay specifies the maximum amount of time the
application waits between attempts to reconnect to the PBX after the
connection is lost. This is used in conjunction with the Incremental Retry
Delay and ensures that the application will try to re-establish a
connection to the PBX within a certain amount of time. The Max Retry
Delay Value is typically set to 10 minutes to make sure that the
application will attempt to reconnect to the PBX at least once an hour.

You can change the Data Mode that LS| uses to communicate with
Dterm users by selecting an available Data Mode from the drop-down
list. The data mode you select must be programmed for use with OAl in
the PBX, and it must be assigned to a function key button on each user's
Dterm in order for LS| to be available to the user.

The value ranges from 128 to 191 and should match the OPCODE in the
AOKC command on the NEAX 2400 IMS and UNIVERGE SV7000, or
the D70 command if using the NEAX 2000 IPS. 128 is assigned as the
default value.
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Step 8 You can change the LED Number that LSI lights when active on the
Dterm. Blank is assigned as the default value.

Step 9 Do one of the following:

—Click Apply to save the information.
—Click Cancel to exit without saving the information.

OAI Server Configuration

OAI Server is a component of the OW5000 and enables Java, Web, and
other applications, except Remote Call Control, to communicate with the
PBX using NEC's Java OAI libraries. OAI Server also manages a single
connection (association) to each target PBX on behalf of the
applications.

Follow the steps below to configure OAI Server:

Step 1 Selecting OAI Server from the OW5000 Applications Options dialog box
(Figure 2-53) displays an OAI Server Settings dialog box (Figure 2-69).

Figure 2-69 OAIl Server Settings dialog box

OAIl Server

Server Settings PBX Settings

* OAl Tenant Number: |0

Step 2  Enter the tenant number in the OAI Tenant Number field. The Tenant
Number is used by the OAI Server when it opens facilities with the PBX.
Typically the default value of 0 is the desired value because this allows
OAI Server to work for all tenant numbers in the PBX.

The OAI Server ignores the OAI Tenant Number setting when opening the Free
= Location Facility. The Free Location Facility always uses Tenant 1.

To use the OAl Server, Selected must be checked in the PBX Settings
dialog box (Figure 2-70). When assigning a new PBX, the Selected
checkbox is checked by default.
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Figure 2-70 PBX Settings dialog box

PBEX: *SV7000-40-Hotel «
IP Address: 172.24.133.40
PBX ID: 40
RMI Bind Mame: OaiServer.SV7000-40-Hotel
Client Server Port: 44000
PBX Type: UNIVERGE SV7000
Split Call Forward: No
Port: 60030
Force Port: @ yes ) no
Heartbeat: @ yes ) no
Selected: [V

Incremental Retry Delay: 30 seconds
Max Retry Delay: 10 minutes
Use DAl Server: No

Enable Free Location Facility:

Step 3

Step 4

Step 5

Select the PBX from the drop-down list.

Values in gray are the read-only values assigned at the time the PBX
was configured for use with the OW5000 Platform. Changes to these
values can only be made by modifying the global PBX configuration
under OW5000 Platform. Such changes will effect every application
using that PBX. To specifically modify the PBX settings used only by LSI,
use the following steps.

Verify the value for Force Port.

This field has the following settings:

—Yes specifies that the application uses the same port each time it runs.
This should be selected to avoid problems with clearing Dterm
displays and monitoring equipment.

—No specifies that the application will retry one of the other port
numbers when the application fails to connect to the PBX because the
port may be in use by another application. This setting has no effect
when the PBX Type is NEAX 2400 IMS Internal IP, UNIVERGE
SV7000, and NEAX 2000 IPS.

You should normally select Yes for the Force Port field.

Verify the setting for Heartbeat.

This field has the following settings:

—Yes specifies that the application checks approximately every 20
seconds to make sure the PBX connection is still alive and
operational.

—No specifies that the application will not check the PBX connection.

You should normally select Yes for the Heartbeat field.
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Step 6 Check the Selected checkbox if you will use the OAI Server. It is
mandatory for OW5000 API (Call Control and Call Notification) and
Presence Gateway (Legacy presence of SIMPLE).

Step 7  Specify the amount of time the application waits to attempt to reconnect
to the PBX after the connection is lost in the Incremental Retry Delay
field. This value is usually 30 seconds.

Step 8 Specify the maximum amount of time the application waits between
attempts to reconnect to the PBX after the connection is lost in the Max
Retry Delay field. This value is usually 30 seconds.

Step 9 Check the Enable Free Location Facility box if an application will be
run that uses the OAI Server and requires the use of the Free Location
Facility. Because the PBX only allows one application to simultaneously
have the Free Location Facility opened for use, this box should only be
checked if instructed to avoid conflict with non-OW5000 applications that
require the Free Location Facility.

Step 10 Do one of the following:

—Click Apply to save the settings.
—Click Cancel to exit without saving the changes.

Remote Call Control Configuration

Selecting Remote Call Control from the OW5000 Applications Options
dialog box (Figure 2-53) displays an RCC Setting dialog box
(Figure 2-71).

Figure 2-71 RCC Setting dialog box

Remote Call Control

General Settings Normalization Rules

* Listen Port:
gonss If you have not installed Remote Call Control, this setting is not needed. For more
2 information, refer to the UNIVERGE OW5000 Installation Guide, OW5000 Remote
Call Control Service.
NOTE
General Settings
Step 1  Enter the port number in the Listen Port field. 5060 is recommended,
but it must be configured when LCS/OCS is installed on the same server.
gonss To set a Monitored number, use the OW5000 Platform option and then select PBX
= Configurations > Reserved Numbers. See “Reserved Numbers” on page 2-39.
NOTE
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Step 2 Click Apply to set the port.

To use the Remote Call Control service with SV8500, SV7000, and IPX series, a
Monitored number must be assigned. Refer to “Reserved Numbers” on page 2-39 for
more detail.

Normalization Rules

Selecting Normalization Rules from the Remote Call Control dialog box
(Figure 2-71) displays a Normalization Rules dialog box (Figure 2-72).

This option allows you to add or edit normalization rules which are used
for LCS/OCS Integration. This value is usually 30 seconds. Multiple
normalization rules can be assigned. The OW5000 system checks the
rule based on priority (first line is highest priority). By clicking the
Reorder arrow in the list can change the priority of the rule.

Figure 2-72 Normalization Rules dialog box

(ENEEIRESAEM  Normalization Rules

Add New
1-20f2 recardsﬂ Results per page Page ﬂ of1
Country Code Reqular Expression Translation Pattern Comment Reorder  Priority &
T 0§ 45 tet31;phone-context=necinfrontia.com For NEC Infrontia, Inc A Y 1
ﬂﬁ' 1 MI0-g tet:31;phone-context=nec.com For NEC Corporation AY 2
1-20f2 recardsﬂ Results per page Page ﬂ of1

Adding a Normalization Rule

Clicking Add New from the Normalization Rules dialog box displays a
Remote Call Control—Normalization Rules dialog box (Figure 2-73).

Figure 2-73 Remote Call Control—Normalization Rules dialog box

General Settings Normalization Rules

NORMALIZATION RULE INFO

Country Code: United States of America (1) -

Phone Pattern Regular
Expression:

Translation Pattern:

Comment:

Cancel
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Normalization Rule Info
When adding a new Normalization Rule, follow the steps below:

Step 1 Select the target Country Code from the Country Code drop-down list.

Step 2 Enter a regular expression of the target phone in the Phone Pattern
Regular Expression field. Refer to Appendix C for more details on
Regular Expression.

Step 3 Enter the translation format in the Translation Pattern field. $1 must be
in this filed.

Step 4 Enter a comment for this normalization rule.

Example1:

Phone Pattern Regular Expression: ~0([0-9*#]{3,4})$

(Phone number starts from 0 and 3 or 4 digits (total 4 or 5 digits) and
stores these digits as $1. Note that the first 0 is not included in $1).
Translation Pattern: tel:$1;phone-context=necinfrontia.com
Comment: This rule is used for NEC Infrontia, Inc.

Input phone number: 01234

Result:

tel:1234;phone-context=necinfrontia.com
Testing a Normalization Rule

Clicking Test Rule from Figure 2-73 displays a Remote Call Control—
Test Normalization Rule page (Figure 2-74). The Test Rule button
displays when more than one Rule is assigned.

Figure 2-74 Remote Call Control—Test Normalization Rule dialog box

General Settings Normalization Rules

Afghanistan (93

TEST TRANSLATION

Test dialed number: Check Rule

Translated number:

TEST ANI TRANSLATION

Test ANI: Destination PEX: NECPBX  + EelERI=i

Translated number:

This page provides test functionality for normalization rules. There are 2
test capabilities: TEST TRANSLATION and TEST ANI TRANSLATION.
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TEST TRANSLATION is used to check the regular expression of the
rule, but the OW5000 system determines the rule not only this regular
expression.

TEST ANI TRANSLATION is used to check how the OW5000 converts
this input phone number. OW5000 uses several internal logics to
determine the translation results so this test field allows the user to see
how the OW5000 works. To test TEST ANI TRANSLATION, assign a
Country Code for the Rule and Location in PBX Management page.

TEST TRANSLATION

Step 1

Enter the test phone number in Test Dialed Number and then click
Check Rule.

If there is a matching normalization rule in the system, the normalization
rule and the translated result displays on this page.

If there is no matching rule in the system, Translated number field is a
blank. The Rule is checked from the top normalization rule so if multiple
rules are matched for the test value, the highest priority rule displays.

TEST ANI TRANSLATION

Step 1

Enter the test phone in the Test ANI field, select the destination PBX
from the drop-down list, and then click Check Rule.

If there is a matching normalization rule in the system, the rule and
translated result displays in the Translated number field.

If there is no matching rule in the system, the Translated number filed is

a blank. Rule is checked from the top normalization rule so if multiple
rules are matched for test value, highest priority rule is displayed.
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Maintaining the OW5000 Directory

Selecting Directory from the OW5000 Options dialog box (Figure 2-12), displays
an OW5000 Directory Configuration dialog box (Figure 2-75). The following
figure is an example when the United States is selected as the Sales
Regions.

Figure 2-75 OW5000 Directory Configuration dialog box

NEC §V:55

OW5000 |

Platform
Applications
Directory
Application Data
Settings

Scheduler
Templates

MAA4000 Integration

ACD Break Modes
ACD Split Modes
ACD Work Modes
Categories

DIDs

Locations

Version Information Organizations

People
Positions
Specialties
User Privileges

Users

The following topics are included in this section:

e Configuring Categories

e Configuring DIDs

e Configuring Locations

e Configuring Organizations

e Person Management

e Configuring Positions

e User Privileges Configuration

e User Management Configuration
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Configuring Categories

The Categories option is used to group organizations, locations, and

people together.

Prior to adding categories, the Organizations, Locations, and People
must already be configured by OW5000 Administrator. Please refer to
“Configuring Organizations” on page 2-78, “Configuring Locations” on
page 2-75, and “Person Management” on page 2-81.

Selecting Categories from the OW5000 Directory Configuration dialog
box (Figure 2-75) displays Figure 2-76.

Figure 2-76 Category Management dialog box

Category Management

E- Categories

- Airlines

Assign Categories

Adding Categories

Step 1

To add a new category, click Categories and then click Add New.
Figure 2-77 displays.

Figure 2-77 Add New Category dialog box

Category Management

Parent Category: None
Category Name:[ ]

Category Descript\on:!

Step 2
Step 3

Enter the Category Name and a Category Description.
Do one of the following:

—Click Apply to save the changes.
—Click Done to exit the dialog box.
—Click Cancel to exit without saving the changes.

The category is added to the list

UCE Application Platform (UNIVERGE OW5000) Configuration Guide




OWS5000 Configuration 2-71

Figure 2-78 Category Added dialog box

Category Management

0 Category updated successfully

Bl Categories
Airlines
EI Golf Courses
- Bear Creek
- Lone Star Park
- Morth Texas

.~ Running Bear
B Universities

Assign Categories

Editing Categories

Step 1  Select the desired category name and click Edit. Make the necessary
changes and then do one of the following.

—Click Apply to save the changes.
—Click Done to exit the dialog box.
—Click Cancel to exit without saving the changes.

Assigning Categories

Select the desired category name and click Assign Categories. Figure 2-79
displays.
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Figure 2-79 Assign Categories dialog box

Category Management

Parent Category: Golf Courses
Category Name:lNoth Texas |
Category Descriptinn:lN—b( |

ASSIGN CATEGORIES

Organizations Locations People

Filter: Unit Mame IContains ;I | |

= Organizations —

I American Airlines
I The Mark

Step 1  Select an Organization or use the Search option to link an organization
with the category.
Step 2 Select the search criteria from the Filter drop-down list.

Step 3 Select the Field in which to search from the drop-down list.

For example, Contains, Equals, or Starts With and click Search. A
Database Search Results screen displays listing all previously entered
data.
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Configuring DIDs

Selecting DIDs from the OW5000 Directory Configuration dialog box
(Figure 2-75) displays a DID dialog box (Figure 2-80).

pA33) Displays only if the United States is selected as the Sales Regions.

NOTE

Figure 2-80 DID dialog box

DID Management

1- 4 of 4 records 20 B Results per page Page[1 |dof1
Name & Extension PBX Company

J @ 09 110 325

ﬂ jim) dicd test 110 325 brwvtest-main

;7 jim) olicd test 110 325 Company 1

;7 jim) olicd test 110 325 Company 1

1- 4 of 4 records 20 B Results per page Page[1 |dof1

stom Fields

Adding a DID Record

Step 1 Click Add New DID from the DID dialog box. A DID Management dialog
box displays (Figure 2-81). If a company has not been defined, an error
message will display in the dialog box.

Figure 2-81 DID Management dialog box

DID Management

* Name: |

*PBX: MNECPBX1 -
* Extension: 10330 -

* Company: MNEC Infrontia -
Test DID:

= Fields which must be completed are designated with an asterisk (*).

Step 2 Enter the Name associated with the DID field.
Step 3 Select the PBX from the drop-down list.
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Step 4 Select the Extension from the drop-down list.

Step 5 Select the Company from the drop-down list.

gonss To remove or change an existing DID Record, select the desired record and then
= click the Pencil § or Trashcan @ icon.
NOTE

Step 6 Do one of the following:

—Click Apply to save the changes.
—Click Done to exit the dialog box.
—Click Cancel to exit without saving the changes.

Manage Custom Fields

Selecting Manage Custom Fields displays a Manage Custom Fields
dialog box (Figure 2-82).

Figure 2-82 Manage Custom Fields dialog box

DID Custom Fields

Custaom Field
1-10of1 records| 20 |E Results per page Pagel1 |[Edof1
Field Name & Required
5? jimj Direct Inc. ]
1-10f1 records |20 K Results per page Page]1 [Eof1
PR3 To remove or change an existing Custom Field, select the desired record and then
— click the Pencil § or Trashcan T icon.

Step 1 To add a new field, click Add New Custom Field from Figure 2-82. A
DID Custom Field dialog box displays (Figure 2-83).
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Figure 2-83 DID Custom Field dialog box

DID Custom Fields

* Field Marme: |
™ Required
Cancel
= Fields which must be completed are designated with an asterisk (*).
NOTE

Step 2 Type the Field Name in the text box.
Step 3 Select the Required checkbox if this entry is mandatory.
Step 4 Do one of the following:

—Click Apply to update the changes.
—Click Done to exit the dialog box.
—Click Cancel to exit without saving the changes.

Configuring Locations

Location is used to assign location data. In the Employee Role page, the
user can make a relation between an employee and a location.

Selecting Locations from the OW5000 Directory Configuration dialog
box (Figure 2-75) displays a Location Management dialog box
(Figure 2-84).

Figure 2-84 Location Management dialog box

Location Management

Add New
Filter: Al v Location Name: Starts With ~ | |
Home Home
1-10f1 recurds{_-zlj_]ﬂ Results per page Page| 'B of 1
Name A Fully Qualified Location Name
’ test location test location
1-10of1 recnrds]-.z-i]__j Results per page Page I1 .B of 1
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NOTE

Adding a Location

Step 1

Click Add New from the Location Management dialog box. An Add New
Location dialog box displays (Figure 2-85).

* Highlight Locations to add a new parent location.
* Highlight a location beneath the parent location to add a new location to the parent.

Figure 2-85 Add New Location dialog box

Location Management

Parent: <Mones

* Marne: |

Type: I(NDtSet) vl

Maotes:

PHONE NUMBERS

Add New

Fields which must be completed are designated with an asterisk (*).

Step 2
Step 3
Step 4
Step 5

Enter the Name of the location.
Select the Type of location from the drop-down list.
Enter any desired Notes.

To assign phone numbers, click Add New. An Add Location Phone
dialog box displays (Figure 2-86).
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Figure 2-86 Add Location Phone dialog box

Location Management

Parent: <Monex

* Name: |Manufacturing

Type: Office -

MNotes: -

PHONE NUMBER S

Add New

Mo phone numbers are assigned.

Type: Intemal -

Add New Extension

Select a number to add

PEX. <Al> v Fiter StetsWih <[ |

1-10f135 rec-:ur-jsﬂ Results per page Page:n of 135
PBX Extension & Tenant
> SVT000-44 1906 1
1-10f135 rec-jr-jsa Results per page Page:ﬂ of 135

Step 6 Select the PBX or choose <All> from the drop-down list.

Step 7 To find a number, select a Filter option from the drop-down list and then
click Search.

Step 8 Do one of the following:

—Click Apply to update the changes.
—Click Done to exit the dialog box.
—Click Cancel to exit without saving the changes.
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Configuring Organizations

Organization is used to assign organization data. In the Employee Role
page, the user can make a relation between an employee and an
organization.

Selecting Organizations from the OW5000 Directory Configuration

dialog box (Figure 2-75) displays an Organizations Management dialog
box (Figure 2-87).

Figure 2-87 Organizations Management dialog box

Organization Management

Expand All Collapse All Add New

Filter: Unit Name ~ Confains  ~
[=- Organizations
w8 NEC

Use this dialog box to add, edit, or delete organizations. Use Expand All
to view all Organizations or Collapse All to only view the parent
organization.

To remove or edit an existing organization, highlight the organization and click Edit
or Delete.
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Adding an Organization

Step 1  Click Add New from the Organization dialog box. An Organization—Add
New dialog box displays (Figure 2-88).

gonss Highlight Organization to add a new parent organization.
= * Highlight an organization beneath the parent organization to add a new
organization to the parent.

NOTE * Fields which must be completed are designated with an asterisk (*).

Ry

é You can also use the plus and minus symbols to Collapse or Expand the view.
NOTE

Figure 2-88 Organization—Add New dialog box

Organization Management

Parent: <Mones

*Mame: |Acme

Type: |...

®nternal  External

Maotes:

LOCATIONS

Add New

Mo locations are assigned.

PHONE NUMBERS

Add New

o phone numbers are assigned.

Step 2 Select the Type of number to add from the drop-down list, either Internal
or External.

Step 3 Enter the Name of the organization.
Step 4 Select the Type of organization from the drop-down list.

Step 5 Select whether or not the organization is Internal or External by
selecting the appropriate option button.

Step 6 Enter any desired Notes.
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Adding Locations

Step 1 If nolocations are assigned, or you wish to add more locations, click Add
New in the Locations section. An Organization—Add Locations dialog
box displays (Figure 2-89).

Figure 2-89 Organization—Add Locations dialog box

LOCATIONS
Add New
Select a location to add. JE=IGE]
Filter: Al ~ Location Name:  Starts With - I:I
Home Home
1-10f1 rec-:nr-jsﬂ Results per page Page:ﬂ of1
Hame A Fully Qualified Location Name
> Manufacturing Manufacturing
1-10f1 rec-:ur-:‘sﬂ Results per page PGQE-B of1

Step 2 Select the location to add from the drop-down list and then click Select.

Adding Phone Numbers

Step 1  If no phone numbers are assigned, or you wish to add more numbers,
click Add in the Phone Numbers section. An Organization—Add Phone
Numbers dialog box displays (Figure 2-90).

Figure 2-90 Organization—Add Phone Numbers dialog box

PHONE NUMBERS

Add New

Mo phone numbers are assigned.

Add Mew Extension

Select a number to add

pEY: <Al *  Filter: Starts With ~ l:l Cancel

1-10f135 rec-:nr-jsﬂ Results per page Page:ﬂ of 135 = =>
PBX Extension 4 Tenant
> SVT000-44 1808 1
1-10f135 rec-:nr-jsﬂ Results per page Page:ﬂ of 135 = =>

Cancel

Step 2 Select the PBX from the drop-down list.

Step 3 To find a number, select a Filter option from the drop-down list and then
click Search.
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Step 4 Do one of the following:

—Click Apply to update the changes.
—Click Done to exit the dialog box.
—Click Cancel to exit without saving the changes.

Person Management

Selecting People from the OW5000 Directory Configuration dialog box
(Figure 2-75) displays a Person Management dialog box (Figure 2-91).

Figure 2-91 Person Management dialog box

Person Management

Add Mew Person Use Template: Mone -

Filter- Al + LastName > Statswith v [ |

1-5of 5 records B Results per page Page:ﬂ of 1
Last Name & First Hame Full Name SIP URI Contact Method
ﬂ m BRETT MEGHAN BRETT, MEGHAN 16154
ﬂ jim) BRIGHT ALICLA BRIGHT, ALICLA 13958
ﬂ jim) BROOKS NATTAN BROOKS, NATTAN 11980
ﬂ jim) BROWN DAVID BROWN, DAVID 16156
ﬂ jim) BROWN EVAN BROWN, EVAN 17761
1-5of 5 records B Results per page Page:ﬂ of 1

Range Delete | Manage Custom Fields | Full Mame Format | URI Format

Searching the Database
Use the following steps to conduct a search in the Person database.

Step 1  Select the search criteria from the Filter drop-down list.

gonss A Role, such as User and employee, is set in the Roles page. Select All in case a
é Role is not assigned. Refer to “Roles” on page 2-87.
NOTE

Step 2 Select the Field in which to search from the drop-down list.

For example, Last Name, First Name, Contact Method, or Login ID.
Another way to search is to select Starts with and then enter data in the
text box and click Search. A Database Search Results screen displays
listing all previously entered data. A wildcard (*) is not required. If you
want to display all Persons, set blank in the search field or set None as
the search target and then click Search.

To add a new person, see “Adding a Person” on page 2-84.
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Manage Person Custom Fields
Use the following steps to add user defined fields in the Person

database.
gonss This parameter is supported only when other OW5000 applications, which are
= supported in US market, is installed in the system.

Step 1 Click Manage Custom Fields. A Person Custom Fields dialog box
displays (Figure 2-92).

Figure 2-92 Person Custom Fields dialog box

Person Custom Fields

Specify the names of the custom fields.

* UserDefined 1: | |serDefined! I Reguired
" UserDefined 2: || serDefined2 I Reguired
* UserDefined 3: | |UserDefined3 I Reguired
" UserDefined 4: || serDefinedd I Reguired
* UserDefined 5: || serDefineds I Reguired
* UserDefined B: || serDefineds I Reguired

Step 2 Select an available undefined UserDefined field and enter the desired
label for the field.

Step 3  Select the Required checkbox if the information to be entered in the
newly defined field is mandatory.

Step 4 Do one of the following:

—Click Apply to update the changes.
—Click Done to exit the dialog box.
—Click Cancel to exit without saving the changes.
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Full Name Display Format

Use the following steps to customize the display name of a Person. At
least one person must be assigned before changing this format.

Step 1  Select Full Name Format from the Person Manager dialog box. A Full
Name Display Format dialog box displays (Figure 2-93).

Figure 2-93 Full Name Display Format dialog box

Ferson Full Name Settings

Full Mame Format: || ast First Capital on First & Last Nameéj

Preview of Full Mame: Doe John M.
Cancel

Step 2 Choose a format from the drop-down list to display a Preview of Full
Name. Available options are shown in Figure 2-94.

Step 3 Do one of the following:

—Click Apply to update the changes.
—Click Done to exit the dialog box.
—Click Cancel to exit without saving the changes.

Figure 2-94 Full Name Display Options

(L3 al on F
First Ml Last, Title Case
Last, Prefix First I, Suffix, Title Case
Prefix First bl Last, Suffix, Title Case
Last Name First Name

URI Format Configuration

Selecting URI Format from Figure 2-91 displays a URI Format
Configuration dialog box (Figure 2-95).

Figure 2-95 URI Format Configuration dialog box

URI Format Configuration

SIPURI FORMAT
SIP URIKey parar('&tﬂ First Character of First Name + Last Name =
Translation patiern -

IMURI FORMAT

M URI Key Pa'ar(”;ulff First Character of First Name + Last Name =

Translation pattern :
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=

/\:K\ -
==

==

REFERENCE

Step 1  Select one of the following keys from the URI Key Parameter drop-down

list: The selected key is treated as $0:

Primary Extension

Prefix + Primary Extension

First Name

Last Name

First character of First name + Last Name
Login ID

Primary Extension and Prefix + Primary Extension keys are only available and
displayed in the US Market.

If Login ID is selected as the URI Key Parameter in the Person URI Derivation, User
roles must be selected for creation in the Import Settings so that the Login ID
database field can be mapped to a Login ID column in the Input File. This column
MUST contain unique Login IDs for each person being added or updated. If an input
record specifies a Login ID that is already in use in the OW5000 database, data
associated with the existing Person can be overwritten by the data that's being
imported for that Login ID. Please ensure that if you are attempting to add a new
Person to the database, that the specified Login ID is unique relative to existing
Login IDs in the database and relative to other Login IDs in the DBTool Input File.

Step 2 Enter the Translation Pattern Regular Expression. Maximum of 100

characters, only single byte.

An IMURI FORMAT is used only for the OW5000 applications which are released in
US market.

Adding a Person
Use the following steps to add a new record to the Person database.

Step 1 Click Add New Person in the Person Manager dialog box

(Figure 2-91). A Person Management dialog box displays (Figure 2-96).

To create a new Person from a pre-defined Template, select the desired
template from the Use Template drop-down menu, then click Add New
Person. Refer to “Template Management” on page 2-118, for more
information on creating a new template.

Example:

URI Key Parameter : First Name
Translation Pattern : $0@nec.com

First name of person : Steve
Auto generated SIP URI : Steve@nec.com

Refer to “Regular Expressions” on page Appendix B-1 for more information on the
database fields and their sizes.
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Person

When adding a new record from the Person Management dialog box, the
first screen to display is the Person tab (Figure 2-96). The figure below
displays when United States is selected as the Sales Regions.

Figure 2-96 Person Management—Add New dialog box

& Current:

* Last Name: | |

* First Name: | |

Middle Name: | |
Display Mame: |
Prefix: -
Suffix: -
SIP URI:
SIP Access Server: Not Assigned -

SIPUA Group: Mot Assigned -

I URI:
IM Access Server: Mot Assigned -
L 1
Special Dial Code: l:l
Add Photo: _ Browse... |
UserDefined1: | |
UserDefined2: | |
UserDefined3: | |
UserDefinedd: | |
UserDefined5: | |
UserDefined6: | |
Mote: -

Cancel

= Fields which must be completed are designated with an asterisk (*).

Step 1 Enter the Last Name and the First Name for the new record.

Step 2 If desired, enter data into the Middle Name, and Display Name fields.

pa33) Display Name is used when OW5000 applications display the person’s name on a
= Dterm (call logs, calling party information, etc.). This name is limited to 16 characters
due to display size limitations and is auto generated using the person’s first and last
names. You may choose to enter a Display Name in the text box to override/prevent
auto generation. Should you wish to resume auto-generation of this field at a later
date, simply clear it by back spacing over any existing value.
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* First character of Middle Name + .(dot) is used for the Full Name Display Format. If
the Display Name is blank, the Full Name Display Format is applied.

* DBTool Person import — Display Name Generation checks this Display Name
parameter.

Step 3
Step 4

Step 5
Step 6

If desired, select a Prefix or Suffix for this record.
Do one of the following:

Enter a SIP URI if you are using a SIP Server. This SIP URI must be
unique in the system. If you are using a SIP terminal, it must be the same
as the SIP URI that was assigned in the Extension page or
prefix+extension SIP URI.

Select Auto Input to set auto generated SIPURI based on the regular
expression assigned in URI format page, overwrite the SIPURI that is
displayed, or do nothing if the regular expression is not configured.

In the URI Format Configuration page, if the Prefix + Primary Extension
or Primary Extension is selected as the SIP URI Key Parameter($0), the
Primary Extension must be set as the contact method before this step.

Select a SIP Access Server from the drop-down list.

Select a SIPUA Group name from the drop-down list.

IM URI, IM Access Server, Voice Mail Server, Subscriber ID and Photo are used for
some OW5000 Applications released in US market only.

Step 7
Step 8
Step 9
Step 10
Step 11

Enter the IM URI number.

Select the IM Access Server from the drop-down list.
Select a Voice Mail Server from the drop-down list.
Enter the Subscriber ID number.

To add a Photo, click Browse. An Add Photo dialog box displays
(Figure 2-97).
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Figure 2-97 Add Photo dialog box

Choose file 2lx|
skiord j & & oF B
Iy Documents
:} My Computer
Iy Metwork Places
Adobe Reader 7.0
Security Configuration Wizard
gﬁ Shorbout bo mspaint . exe
File: narme: I j Dpen I
Files of type: IA\I Files () j Cancel |
p

Step 12 Enter the file name of the desired photo or choose a different path to find
the location and then click Open. The file name is added in the Photo
field.

When adding a picture for a person to be viewed in the UC700 client, please be sure
= to put pictures in a folder accessible by the local service account. Do NOT select a
path in a specific user's My Documents or My Pictures folder, for example. Instead,
create a separate folder under the C or D drive.

Step 13 Do one of the following:

—Click Apply to save the record.
—Click Done to close the dialog box.
—Click Cancel to exit without saving the information.

Roles

Roles can be added to any person that is already configured in the
Person database. After selecting the desired person, click the Roles
tab to display a Roles dialog box (Figure 2-98). The following figure
displays when United States is selected as the Sales Regions.

Figure 2-98 Roles dialog box

Person Contact Methods Addresses

Role Type
f jimj Employee
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Adding a User Role

Step 1 Click Add Role. A Roles—Add New dialog box displays (Figure 2-99).
The following figure displays when United States is selected as
the Sales Regions.

The dialog boxes will differ depending on the type of role selected. User and

IMPORTANT

Employee are required for OW5000 API (InformationAPI).

The following screens reflect the steps necessary for adding a User as
the role type. Multiple roles can be assigned for one person.

Figure 2-99 User Roles—Add New dialog box

Person

Roles Contact Methods Addresses

User -

* Login ID: | |

*New Password: | |

* Confirm New Password: | |

WTtogno [

[T Login is disabled

[ password never expires
Security Roles: Select the security roles for the user.

[] DbTool - Import/Export OWS5000 Data | DbTool User
[T w5000 Administrator 0

Confidentiality Status: None -

Ry
= Fields which must be completed are designated with an asterisk (*).
NOTE
Step 2 Select User from the drop-down list.
Step 3 Enter the information in the following fields:
—Login ID
—New Password
—Confirm New Password
pD User must be selected if SOAP (Information API) is used and the user needs to login
= to OW5000 Administrator. The length of the password must be at least 8 characters
NOTE long and include the following rules:

1 Uppercase letter (A-Z)
1 Lowercase letter (a-z)

1 Digit(1-9)

1 Special Character (excluding a space, square brackets, backslash, and single or

double quotes)
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Step 4 For Windows Authentication, enter the NTLM Login ID for the user.

UC700 only for this parameter. This parameter does not display if UC700 is not
= installed or if United States is selected as the Sales Region.

Step 5 To disable the user role for any reason, click the check box Login is
disabled.

Step 6 To set the password to never expire for the user, click the check box
Password never expires.

Step 7 To select the Security Roles for this user, click the checkbox for each
application the user is allowed to view or use, and then select the role
type. For example, an administrator, a user, a recipient, or an assistant.

Step 8 Select the Confidentiality Status for this role from the drop-down menu.
This is not required for configuration unless United States is selected as
the Sales Region.

Step 9 Do one of the following:

—Click Apply to add the role and continue with the configuration.
—Click Done to save the information and close the dialog box.
—Click Cancel to exit without saving the changes.

Adding an Employee Role

After selecting the name, click the Roles tab from the Person
Management dialog box (Figure 2-96). Select Employee from the drop-
down role type list box to display an Employee Role Type dialog box
(Figure 2-100).

If the selected person already has a role assigned, you can edit or delete

the role by clicking the Pencil # or Trashcan i icon (Figure 2-98). The
following figure displays when United States is selected as the Sales
Regions.
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Figure 2-100 Employee Roles—Add New dialog box

Person Roles Contact Methods Addresses

| Employee v

Employee ID: |

Employee Position: | -Select a _position- v
Employee Type: | . v

Crganization: <Mot Set=

Location: <MNot Set=

Remove

Confidentiality Status: [None v

Apply Cancel

Step 1

Enter the Employee ID.

The Employee Position, Employee Type, and Confidentiality Status are not used.

Step 2
Step 3

Step 4

Step 5

Step 6
Step 7

Select the Employee Position from the drop-down list.

Select the Employee Type from the drop-down list. For example, a
Contractor, Permanent, or Part Time employee.

To set an Organization for this employee, click Select and then choose
an organization. For configuring an Organization, see “Configuring
Organizations” on page 2-78. To remove an organization, click Remove.

To set a Location, click Select and then choose a location. For
configuring a Location, see “Configuring Locations” on page 2-75. To
remove a location, click Remove.

Select the Confidentiality Status from the drop-down menu.
Do one of the following:

—Click Apply to add the role and continue with the configuration.
—Click Done to save the information and close the dialog box.
—Click Cancel to exit without saving the changes.
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Contact Methods

To add a contact method, select the Contact Method tab. A Contact
Method dialog box displays (Figure 2-101). The following figure is an
example when the United States is selected as the Sales Regions.

Figure 2-101 Contact Method dialog box

Person Contact Methods Addresses

Addd N act Method

Step 1 If no Contact Methods are configured, click Add New Contact Method.
A Select Contact Method—Type dialog box displays (Figure 2-102). The
following figure is an example when the United States is
selected as the Sales Regions.

Figure 2-102 Select Contact Method—Type dialog box

Person Roles Contact Methods Addresses
* Contact Method: | Primary Extension =l
* Priarity: Alpha Pager =

Assured Mobility Fhone
* Phy Mame: External Fax
. External Primary Murnber
" Extension: External Secondary Murnber
Dterm Password: External Tertiary Number
Caonfidentiality Home Email Address
Status: Horne Phone Number
sipUR: Mobile Phone
Other Email Address
Other Email Pager
OtherWork Phone Mumber

Personal Homepage
Bl Phone Pager

Access Server:

Frimary Extension
Secondary Extension
Tertiary Extension
Text Messaging
Wireless hd

Step 2 Select the type of contact method from the drop-down list.

= Fields which must be completed are designated with an asterisk (*).

The Contact Method dialog boxes may differ depending on the type of
contact method you selected. Primary Extension, Secondary Extension
and Tertiary Extension are available as a SIP Presence feature. If you
are using a softphone collaboration feature, the Primary Extension
should be a collaborated extension, and the Secondary Extension should
be the softphone.
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For example, if you selected Primary Extension from the drop-down list,
a Contact Methods—Primary Extension dialog box displays

(Figure 2-103). The following figure is an example when the
United States is selected as the Sales Regions.

Figure 2-103 Contact Methods—Primary Extension dialog box

Person Roles

* Contact Method: Primary Extension -
* Priority: 1 -
* PBX Mame: NECPBX1 -

* Extension:

1-50f134 rec-:nrdsﬂ Results per page PGQEZB of27 = ==
Extension & Tenant E164 Number
> 2110 1
> 2123 1
b2 10330 1
> 15410 1
> 15415 1
1-50f134 rec-:nrdsﬂ Results per page PGQEZB of27 = ==
Pilot Number Mone -
Oterm Password: [ ]
Confidentiality Status: None v
SIPURI:

Access Server:

Contact Methods Addresses

| Add New Extension

Stats Wi+ [ ]

Step 3
Step 4
Step 5

Step 6

Step 7

Cancel

Select the Priority from the drop-down list.

Select the PBX Name from the drop-down list.

Do one of the following to choose an Extension:
—select the target Extension from the extension list

—click Add New Extension

Clicking the Add New Extension button opens an Extension dialog
box. Refer to “Adding Extensions” on page 2-18 for more information.
After entering all necessary information, click Apply.

—search for an extension, by choosing Contains, Ends With, Equals,
or Starts With from the drop-down list, then enter the desired value
and click Search.

Select Pilot Number for personal voice mailbox (displayed only when
UC700 is installed).

Enter the Dterm Password (if applicable) in the text box.
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Step 8 Choose the Confidentiality Status from the drop-down list. (Only
available for the US market).

Pilot Number, Dterm Password, and Confidentiality Status are not used unless the
= OWS5000 Applications released in the US market are used.

Step 9 Do one of the following:
—Click Apply to add the contact method and continue with the
configuration.
—Click Done to save the information and close the dialog box.
—Click Cancel to exit without saving the information.

Address Information

This is displayed only when the United States is selected as the Sales
Region or if an OW5000 Application which released in US market is
installed.

Step 1 To add an address, select the Addresses tab. If no Addresses have
been configured, click Add New Address. An Address Information
dialog box displays (Figure 2-104).

Figure 2-104 Address Information dialog box

Person Roles Contact Methods Addresses

* Address Type: Select an address type -

Country/Region: United States of America (1) -
* Street: -

City:
State/Province: Select a State v

Zip/Postal Code:

Step 2 Select the Address Type from the drop-down list.

Fields which must be completed are designated with an asterisk (*).

) —

Step 3 Enter/select information in the following fields:

—Country/Region
—Street

—City
—Zip/Postal Code
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Step 4

Do one of the following:

—Click Apply to add the address.
—Click Done to display the new entry.
—Click Cancel to exit without saving the information.

Editing or Deleting Person

To edit or delete a person, follow the steps below.

Step 1

Step 2

Step 3

Click the Pencil # icon next to the desired Person to edit the data
(Figure 2-91).

After you have completed the editing, do the one of following:

—Click Apply to save the information.
—Click Done to save the information and close the dialog box.
—Click Cancel to exit without saving the changes.

Click the Trashcan @ icon next to the desired Person to delete the data.

Person Range Delete

Follows the steps below to range delete a Person.

Step 1

Click Range Delete from the Person Management dialog box
(Figure 2-91).

Figure 2-105 Person Range Delete dialog box

Step 2
Step 3

Person Range Delete

SELECT THE RANGE OF PERSONS TO DELETE

*Filter: LastName ~  Staris With ~

* From:
To:

Select the desired filter of the range delete from drop-down list.

If you use an alphabet or numeric value as the query parameter, enter
the value in the From and To text box fields. If another query parameter
is used, such as a multi-byte character, enter the value in the From text
box field only.
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Step 4 Click Delete. This may take a few minutes depending on the number of
people to be removed. A maximum of 500 people can be deleted at a
time.

P339 A Person cannot be deleted if they are is use by the system. In this case, retry the
= range delete or execute after business hours.

gonss DBTool—BulkDelete can be used as a Person delete.

Configuring Positions

Step 1 Selecting Position from the OW5000 Directory Configuration
dialog box (Figure 2-75) displays a Position Management dialog
box (Figure 2-106). The following figure is an example when
the United States is selected as the Sales Regions.

Figure 2-106 Position Management dialog box

Fosition Management

Filter:

1-200f2186 records Results per page Page: of 110 = =2

Title & Abbreviation

J @ Med student Medstucent
;7 jim) (=om) Physician [=om)Physi

;7 i *admin Azssistant *admindasi
;7 jim) *analyst Programmer | *analystPr

;7 jim) *asst Crediticollect Mar *azstCredi

;7 i *oarpenter *carpenter

;7 jim) *clerical Specialist v *clericals

;7 jim) *clinical Peychologist li *linicalP

;7 i *counselor | *counselor

;7 jim) *olemographer *demograph
;7 jim) *department Secretary *departmen
;7 i *directar Of Cars *directarC

;7 i *emt Trainer Iy *emtTraine

;7 i *invalid Job Clazs *irrealichJo

;7 i *lead Custodian *leadCusta

;7 jim) *med Transcriptionist i *medTransc
;7 jim) *medical Dept Admin li *medicalle

;7 i *mental Heatth Az=oc i *mertalHea

;7 jim) *physician *physician

;7 jim) *program Manager *programhda
1-200f2186 records Results per page Page: of 110 = =2
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Adding a Position

Step 1 Click Add New Position from the Position Management dialog box. A
Position—Add New dialog box displays (Figure 2-107).

Figure 2-107 Position—Add New dialog box

* Title:
Abbreviation:

Step 2 Enter the position name in the Title field.
Step 3 (Optional) Enter the position abbreviation in the Abbreviation field.
Step 4 Do one of the following:

—Click Apply to save the information.
—Click Done to exit the dialog box.
—Click Cancel to exit without saving the changes.

—\ —  Toremove or edit an existing position, select the Pencil / or Trashcan T icon.

Step 5 To find a position, enter data in the Filter text box and click Search.
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Configuring Specialities

Selecting Specialities from the OW5000 Directory Configuration dialog
box (Figure 2-75) displays a Specialities dialog box (Figure 2-108).
Specialities is displayed only when UA5200 is installed in the system.

Figure 2-108 Specialities dialog box

Specialty Management

Add Ne

Filter: Search

1-200f55 records Results per page Page: of 3 = ==
Name A

é? i Adolescent Medicine

é? jim) Adolescent Peychiatry

é? jim) Alleroy

é? jim) Anesthesiology

é? jim) Anesthesiology, Pedistric

é? i Burn

é? jim) Cardiac and Thoracic Surgery, Pediatric

é? jim) Cardiolocgy

é? jim) Cardialogy, Pediatric

é? jim) Child & Adolescent Paychistry

57 jim) Chiltd Development

57 jim) Critical Care, Pedistric

J @ Deriistry, Pedistric

é? jim) Dermatology

é? jim) Dermatology, Pedistric

é? jim) Electrophysialogy

é? jim) Emergency Medicine

é? jim) Emergency Medicine, Pediatric

é? jim) Endocrinology

é? jim) Endocrinalogy, Pediatric

1-200f55 records Results per page Page: of 3 = ==

Adding a Speciality

Step 1 Click Add New Speciality from the Specialities dialog box. A
Specialty—Add New dialog box displays (Figure 2-109).

Figure 2-109 Specialty—Add New dialog box

Specialty Management

* Description: |
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Step 2 Enter a name in the Description field.
Step 3 Do one of the following:

—Click Apply to save the speciality.
—Click Done to exit the dialog box.
—Click Cancel to exit without saving the changes.

Step 4 To remove or edit an existing specialty, select the Pencil / or
Trashcan @ icon next to the specialty name.

User Privileges Configuration

Step 1 Selecting User Privileges from the OW5000 Directory Configuration
dialog box (Figure 2-75) displays a User Privilege Management dialog
box (Figure 2-110). The following figure is an example when the
United States is selected as the Sales Regions.

Figure 2-110 User Privilege Management dialog box

User Privilege Management

SEARCH USERS

Organizations .l . al

Search:

Organizations Results Selected Members

~

. WEC Corporation of
+ America

- NEC Infrontia E
NEC Infrontia, Inc
NEC Unified Solutions

+ Inc b

APPLICATIONS AND ROLES

CJEmployae

[Patient

[JPhysician

[ Student

User

APPLICATIONS AND ROLES

[J Mability Client
] OWS5000 Administrator
Cucvoo

SELECT ORGANIZATION
QOrganization : <Mot Set>

Remaove

SELECT LOCATION

Location - <Not Set>
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Step 2 To modify privileges for a user, enter the user name in the Search text

box. You can also search by Organizations, Locations, Roles, or
Security.

Step 3 Select the desired application(s) in which to change privileges, and then
select the privilege type from the drop-down list.

Step 4 Click Apply.

pA3%) If the person being modified does not have an assigned role but Organization/
é Location is selected on this page, an Employee role will be created for this person
NOTE and associated with the selected Organization/Location.
gonss If the person is already assigned a role, like physician/employee/patient, and has an
= associated Organization/Location, they will simply be updated with the new values.
NOTE
gonss If multiple people are assigned User roles using the User Privilege page, the default
= password that the OW5000 uses for the created logins is PasswO0rd$.
NOTE
PR3 A maximum of 500 people can be modified at one time.
NOTE
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User Management Configuration

Selecting Users from the OW5000 Directory Configuration dialog box
(Figure 2-75) displays a User Management dialog box (Figure 2-111).
This option allows you to manage user information, and to add or
change application and role privileges. The following figure is an
example when the United States is selected as the Sales Regions.

The Password for an Administrator can only be changed from this configuration
page. The Person Management Roles page can be used for other person
configurations.

IMPORTANT

Figure 2-111 User Management dialog box

User Management

SEARCH USERS

Filter By: Last Mame - Starts With - l:l

1-80of8 recnrds Results per page FPage of 1
Last Name & First Name Full Name Login ID

J Front Desk Front Desk

é’ Guest Phone Guest Phone

67 Administrator Administrator Administrator admin

J jiig Davis Scott Davis, Scott sdavis

4 @ Little James Little, James ittle

é’ mehta vivek mehta, vivek

J jiig Mohammed Rizaullah Mohammed, Rizaullah Riza

é’ Westbrook Lesley Westbrook, Lesley

1-80f8 racards Results per page Page af 1

USER INFORMATION

APPLICATIONS AND ROLES

MC Admin Recipient

On Call Admin User
QOW5000 Administrator
Procedure Manager Admin
UAS200 Administrator

Wake Up Administrator

Use the steps below to change passwords, application privileges, or to
delete a user account.
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Modifying a User Account
Use the following steps to modify an account.

Step 1 Select the Pencil / icon next to the desired user from the list of
displayed names (Figure 2-111), or enter data in the Filter By field and
click Search.

Step 2 Enter the Login ID.

= Fields which must be completed are designated with an asterisk (*).

Step 3 Enter a new password in the New Password field.

P The length of the password must be at least eight characters long and include the
= following rules:
NOTE

1 Uppercase letter (A-Z)

1 Lowercase letter (a-z)

1 Digit(1-9)

1 Special Character (excluding a space, square brackets, backslash, and single or
double quotes)

Step 4 Enter the new password again in the Confirm New Password field.

Step 5 For Windows Authentication, enter the NTLM Login ID for the user.

PR3 This parameter is displayed only when the United States is selected as the Sales
= Region or if OW5000 Applications which are released in US market is installed.
NOTE

Step 6 To disable the user role for any reason, click the check box Login is
disabled.

Step 7 To set the password to never expire for the user, click the check box
Password never expires.

Step 8 Select the desired privilege for OW5000 Administrator as well as any
installed applications. See each application's installation guide for a
definition of each available choice.

Step 9 Click Apply.

Deleting a User Account

Step 1  Select the Trashcan @ icon next to the desired user from the list of
displayed names (Figure 2-111), or enter data in the Filter By field and
click Search. A delete confirmation dialog box displays.

Step 2 Click OK to delete the user role for this person.
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Application Data Management

From the Application Data Management page, it is possible to change
the configuration data of the OW5000 system. This configuration change
is allowed only for maintenance, and should never be changed without
first consulting with an NEC representative.

IM Archiving Management

Using the IM Archiving Management option, you can configure IM
archiving for the OW5000 system. This configuration page is restricted,
and only a user who has special privileges can see the Instant Message
menu.

Adding IM Archiving privileges for a User

Use the steps below to display the IM Archiving Management menu. It is
assumed that the user, who manages IM Archiving configurations, has
already been created and has a User role.

Step 1 Login as administrator. For more information, refer to Chapter 2,
"Logging into OW5000 Administrator" on page 2-4.

Step 2 Click OW5000 > Directory > People and then select the desired user
who should have IM Archiving Management privileges. Note that admin
cannot have this privilege for security reason.

Step 3 Click the Role tab and select the User role. Check IM Admin security
permission, then click Apply or Done.

The user who has IM Archiving Management privileges may be able to see all IM
sessions of the system. This privilege must be assigned to only one or a limited
number of users.

IMPORTANT

IM Archiving Settings

Logging in using an IM Admin account, displays an Instant Messages
menu under OW5000.

View Logs

Selecting Instant Messages from OW5000 displays an IM Archiving
Management dialog box (Figure 2-112).
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Figure 2-112 IM Archiving Management dialog box

Start Date

From
Barnett

Larty
Jones
Olivia
Jones
Dlivia

Jones
Dlivia

Jones
Dlivia
Jones
Olivia
Jones
Dlivvia

View logs

To
Jones
Olivia
Jones
Clivia
Jones
Clivia
Jones
Olivia
Barnett
Larry
Barnstt
Larry

Barnett
Larry

Barnstt
Larry
Barnett
Larry
Barnett
Larry

figu

i)

oh History

E¥ End Date:

From IMURI
Ibarnett_imi@sip.com

Ibarnett_imi@sip.com
Iharnett_im{@sip.com
Ibarnett_imi@sip.com
user_1_im@sip.com

uzer_1_im@sip.com

user_1_im@sip.com

uzer_1_imi@sip.com
user_1_im@sip.com

user_1_im@sip.com

To IMUR]

uzer_1_im@sip.com
user_1_im@sip.com
user_1_im@sip.com
user_1_im@sip.com
Ibarnett_imi@sip.com

Ibarnett_imi@sip.com

Ibarnett_im@@sip.com

Ibarnett_imi@sip.com
Ibarnett_imi@sip com

Iharnett_im{@sip.com

1-100f10 recurdsﬂ Results per page

Sender IM URI : IStans Withﬂ Receiver M URI IStans Withﬂ I Text: IStans Withﬂ |—‘
1-100f10 recordsﬂ Results per page

Text
MZ-DOS, Microsoft, snd Windows are registered trademarks of Microsoft Corporation.

This chapter outlines how to use the manusl, including the actual manual organization, chapter lsyout,
converntions, and function keys for the Dialer application

This chapter explains how to locate, view, and call a telephone number using the Dialer application
See the Openior Dialer Installation Guide for more information akout the instslistion process

NEC Unified Soltions, Inc. reserves the right to change

Welcome to the Openvvior @ Dialer User Guide. The OperorX Dialer User Guide provides the information
you need to work with the Dialer application

Dialer is an Openorx application thst enakles MEC Dterm users to sccess a corporste-wide directary on
their telephone display . With OperiorX Dialer, you can search the entire corporate directory for a
telephone number or sgarch the directory of & specific division or department

Once Disler locates the name or location that you are looking for, it displays the information on your NEC
Cterm telephone. You can then place or transfer a call to the telephone number corresponding to that ertry
When Dialer iz activated by pressing the assigned OAl key on your Dterm phaone, the prompts are displayed
on your Ctertn LCD screen. Use the keys shown below to scroll through and select the desired infornation
Operifiory Dialer can be configured to display search prompts in tvo different ways: during the installation
process, or after the installation by using the OpervorX Administrator

Fage]

Date Time
2010-09-28
132650
2010-03-23
132744
2010-09-28
132754
2010-03-23
132300
2010-09-28
132618
20100928
132713

2010-03-23
132723

20100928
132732
2010-03-23
1326821
2010-09-28
132852

This page displays all IM sessions for those using Instant Message. The
following query is available on this page to specify the session. A
combination of following parameters is also available.

Table 2-5 IM Parameters

Parameter

Description

Start Date / End Date
Sender/Receiver IM URI

IM Text

Query the message based on the text.

Query the messages for a specific term.

Query the messages based on the URI.
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Configuration

Selecting Instant Messages > Configuration from OW5000
Administrator displays an IM Archiving Management Configuration
dialog box (Figure 2-113).

Figure 2-113 IM Archiving Management—Configuration dialog box

Last scheduled archiving ran successfully.

*IM Log Age (days)

IM logs older (in days) than the value mentioned here will be archived and then deleted from database. Remaining [M logs stay in database.

* Maximum File Size (M)

Iffile size reaches maximum limit during archiving, a new file is created to log rest of the messages.
Archive Now

SCHEDULE

Enabled: [ Recurring Type Current Server Time: 4:14 PM

Schedule Time

* Start Date M E -~ Stat Time
L]
[l ‘ o

Table 2-6 IM archiving Management Parameters

Parameter Description

The archiving process uses this value to find old logs
to archive and eventually delete from the OW5000
IM Log Age database. Entering O for this field means to archive
everything. This Does Not retain any records in the
database.

If, during one instance of archiving, the file reaches the
maximum specified size, another file is created with the
same name and appended with a Time Stamp to
Maximum File Size archive the remaining messages. This goes on until all
the messages chosen by archiving process for the
current session are archived.

Maximum file size is 500MB.

The password used to encrypt the data when it is
exported.

Important: This password is used every time an

IM Archiving Password archive file is created. So, once it is changed, new and
old archived files cannot be opened at the same time
using Archive Viewer because the encrypted key is
changed.
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Parameter Description

Sets up a schedule that Scheduler picks up and starts
the archiving process using the DBTool export engine.
Archive Now The archiving process is also responsible for deletion
of IM logs from OW5000 database. Clicking this button
will inform the user the number of logs to be archived.

P33 By default, Instant Message (IM) archive files are stored in C:\Program

.—;P Files\NEC\OW5000\Runtime Platform\archive. The directory can be changed
using Application Data Management in OW5000 Administrator and searching on

the IM Archive Directory key. Users may want to change the directory to manage the

amount of disk space that is being used by the archiving process.

Administrators can use the estimate of 100K bytes per User per month when
calculating the amount of space that will be used by the archival process. This
estimate is based on 200 messages per month, per User, and an average message
size of 55 bytes.

Schedule
To enable scheduled archiving, follow the steps below.
Step 1 Check the Enabled check box and click Save.

Step 2 Select the Recurring Type from the drop-down list. Selection options
are One Time (non-recurring), or Recurring. If recurring is selected, a
frequency of daily, weekly, or monthly is available for selection. The
display screen is dependent on the kind of schedule created.

Duration of Recurrence is used to configure a detailed schedule.
Start Date: Sets the start date of this schedule.
Start Time: Sets the start time of this schedule.

End By: Sets the end date of this schedule. Select No End Date when
an end date is not needed.

P33 If a One Time schedule is set before the current time, the schedule will not be
— executed.

gonss A One Time schedule only needs the start date and time. A Recurring schedule
= needs the setting of Recurrence Pattern in addition to the Duration of Recurrence.
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History

Step 1

Click

the History tab to display Figure 2-114. This dialog box displays

the results of the schedule process for IM Archiving.

Figure 2-114 History dialog box

View loys Configuration History

Start Date End Date

Time Time
2010-08-27  2010-09-27
09:32:03 08:32.03
2010-09-24 2010-09-24
089:39:00 09:39:.00

1-20f2 recordsgn_:}ﬂ Results per page

Success r
True

True

1-20f2records(qg _HResults per page

Page]1 jﬂuﬁ

Results

Files created during srchiving: C:Program Files\NECIOWSO00Runtime Platformiarchivelda_2010_9_27_9_32_3 IMA Characters written to file
(=) 7404 Deletion of log records has finished. Reading, encrypting and writing bytes has completed.
Files crested during srchiving: C:\Program Files\NECWOWSO00 Runtime Platformiarchivelda_2010_9_24_9_39_0IMA Characters weritten to file
(=): 8448 Deletion of log records has finished. Reading, encrypting and writing bytes has completed.

Pagel1  [@of1

When a schedule is executed, the Start Data, End Date and Results are
displayed.

Settings Configuration

Selecting Settings from the OW5000 Options dialog box (Figure 2-12), displays an
OWS5000 General Settings dialog box (Figure 2-115).

General Settings

Follow the steps below to configure General Settings. The following
figure is an example when the United States is selected as the Sales
Regions.
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Figure 2-115 OW5000 General Settings dialog box

General Settings Countries & States

2-107

DEFAULT COUNTRY CODE
Select The Default Country Code:  United States of America (1)

REPORT SETTINGS

Reporting Services URL: ‘http:.l‘fgalaclicaMEReportSer\.'er

DEFAULT HOME PAGE

Select The Default Home Page: Blank{default) -

PASSWORD SETTINGS

Password Never Expires

Default Password Validity Period: l:l (days)

LICENSE MANAGER CONNECTION INFORMATION

SMTP SERVER SETTINGS

Reports must be uploaded to the report server before they can be executed:

IP Address/MName: Port: [49300

Ifany changes to this section are made, it may take a minute for the system to read licenses and reflect changes.

SMTP Server Name:|

( e.q. server.domain.prv)

Upload Reports

Server SMTP Port:[25 | (1- 65535 default '25)
SMTP Secure Por:|  |(1-65535)
Password |
Apply Cancel

Step 1 Select the Default Country Code from the drop-down list.

Step 2 Enter the Reporting Services URL. The OW5000 installed server is set
as the default URL. This parameter is displayed only when the
United States is selected as the Sales Region.

Step 3 Select the Default Home Page. The Extension or Person page can be
selected as the default page when you log into OW5000 Administrator.

pa3%) When logging in after a session timeout, the last page you used before the timeout
é displays; not the Default Home Page.
NOTE

Step 4 To set the password to never expire for the user, click the check box

Password never expires.

When Password never expires is checked, set the validity period for
the password. This parameter is disabled if Password Never Expires is

set.

Step 5 Inthe License Manager Connection Information section, do the

following:
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—enter the IP Address/Name and the Port number to set the LMC
server connection IP Address. This is a mandatory parameter.

—enter the Port number to set the LMC Server connection port. This is a
mandatory parameter.

gonss This configuration is not required when Asia is selected as the Sales Region.

Step 6 Do one of the following:

—Click Apply to save the speciality.
—Click Cancel to exit without saving the changes.

Countries & States

Follow the steps below to configure Countries & States.

Figure 2-116 OW5000 Countries & States dialog box

General Settings Countries & States

COUNTRIES/REGIONS

Add New Country/Region

Filter: Search By: MNone ¥ Number: Stars with ~ l:l

1-50f244 rec-:nr-jsﬂ Results per page Page:ﬂ of4g = ==
Description & Country Code Is Default for Install Is Default for CountryCode
> p‘f jinj Afghanistan 93 Falze Falze
> 6? jim) Albania (Republic of} 355 False Falze
> 6? jim) Algeria (People's Democratic Republic of) 213 Falze Falze
¥ é:? jinj American Samoa 1 False Falze
> 6? jim) Andorra (Principality of) 376 False Falze
1-50f244 rec-:nrdslilﬂ Results per page Page:ﬂ of4d > >

Adding a New Country

Step 1 Click Add New Country/Region in the Countries & States dialog box
(Figure 2-116). Figure 2-117 displays.
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Figure 2-117 Adding New Country/Region dialog box

General Settings Countries & States

* Description:| |
* Country Code:| |
|s Default For Install: []
Is Default For CountryCode: [

Cancel

Step 2 Enter the Description and the Country Code.
Step 3 Do one of the following for the Is Default For Install field.

—Do not check if you are creating a new Country.

—Do check if this new country is treated as the default country when
more than one county has the same country code.

Step 4 Do one of the following:

—Click Apply to save the record.
—Click Done to close the dialog box.
—Click Cancel to exit without saving the information.
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Adding New Region
Step 1  Select the target Country from the country list (Figure 2-116).

Step 2  State/Provinces displays at the bottom of list, so click Add New State/
Province. A State/Provinces dialog box displays.

Figure 2-118 State/Provinces dialog box

STATES/PROVINCES

* Mame:
* Code:

Cancel

Step 3 Enter the Name and Code.

Step 4 Do one of the following:

—Click Apply to save the record.
—Click Done to close the dialog box.
—Click Cancel to exit without saving the information.
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Schedule Configuration

OW5000 provides schedule functionality of data import/export and
database backup. It allows a variety of scheduling types such as one-
time, daily, weekly and monthly. Also, the history page shows the result
of the schedule.

Creating a DBTool Schedule

Select Scheduler from the OW5000 Options dialog box (Figure 2-12)
and follow the steps below.

Step 1  Click the DBTool tab to display Figure 2-119, and then follow the steps
below to configure the schedules.

Figure 2-119 Schedule Profile dialog box

Schedule Manager

DBTool Database BackUp History

Fiter: Profile : StatsWith ~ [ |

1-10of1records|[10 |[E Results per page Page]1 ]EI of1
Profile Name & Import | Export Source Profile Type Scheduled
TEST DBTool Import False

1-10f1 rec-:nr-js__|TD B Results per page Page]1 & of 1

Step 2 When scheduling an existing profile, click the Pencil / icon to display a
Scheduling dialog box (Figure 2-120). To delete or cancel a schedule,
click the Trashcan @ icon. Refer to Chapter 6, "Database Operations"
on page 6-1 for information on creating a DBTool Profile.

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



2-112 OW5000 Configuration

Figure 2-120 Scheduling (One Time) dialog box

DBTool Database BackUp History

Profile

Enabled: ¥ Recurring Type: IOHB Time ‘l

Schedule Time

* Start Date: M E  * Start Time: |12 'l 00 '"AM 'l
Recurrence Pattern
[Daly =
Ewvery Day(s)
Duration of Recurrence
* Start Date: |[January 192010 | & E9 € End By W
* Start Time |12 ‘"'i“-" 'l AM 'l
& No End Date
Step 3 Check the Enabled check box. When checked, the scheduled profile is
available.

Step 4 Select the Recurring Type from the drop-down list. Selection options are
One Time (non-recurring), or Recurring. If recurring is selected, a
frequency of daily, weekly, or monthly is available for selection. The
display screen is dependent on the kind of schedule created.

Duration of Recurrence is used to configure a detailed schedule.

Start Date: Sets the start date of this schedule.
Start Time: Sets the start time of this schedule.

Sets the end date of this schedule. Select No End

EndBY:  nate when you do not need to set an end date.

If a One Time schedule is set before the current time, the schedule will not be

= executed.
NOTE
paad A One Time schedule only needs the start date and time. A Recurring schedule
= needs the setting of Recurrence Pattern in addition to the Duration of Recurrence.
NOTE

For instance, if you select Recurring from the Schedule Type drop-
down list and select Daily as the Recurrence Pattern, Figure 2-121
displays.
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Figure 2-121 Scheduling (Recurring Daily) dialog box

DBTool Database BackUp History

2-113

Profile -

Enabled: ¥ Recurring Type: |Recurring ‘l

Schedule Time

* Start Date W E  * Start Time |12 '"':“-" '"-ﬂ-m ‘l

Recurrence Pattern

IDain 'l
Every Day(s)

Duration of Recurrence

* Start Date:  January 192010 T £

* Start Time: |12 '"UU '"AM 'l

" End By: m £

' No End Date

Apply Cancel

This Schedule is executed on a daily basis. Set 1 to run the schedule

import/export everyday.

Duration of Recurrence is used to configure a detailed schedule.

Start Date: Sets the start date of this schedule.

Start Time: Sets the start time of this schedule.

End Bv: Sets the end date of this schedule. Select No End
y: Date when you do not need to set an end date.

Selecting Weekly as the Recurrence Pattern displays Figure 2-122.
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Figure 2-122 Scheduling (Recurring Weekly) dialog box

DBTool Database BackUp History

Profile : IE““C-|D'_-.EES 'l
Enabled: ¥ Recurring Type: IRecurring 'I

Schedule Time

* Start Date @ ER  * Stat Tme: |12 '“ 00 '"RH 'I

Recurrence Pattern

IWeekly VI

Recur every l:l weeks on- [T Sunday [ Monday I Tuesday [~ Wednesday
[ Thursday I Friday [T Saturday

Duration of Recurrence

* Start Date: January 192010 T £ " End By: o E

* Start Time- |12 'l 00 '"AM 'l

& Mo End Date

Apply Cancel

This schedule is executed on a weekly basis. Set 1 to run the schedule
import/export every week.

Duration of Recurrence is used to configure a detailed schedule.
Start Date: Sets the start date of this schedule.

Start Time: Sets the start time of this schedule.

End By: Sets the end date of this schedule. Select No End
¥* Date when you do not need to set an end date.

Selecting Monthly as the Recurrence Pattern displays Figure 2-123.
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Figure 2-123 Scheduling (Recurring Monthly) dialog box

DBTool Database BackUp History

Profile :

Enabled: ¥  Recurring Type: IRBCUFFiﬂg 'l

Schedule Time

* Start Date @ * start Time: [12 ][00 Z[AME]
Recurrence Pattern

IMonth\y 'l

& Day | | of every | | month(s)

" The |ﬂr5t j |6L|nc|a-_-.- j of every month(s)

Duration of Recurrence

* Start Date: January 192010 T £ " End By: o fld)

* Start Time: |12 '"UU '"AM 'l

& Mo End Date

Apply Cancel

This schedule is executed on a monthly basis. Set 1 to run the schedule
import/export every month.

Duration of Recurrence is used to configure a detailed schedule.
Start Date: Sets the start date of this schedule.
Start Time: Sets the start time of this schedule.

End By: Sets the end date of this schedule. Select No End
y: Date when you do not need to set an end date.
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Confirmation of Schedule Results

To confirm the schedule results, use the Log Viewer by following the
steps below.

Step 1 Click Start > All Programs > NEC OW5000 > Runtime Platform >
LogViewer, and then select Scheduler and DBTool, which includes the
log of confirmation dates, and then click Start Search.

When the scheduler is executed, the following event is logged
(Table 2-7).

Table 2-7 Scheduler Execution

Severity Application Description

Debug Scheduler Successfully executed.DbToolPlugin:

When the DBTool is executed, the following event is logged (Table 2-8).

Table 2-8 DBTool Execution

Severity Application Description

New Application has started logging: APP:DBTool PID:
<PID #> TID:<TID #> USER:Administrator MACHINE:

Info DBTool <OW5000 server name> EXE:C:\Program
Files\NEC\OW5000\DBTools\DBToolConsole.exe
EventSource:OAIMsg.dll.

When the DBTool process is completed, the following event is logged
(Table 2-9).

Table 2-9 DBTool Process Completed

Severity Application Description
Dbug DBTool Closing Log

Step 2 If a schedule is not executed correctly, an Error event is logged between
the executed and completed event.
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Creating a Database Backup Schedule

Step 1 Click the Database Backup tab to display Figure 2-124, and then follow
the steps below to configure the schedules.

Figure 2-124 Database Backup dialog box

Dosbasecock [

* Retention Days:| 14

The backup would be taken on Dalabase server in SQL Servers default directory

® £

Cancel

Step 2 Enter the number of days in the Retention Days edit box to define the
amount of time the backup file will be kept in the server. Default is 14
days.

Step 3 Enter the File Name to define the saved backup file name. By default,
the file is backed-up in the same location as where SQL Server is
installed. By clicking Test File Path, you can confirm that the database
backup file was created correctly.

Step 4 Set the schedule based on your requirements. Refer to “Creating a
DBTool Schedule” on page 2-111 for more details.
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History

Step 1 Click the History tab to display Figure 2-125. This dialog box displays
the results of the schedule process for both DBTool and Database
Backup.

Figure 2-125 History dialog box

DBTool Database BackUp History

Filter: Event Type :IA” j' Event Name - | Starts With x|

1-20f2 FECDFGSH Results per page Page: of 1
Event Type & Event Hame Start Date Time End Date Time Success Retried
DbTool Import extensions 172002010 10:05:00 AM 172002010 10:05:00 AN True

DbTool License Import 172002010 10:10:00 AM 172002010 10:10:00 AM False

1-2 of 2 records B Results per page F'C-IQBZ of1

When a schedule is executed, the Type, Event Name, Date and the
results display. If the schedule process fails, click on the icon (left side)
of the results information. The request is then executed immediately.

Template Management

From the Template Management page, it is possible to create a template
related to person management. This page allows you to create a new
person and their related configuration; such as roles, contact methods,
and address information, in a single page.

Selecting Template Management from the Template dialog box,
displays a Template Management dialog box (Figure 2-127).

Figure 2-126 Template Management dialog box

Template Management

Add New Template

1-10of1records|[10 | Results per page Page:ﬂ of 1
Template Name A
J @ uCc700
1-10f1records|10  |EResults per page Page[1 | of1
gonss To remove or change an existing Custom Field, select the desired record and then
= click the Pencil or Trashcan icon.
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Step 1 To add a new template click Add New Template from the Template
Management dialog box. A Template Management Configuration Page
displays (Figure 2-127).

Figure 2-127 Template Management dialog box

Template Management

Template Type:  Custom Person ~  * Template Name:

PERSON ROLES
SIP Access Server: Not Assigned - 1 Employee
IM Access Server: Not Assigned - TUser

SIPUA Group: Mot Assigned ~

"1 Prefix UserDefined1
| Suffixc [ UserDefined2
" Vaoice Mail "l UserDefined3
SRy [7]UserDefined4
"1 Subscriber Id UserDefineds
L Special Dial [ yserDefineds
Code
Add Photo
I Note
CONTACT METHODS ADDRESSES
|| Alpha Pager ~ [DiBiing
[7] Assured Mobility WiFi : HDTHE_
| Dual Mode Number Bl Shipping
[CI'Work

[[1Extemal Fax

m

[C]External Primary Number

|1 Extemal Secondary Number
| External Tertiary Number
|Fax

“|Free Form

[[THome Email Address
Home Phone Number

[“I Mabile Phone

| Other Email Address

[71Other Email Pager

Step 2 Select the Template Type from the drop-down menu and enter the
Template Name.

gonas) Only Custom Person is available as the Template Type in OW5000 R5.

Step 3 Select the desired parameters to be configured in this template from the
Person, Roles, Contact Methods, and Addresses pane.

PR3 Last Name, First Name, Middle Name and Display Name will be displayed when this
= template is selected in the Person page regardless of this configuration
NOTE
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Step 4 Do one of the following:

—Click Apply to save the settings.

—Click Done to save and then exit the dialog box.
—Click Cancel to exit without saving the changes

MA4000 Integration

Please refer to Chapter 7, "OW5000-MA4000 Integration" on page 7-1

for more information.

Version Information

Selecting Version Information from "OW5000 Options dialog box” on

page 2-8, displays an OW5000 Version Information dialog box
(Figure 2-128). This is used for informational purposes only.

Figure 2-128 OW5000 Version Information dialog box

CWYE000 Yersion Information

SUMMARY BUILD INFORMATION

Version:5.4.0 A7
Build:6.408
Date: 12-21-2008
Time:01:16:39

DETAILED FILE VERSION INFORMATION

1-80f 727 records Results per page
File Harme & Path

AccessServer exe CHProgram Files\WECWAAWSO00WACoessServer)

Acdmin . Common.cl CProgram Files WECWIAWES000W diministratoribint
Addmin.Common.cil CHProgram FilesWECWAAWSO000dministratorbint
Admin MessageCenter .ol CHProgram FilesWECWIAASO000S, dministratorbint
Admin MessageCenter .ol CHProgram FilesWECWAAWSO000dministratorbint

1-80f 727 records Results per page

Version
ES51158.0
E5.125.0
651250
651250
651250

Page[1  |@lof146 > ==

Date

12852009
102009
1130,/2009
113052009
1130,/2009

Page[1  |@lof146 > ==

If Asia (Others) is selected as the Sales Region, check the OW5000 version using

the steps below.

1. Open Issue.txt from C:\Program Files\NEC\OW5000\Runtime Platform\Issue.txt

(default).

2. Confirm the underline part as the version information.

DO NOT MODIFY THIS FILE
SC-3904 OWX PROG-R4 ISSUE X.XX
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Exiting OW5000 Administrator

The OW5000 Administrator user interface can be exited by closing your

browser or by clicking Log Out in the OW5000 Administrator Control
Panel (Figure 2-12).

pa3%) OW5000 Administrator will automatically time out if there is no activity after 15
é minutes (default). If this happens, you will need to login again to continue the
NOTE configuration.

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



2-122 OW5000 Configuration

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



3-1
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Chapter Topics

WatchDog is a utility in the OW5000. It operates in the background and
monitors selected software service applications.

Should a service encounter some type of data error, it may shutdown
and disable the network service it was providing. Since these services
cannot restart themselves, WatchDog can detect the service outage and
then restart the service application. WatchDog can monitor multiple
service applications residing on the local server.

When WatchDog detects a monitored service shutdown, it first makes a
log entry, and after a set interval, restarts the service. Log entries can
aid in application troubleshooting. If the monitored service has any
dependent services set up (typically automatically set during the
installation of the application), they will be stopped before the
monitored service is restarted.

The following topics are included in this chapter.

o Verifying the WatchDog Status
e WatchDog Helper

Verifying the WatchDog Status

WatchDog is installed during the initial OW5000 installation. No
additional installation is required. It is configured by default to
automatically start every time the OW5000 Server boots.

These settings can be verified through the Administrative Tools window.
WatchDog cannot monitor the service if it is installed on another server.

WatchDog Helper

WatchDog Helper is the graphical user interface (GUI) for the OW5000
WatchDog application. The following sections describe the windows and
functions of WatchDog Helper.
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Main Window

Starting the WatchDog Helper program displays the WatchDog Helper
main window (Figure 3-1).

Step 1 Start WatchDog Helper by clicking the Start button on the workstation
desktop, and then select All Programs > NEC OW5000 > Runtime
Platform > WatchDog Helper.

Figure 3-1 WatchDog Helper main window

- WatchDog Helper B 10| =]
File Wiew Tools Help
v i i o WA - e
OWS000 Application | Host Machine | Manitoring | Retry Interval | Service Skatus |
Oy OAIManitor PROPHET Yes 10 Running
O Accessherver PROPHET Yes 10 Running
CiwConference Server  PROPHET Yes 10 Mat Running
O DBSvnC PROPHET Yes 10 Mot Running
CwIncomingCalldssi,..  PROPHET es e400 Mot Running
OwvLocationstatus PROPHET Yes S6400 Mok Running
OWOaiserver PROPHET Yes 10 Mat Running
OWPSGate\Wavservice  PROPHET Yes 10 Mot Running
iR pmid PROPHET Yes 10 Running
OwRmiRegistry PROPHET Yes 10 Running
CiiTelephony Even, ., PRZPHET es 10 Mot Running
O Tomcak PROPHET Yes 10 Running
Ready a

The columns in the WatchDog Helper main window (Figure 3-1) are
described in Table 3-1.

Table 3-1 WatchDog Helper main window—columns

Option Action

OW5000 Services that have been assigned to be monitored
Application by WatchDog.

Name of the local Host server where services are

Ao el monitored by WatchDog.

Indicates whether WatchDog monitoring is
currently enabled for a service. A service may be
listed to be monitored, but can have monitoring
Monitoring temporarily turned off to allow for specific testing
of the service application. This would be useful if
testing could generate errors or changes in the
operating status of the service.

Displays the time interval (in seconds) that
WatchDog will wait, after it monitors a service
Retry Interval shutdown, before it restarts the monitored service.
This interval is set as appropriate for the service
and its specific requirements in restarting.
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Option Action

Additional way to determine if the service itself is
running. A Service Status of "Running” could
indicate a service that was started. A Service
Status of "Not Running” could indicate a service
that was shut down. A Service Status of "Invalid/
Non Existing Service" could indicate the service is
not registered to the OS. A Service Status of
"WatchDog not running" could indicate that
service monitoring is shutdown. A Service Status
of "Not Monitored" could indicate that the
Monitoring setting is inactivated or that service
monitoring is not set.

Service Status

Main Window Display Options

The main window Tool and Status bars can be enabled or disabled. From
the menu bar, under View select to enable or disable the tool and status
bars.

The main window application listing can be sorted by selected column.
Click on a column label (OW5000 Application, Host Machine, Monitoring,
Retry Interval, or Service Status) to sort the list by that column.
Alternate selection of the sort column will alternately sort the list in
ascending or descending order.

The main window listing can be further sorted and the display enhanced
for readability.

Step 1  Select View > Options from the main window. A WatchDog Helper
Options dialog box displays (Figure 3-2).

Figure 3-2 WatchDog Helper Options dialog box

Options
— Sarting

%
%s Apply secondary sort on: [{REEENERT N

r— bulti Color

™ Use alternate colors to display list items

ok I Cancel

The Options dialog box provides the selection of a secondary sort
parameter.

Step 2 Select the secondary column from the Apply secondary sort on drop-
down list.

Step 3 The main window listing can be displayed with a different line color for
other service applications for easier readability. Select the Use alternate
colors to display list items box to apply the Multi Color display style.
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Step 4 Click OK.

Main Window Toolbar

The main window toolbar (Figure 3-3) provides toolbar buttons to
quickly access the primary WatchDog Helper functions.

Figure 3-3 WatchDog Helper main window toolbar

Menu bar

- wWatchDog Helper

File “iew Toolz Help

Tool bar flﬁ?lzﬁls’?l ﬁl %l ﬂ ‘

The seven buttons (left to right) provide quick access to the functions
described in Table 3-2.

Table 3-2 Main window toolbar

:;F',-::' Add Service item

Delete Service item

L.
S5y

.
vt

. Update Service item

£ Stop Service
E Start WatchDog
ﬁ Stop WatchDog
.@ About (Shows the “About This Program”
e information)
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The functions can also be selected by clicking the right mouse button to
display the context (shortcut) menu (Figure 3-4). Select the desired
function as indicated.

Figure 3-4 WatchDog Helper shortcut menu

7

3 Add Service

elete Service

?%?Uﬂ‘?

4 3 g
i3 Update Service
F.L:.. 5

top Service

s

watchDaog b ﬁ Start SEnine
B Stop Service

These functions are described in detail in the following sections.

Adding a Service

Use the following steps to add a service application for monitoring by
WatchDog.

Step 1 Do one of the following in the main WatchDog Helper window:

—Click Tools > Add Service.

—Right-click the name of any OW5000 Application in the main window
and select Add Service.

—Click the Add Service ﬂ button.
A WatchDog Helper Add Service dialog box displays (Figure 3-5).

Figure 3-5 WatchDog Helper Add Service dialog box

Xl
Add fen
Host Maching: Hyyiilsal= i
-in_-
L’ Inztalled 05000 Application: IGInhaI.f-‘-.F'l j

Options
¥ Monitar Service Rety Interval [in secands]: I‘IEI

Add Cancel |

Step 2 Select the desired Host from the drop-down list of available machines in
the Host Machine field.
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Step 3  Select the OW5000 application to be monitored by WatchDog for the
specific Host Machine from the Installed OW5000 Application field.

P33 If nothing is shown, all the OW5000 applications are already monitored by
= WatchDog.
NOTE

Step 4 Select the Monitor Service box under Options if WatchDog monitoring
is to be enabled at this time.

Step 5 Enter the Retry Interval (in seconds) for the restart of this application
following a shutdown.

pa3%) Some applications take longer to completely shut down than others. Selecting a retry
= interval that is too short may result in a service race condition where a service may
try to restart before it is completely shut down. This can result in serious problems
with Windows and the services may not start properly.

Step 6 Select the Add button to add the service item, or Cancel to leave this
function without saving your changes. Once an application item is added,
it will then be listed on the WatchDog Helper main window of monitored
service applications.

Deleting a Service

Use the following steps to delete a monitored service application from
WatchDog.

Step 1 Do one of the following in the main WatchDog Helper window:

—Select OW5000 Application, then click Tools > Delete Service.

—Right-click the name of any OW5000 Application in the main window
and select Delete Service.

—Select OW5000 Application, then click the Delete Service ﬂ
button.

A WatchDog Helper Delete Service dialog box displays (Figure 3-6).

Figure 3-6 WatchDog Helper Delete Service dialog box

Delate flam

Hust Machine: |PHOPHET =l
Inztalled 05000 Application: IDWﬂcceﬁSewm j

Options
V| Hanitor Service Retry Interval (in seconds): |1EI

Cancel |
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The information in the dialog box verifies the service to be removed from
WatchDog monitoring.

Step 2 Click Delete to delete the item.

Updating a Service

Use the following steps to update WatchDog settings for any monitored
service application.

Step 1 Do one of the following in the main WatchDog Helper window:
—Select OW5000 Application, then click Tools>Update Service.

—Double click the name of any OW5000 Application in the main window.

—Right-click the name of any OW5000 Application in the main window
and select Update Service.

—Select OW5000 Application, then click Update.
A WatchDog Update Item dialog box displays (Figure 3-7).

Figure 3-7 WatchDog Update Item dialog box

LUvdote Mem

% Hast Machine: [PROPHET [#]
Installed 045000 Application: IDWAccegsSewm j

Options

Rety Interval [in seconds]: I‘l 1]
Update I Cancel |

Step 2 Select or clear the Monitor Service box under Options if you want to
change this choice.

Step 3 If desired, change the Retry Interval (in seconds) for the restart of this
application following a shutdown.

Step 4 Select Update to save the changes.
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Stopping a Service

Use the following steps to stop an OW5000 application from WatchDog

Helper.
Step 1

Step 2

Do one of the following in the main WatchDog Helper window:

—Select OW5000 Application, then click Tools > Stop Service.

—Right-click the name of any OW5000 Application in the main window
and select Stop Service.

—Select OW5000 Application, then click the Stop Service ﬂ button.
A WatchDog Helper dialog box displays verifying the selected service

application to stop. This function can aid in troubleshooting services.
Click Yes.

A few seconds after stopping a service, the main window Service Status
for the selected service should indicate 'Not Running'. But, if WatchDog
service is started, after the Retry Interval time is passed, the status will
go back to 'Running'.

A Service can be stopped from the Services window. But if WatchDog service is
running, the service cannot be stopped. To stop the service from the Services
window, stop OWWatchDog first.

If OW5000 Access Server is installed on a separate server, it cannot be monitored by
WatchDog service. Stop the service from the installed server's Service window.

There is a case that the status of the Access Server keep displaying "Stopping”
when the user tries to stop/restart. In this case, stop the AccessServer.exe from Task
Manager.

When stopping a service for OWTelephony Event Notification and OWOaiServer, the
terminal which has been in a call shows the on-phone status until the on-hook event
is occurred after restart. (non SIP terminal presence feature is used)

Step 1

Starting WatchDog

Starting WatchDog will enable and start WatchDog monitoring for all
listed service applications. Select Start WatchDog from the menu bar,
toolbar, or click the right mouse button. A few seconds after starting
WatchDog, the main window Service Status should indicate the
current status for each service.

In the WatchDog Helper main window, follow one of the options below:

—Click the Start WatchDog button J .
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—Right-click at the main window and then click WatchDog > Start

Service.
PR3 WatchDog can start from Control Panel > Administrative Tools> Services and
= then start OWWatchDog service.
NOTE
gD OWS5000 Access Server which is installed in a separate server cannot be monitored
= by WatchDog.
NOTE
Stopping WatchDog
WatchDog monitoring can be stopped for all service applications. This
could be useful in application maintenance activities. Select Stop
WatchDog from the menu bar, toolbar, or click the right mouse button.
The main window Service Status should indicate 'WatchDog Not
Running' for all services.
Follow the steps below to stop WatchDog.
Step 1 Do one of following from the WatchDog Helper main window.
—Click the Stop WatchDog button M
—Right-click in the main window and then select WatchDog > Stop
Service.
PR3 WatchDog can be stopped from the Services window. (OWWatchDog service)
NOTE

Exiting WatchDog Helper

Exit the WatchDog Helper application from the menu bar, under the File
menu and select Exit.
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Log Viewer is a utility in the UNIVERGE OW5000. OW5000 applications
generally log events to the OW5000 Log Server (OAI Monitor). These
logs are then stored into log file.

Log Viewer gives a system administrator the ability to:

e Connect to the OW5000 Log Server, display logged event, and change
the log level.

¢ Open .LOG files generated by the Log Server to query, filter, and
display their contents.

e Open the current log file which is created by the OW5000 Log Server
and display the Real-time log information.

The following topics are included in this chapter.

Chapter Topics Log Viewer Support Feature

e Starting Log Viewer

e Log Viewer Main Window

e Standard Query Mode

e Print Log Information

e Real-time Query Mode

e Configuration of OW5000 Application Log Level
e Log File Maintenance

e Change Query Mode
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Log Viewer Support Feature

Log Viewer support features are different based on the environment and
the conditions.

There are two operating environment choices:

¢ Using Log Viewer on the OW5000 Platform installed server (Local).

e Using Log Viewer on a separate server from the OW5000 Platform
installed server (Remote).

There are two start-up modes available:

e Connecting with the OW5000 Log Server (Log Server)
¢ Connecting with the OAI.LOG file

Features Local Remote
Log Server OALLOG Log Server OAI.LOG

1 Query/Display current log file X ) X )
(Standard Query)

2 Query/Display saved log file ) X ) X
(Standard Query)
Filtering by text

3 (Standard Query) X X X X
Search by text

4 | (Standard Query) 2 2 2 2
High light display

5 | (Standard Query) X X X X
Day Light Saving adjustment

6 (Standard Query) X X X X
Display attached data

7 (Standard Query) X X X X
Print out event information

8 | (Standard Query) 2 2 2 2

g |Save search result X ) ) )
(Standard Query)
Bookmark

10 (Standard Query) X i i i

11 |Query/ Real-time Display currentlog X ) ) )
file (Real-time Query)
Filtering by text

2 (Real-time Query) 2 ) ) )
Search by text

13 (Real-time Query) X ) ) )

14 |High light display X ) ) )
(Real-time Query)

15 Day Light Saving adjustment X ) ) )
(Real-time Query)

16 |Display attached data X 3 3 3
(Real-time Query)
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Features Local Remote
Log Server OAILLOG Log Server OAILLOG
17 |t ot N
1 |Save search result X _ _ _

(Real-time Query)

19 Bookmark
(Real-time Query)

20 |Change Log Level
21 |Maintenance Log File
22 |Change Query Mode

<X X X X

Multiple Log Viewers can be used on the same server. However, it might be a
= problem when the Log Viewer configuration is changed. Therefore, do not change
any configurations while multiple Log Viewers are being used.

Starting Log Viewer
Log Viewer connects to the OW5000 Log Server (OAI Monitor) or the log
file which was created by the OW5000 Log Server.
Use the following steps to start Log Viewer:

Step 1 From the desktop, click the Start button, and then select All Programs >
NEC OW5000 > Runtime Platform > Log Viewer. A Connect to
OWS5000 Log dialog box displays (Figure 4-1).

Figure 4-1 Connect to OW5000 Log dialog box

g Lacation IDWEDDDSEWEII j J Qunnectl

Enter the name of an 0%W5000 Log Server machine or a log
filename to connect to

Step 2 In the Location field, type the name where the Log Server is to connect.

If this is a Local Server, type the OW5000 Platform computer name
where it connects to the OW5000 Log Server.

If this is a Remote Server, type the OW5000 Platform server IP Address
and port number (5690). For example, 127.0.0.1:5690. If the DNS is

available, the OW5000 Platform computer name is available even if it is
a remote server. You can also use the browse button (...) to select a log
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file or use the drop-down list to display all previously opened machines
and .LOG files in the Location field.

Step 3 Click the Connect button, A Log Viewer Main Window displays if it is

connected successfully. A Connect Failed dialog box displays if it failed
(Figure 4-2).

Step 4 Click OK and try again beginning with Step 2.

Figure 4-2 Connection Failed dialog box

Connect Failed [E3

Failed to connect,

Log Viewer Main Window

Starting the Log Viewer program displays the Log Viewer Main Window,
shown in Figure 4-3. Standard Query mode is applied when the Log
Viewer starts.

From the Log Viewer Main window, you can:

Specify the applications that are displayed.

Search the log files for specific information, including events, dates,
and text. See “Searching for Logged Events” on page 4-13, for more
information.

View log file information. See “Viewing Event Data” on page 4-14, for
more information.

Print log file information. See “Print Log Information” on page 4-15,
for more information.

Save query results and bookmark them for easy access. See “Saving
Search Results and Working with Bookmarks” on page 4-16, for more
information.

In Real-time Query mode, Real-time event information displays. See
“Real-time Query Mode"” on page 4-18 for more information.

Change the application log level. See “Configuration of OW5000
Application Log Level” on page 4-20 for more information.

Maintenance of log files. See “Log File Maintenance” on page 4-22 for
more information.

Change query mode between Standard Query mode and Real-time
Query mode. See “Log File Maintenance” on page 4-22 for more
information.
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Figure 4-3 OW5000 Log Viewer Main window

©: OW5000 Log Yiewer - ADAMA,
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Start T
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The Log Viewer window contains the following components:

Title Bar

4-5

Displays the name of the application and the name of the OW5000 Log
Server or log file to which Log Viewer is connected.

Figure 4-4 Log Viewer Title Bar

& DWS5000 Log Yiewer - karma

Menu Bar

The menu bar displays at the top of the Log Viewer window and contains
two pull-down menus: File and Help (Figure 4-5).

Figure 4-5 Log Viewer Menu Bar

MenuBar ——

& DW5000 Log Yiewer

File Help

Each menu item contains various menu options. Each menu item and its
corresponding menu options are described below:
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File Menu
The File menu options are Open Log, Print, Print Setup, and Exit. A brief
description of each option is listed below.
Figure 4-6 File Menu
'Ele Help

Open Log...  ChrH+O

Print... Ckrl+P

Print Sekup...

Exit
Open Log
Opens a dialog box which enables you to connect to a specified OW5000
Log Server or .LOG file. When connected to a Log Server, you can view
and configure its log parameters.
Print
Opens the Print dialog box and enables you to print the events that are
currently displayed.
Print Setup
Opens the Print Setup dialog box where you can select your printing
options.
Exit
Closes Log Viewer.
Help Menu
The Help menu option is About OW5000 Log Viewer. A description of
this option is listed below (Figure 4-7).

Figure 4-7 Help Menu

Help

About OWS000 Log Yiewer. ..

About OW5000 Log Viewer
Displays version information for the Log Viewer.
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Application Group Box

The Applications Group Box displays the application log sessions so the
user can select a session to perform searches (Figure 4-8). The
Application Group Box displays information for each log session
performed by an application as follows:

Figure 4-8 Application Group Box

£ pplication | Start Time | Lazt Logged Time | Record Count -
0 ]

Application

The name that the application used for the log session (typically the
name of the application performing the logging).

Start Time

The time of the first event logged by the application for this log session.
Last Logged Time

The time of the last logged event by the application for this log session.
Record Count

Number of records/events logged by the application for this log session.

Applications Displayed Box

The Applications Displayed in the Application Group Box can be altered
so that only the more relevant application log sessions are displayed by
using the controls in the Applications Displayed Box (Figure 4-9).

The Applications Displayed Box is activated only in the Standard Query
Mode. It is deactivated in the Real-time Query Mode.

The controls and their functions are described below:

Figure 4-9 Applications Displayed Box

Applications Dizplayed

[~ Logged in the Past |1 IHours "I

v Hide &pps With Only Application Headers
[ Connected Orly

Logged in the Past XX XXXX

When checked, the user is able to specify the most recent log sessions
by Days, Hours, Minutes or Seconds. If checked, and an application
sessions last log event is not within the specified time, that application
will not be displayed in the Application Group Box.
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Hide Apps With Only Application Headers

When this option is checked, applications are hidden that have not
logged any information, other than the initial Application started logging
message. This is normally checked so that log sessions that have not
logged anything other than the start of the log session are not
displayed.

Connected Only

When checked, applications that currently have a logging session
connected with the OAIMonitor service is displayed. Typically this will be
the applications that are currently running. To see log sessions of
applications that have ended their log session, you must unselect this
option.

Reload App List Button

If an application has started a new log session (which typically happens
when an application starts or restarts), you can reload the applications
in the Application Group Box by clicking on Reload App List to get the
most recent list of applications.

This is available only when the Log Viewer is connected with the
OW5000 Log Server (OAI Monitor).

Configure...Button

The following functions are available when selecting Configure
(Figure 4-3).

e Configure event type of applications which are connected to OW5000
Log Server (OAI Monitor.) See “Configuration of OW5000 Application
Log Level” on page 4-20 for more information.

¢ Configure the maximum file size of OAI.LOG and the maximum
number of files of OAI.LOG which stored in the server. See “Log File
Maintenance” on page 4-22 for more information.

e Backup current OAI.LOG file which is the log file of OW5000 manually.
See Page 4-22 for more information.

e Change query mode between the Standard Query Mode and Real-time
Query mode. Also able to configure the parameter. See Page 4-24 for
more information.
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Search Criteria Box

The search criteria box allows you to set the search condition of the
OW5000 application log (Figure 4-10).

The Date, Time, Severity and search text are used as search conditions.

Figure 4-10 Search Criteria Box

1 of File or Felative to Last Search End Time Span = Severiy
— = ¥ Debug
= | & HH S5 Begn| 5272008 v| [1200004M B Informtion
=~ Becords End 00:15:00 j V¥ ‘warring
ter I~ Filter data I Daylight Saving Time — Start AutoHefresh | IV Eror

Search from Begin/End of File or Relative to Last Search Radio Button

Selecting this option allows the user to search from a point in the file
(beginning, end, or from the last search position). The following types of
relative searches are available:

Last

Backward search starting from the end of the file.

First

Forward search starting from the beginning of the file.

Previous

Backward search starting from the first record displayed on the
previous search.

Next

Forward search starting from the last record displayed on the previous
search.

Include Previous

Same as Previous except the current search results are not cleared.
The new search results are inserted in front of the current search
results.

Include Next

Same as Next except the current search results are not cleared. The
new search results are appended to the end of the current search
results.

The range can be specified by either a time range or number of records.
HH:MM:SS

Indicates the range to be displayed specified by the number of Hours,
Minutes and Seconds from the first record displayed.

Records
Indicates the number of records to be displayed.

) This will override the Max. Number of Results in the Application Log Properties
= dialog box—Maintenance tab. This is deactivated when in Real-time Query Mode.

Selecting Search by Begin Time Radio Button allows the user to
search by specifying a begin time. The end of the search can be
specified by one of the following ways:
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Figure 4-11 Search by Begin Time

% Search by Beqgin Time and IEI‘TEI Time Span 'I

Begn | 5/27/2003 =] [120000AM =

End 00:15:00 :II

End Time
Indicates the user will specify the absolute end date and time for the
search.

Record Count

Indicates the user will specify the number of records that the search
will display.

End Time Span
Indicates the user will specify how many Hours, Minutes, and Seconds
past the Begin Time that the End Time will be for the search.

This will override the Max. Number of Results in the Application Log Properties
dialog box—Maintenance tab. This is deactivated when in Real-time Query Mode.

Severity Box

The Setting Severity Box allows the user to select search conditions
based on an event type. There are 4 types of events; such as Debug,
Information, Warning, and Error. The user can set the type per
selected application.

Filter Field

Type a word or phrase in the Filter field to filter the list for a word or
phrase (Figure 4-12).

Figure 4-12 Filter Field

Filter | extensior] I~ Filter data

Select the Also filter data check box if you want to filter the
information in the attached data.

Daylight Saving Time Check Box

Setting this parameter allows the user to adjust Daylight Savings Time.
Start Time and Last Logged Time in the Application Group box, and Time
in the Event Display Area are the target of this adjustment.
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Start Search Button

Clicking the Start Search button allows the user to start the search
using search conditions which are assigned in the Search Criteria for
application(s) assigned in the Application Group Box. Search results
displayed in the Event Display Area and the total event number is
displayed in the search result display area per event type.

Start Auto Refresh Button

Clicking the Start Auto Refresh Button allows the user to start a Real-
time display. It is deactivated when in the Standard Query Mode.

Search Results Display Area

The total number of events information is displayed in this area for each
event type (Figure 4-13).

Figure 4-13 Search Result Display Area

[ebug I 0 Information I 11 “wWaming 0 Error ]

Find Field

Step 1 Type a word or phrase in the Find box to find a specific word or phrase in
a log file (Figure 4-14).

Figure 4-14 Find Field

Find | > on | ]

Step 2 The specific word is highlighted in yellow by clicking the ON button.

Step 3  Clicking the right or left arrow allows you to scroll through the display to
reach the next target event.

Log Viewer searches above or below the currently selected log event,
depending on the arrow you select.
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Event Information Display Area

The Event Information Display Area displays the searched event
information (Figure 4-15).

Figure 4-15 Event Information Display Area

Time | Severity | Application | D ezcription -

05/27/09 09:10:12.140 Info DAlServer.pbe.internal  Top of loop in read thread..

05/27/09 09:10:28.953 Info DAlServer. pbe.internal  AlFacilitiestd ap.getFacili(43, 0)..

05/27/09 09:10:28.953 Info 0AlServerpba.internal  OAlHeartbeat. processdd () nstBytel ni=xd byteCount=24 count=20.a1 81 15 30811202 _|

05/27/09 09:10:28.953 Info OalServer.pbe.internal - Top of loop in read thread..

05/27/03 03:10:45.656 Info OalServer pba.internal - AlF acilitiestd ap.getF acility(48, 0)..

0R/27/09 09:10:45.656 Info DalServerpbe.internal - DAlHeartbeat. processal (] netButel ne=xd byteCount=24 count=80.a1 81 1530811202

OR/27/09 09:10:45.656 Info DalServerpbe.internal - Top of loop in read thread..

0R/27/09 09:11:02.484 Infa DalServer.pbr.internal  AlFacilitiest ap.getF acility(48, 0)..

05/27/09 09:11:02.484 Info DAlServer.pbe.internal - DAlHeartbeat. procesad (] nutButel ne=xd byteCount=24 count=80.a1 81 15 3081 12 02

05/27/09 09:11:02.484 Info 0AlServer.pba.internal  Top of loop in read thread..

08/27409 09:11:19.000 Info OalServer.pba.internal - AlFacilitiestd ap.getF acility(48, 0)..

08/27409 09:11:19.000 Info OalServer.pba.internal - DalHeartbeat. processd (] netBytel nu=xd byteCount=24 count=E0.a1 81 15 30811202

05/27/03 03:11:19.000 Info OalServer.pbs.internal - Top of loop in read thread..

0R/27/09 09:11:35.609 Info DalServer pbe.internal - AllF acilitiestd ap.getF acilit(48, 0)..

OR/27409 09:11:35.609 Info DalServer pba.internal - DAlHeartbeat. proceszd ] (] netButel ir=xd byteCount=24 count=80.a1 81 15 308112 02

05/27/09 09:11:35.609 Info DalServer.pbe.internal  Top of loop in read thread..

05/27/09 09:11:52.843 Info DAlServer.pbe.internal  AlFacilitiestd ap.getF acility(48, 0)..

05/27/09 09:11:52.843 Info D&|Server phw.internal - DAIHeartbeat processal (] nstBytel ne=xd byteCount=24 count=80.a1 811530811202 _
3 I

OF 9700 01157 0473 ke FLAIT mrcime mbas ebarmed T of lome fe enned oo

4 |

Time

The Time when the application event happened
Severity

Event Type

Application

Name of log session for the application
Description

Description of log information

Data

Data size for the event
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Standard Query Mode

The Standard Query Mode allows the user to search and display the
event information.

e Connect to the OW5000 Log Server to search and display the logged
events which have been logged when the Start Search was clicked.

e Open the log file created by the OW5000 Log Server to search and
display the logged events.

Searching for Logged Events

Use the following items to filter a search of logged events in the Log
Viewer.

e the application
e the time period

¢ the log file severity type - such as Debug, Information, Warning,
or Error

e Text Filter

Starting a Search

Step 1  Select the application whose files you want to search from the
Application group box. To select more than one application, hold down
the Ctrl key while you click each application.

Step 2 Set the search time period from Search from Begin/End of File or
Relative to Last Search or Search by Begin Time.

Step 3 Select one or more checkboxes in the Severity type group box: Debug,
Information, Warning, Error.

Step 4 If you are searching for a particular event, extension, or pattern, type this
text in the Filter field.

Step 5 Click the Start Search button to begin searching the log files. Search
results are displayed in the Event Information Display Area, also the total
number of Debug, Information, Warning and Error events are displayed
in the Search Result Display Area.

If the data for a given time period seems incomplete, check the Max Number of
Results on the Configure > Maintenance tab. It is possible that more entries exist
for this time period, but the logged entries exceed the maximum number of results
configured. To solve this problem, either issue another query where the Start Time
begins from the point where the last entry leaves off, or increase the Max Number of
Results.
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Searching Logged Events for Specific Test

Once the list of logged events is displayed, you can search or filter the
list for a specific word or phrase.

Finding a specific word or phrase

Step 1

Step 2

Type a word or phrase in the Find box to find a specific word or phrase in
a log file. Click ON button if the highlighted word/phrase displays.

Click the Prev or Next arrow to scroll through the log events. Log Viewer
searches above or below the currently selected log event, depending on
the arrow you select.

Filtering the list for a word or phrase

Step 1

Step 2

Step 3

Type a word or phrase in the Filter field to filter the list for a word or
phrase.

Select the Also filter data check box if you want to filter the information
in the attached data.

Click the Start Search button to begin the search. The log events, from
your search containing the specified word or phrase, are displayed.

Viewing Event Data

If data is attached to a log event, the size of the data displays in the
Data column of the box displaying the logs. To view data attached to a
log event, double-click the desired logged event that contains attached
data. The data and a brief description of the data is displayed in a list

box.

Reload Application List

If an application has started a new log session (which typically happens
when an application starts or restarts) you can reload the applications in
the Application Group Box by clicking on Reload App List to get the
most recent list of applications.
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Print Log Information

Once the list of logged events is displayed, you can print one or more
log events from the Logs tab.

To print one or more log events:

Step 1  To select more than one log event, hold down the Ctrl key to select each
event or hold down the Shift key to select a range of events.

Step 2 Click File > Print from the menu bar. Figure 4-16 displays.

Figure 4-16 Print Log Query Results dialog box

Print Log Query Results E
r— Printer
Broperties |

M ame: <P'S Document Writer

Status:
Type:
Where:
Cornment:

— Options Copy Options
[v Prirt binary data associated with events Mumber of copies: |'|
Limit datata [512 bytes =]

¥ “Wamings in Bold ¥ Errore in Bold

0k I Cancel

Step 3 Select the printer Name that you want to use.

Step 4 To print the binary data as well as the log event, select the Print binary
data associated with events checkbox.

Step 5 To print warnings in bold, select the Warnings in Bold checkbox.
Step 6 To print errors in bold, select the Errors in Bold checkbox.

Step 7 Click OK. The selected log events print.
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Saving Search Results and Working with Bookmarks

Log Viewer allows you to save the results of a query to a text file, to set
a bookmark in the results, and to jump to a bookmark once it is set. To
use these features, click the right mouse button on the results of a
query to open a shortcut menu with the save results, and bookmark
options (Figure 4-17).

Figure 4-17 Log Viewer Shortcut menu

| Severity | Application | Description :I
0909:05:18.375 Info Al anitar Hardwarek.eyCode="DC302E 8330EQFBD T
/09 09:05:21.656 Infa Al onitar Platform Y alidated with Serial Mumber RUMTIM [Trial Licenss]

| 0g Service 5
0A|Server pbe 409 = erend 19 F 28 TID::

R Lo o= 1= L= D e A A T o) .
0909 31 Info 0AIServer. phaintermal Mew Application has started logaing: APP:0AlS erver pbx. internal PID:3028 TI
/09 09:05:29.046 Info 0AlServerintemnal Mew Application has started logging: APP:0AIServerinternal PID: 3028 TID:26
/09 09:05:29.046 Info QOalServerinternal Logging configured..

09 09:05:29.046 Info 0AlServerintemnal Logaing configured..

/09 09:05:29.046 Info QOalServerinternal initializing ‘Windows security.. -
N0 N0.NE-20 04D lefe MAIC mrvme imbmrss =] I HRR PN P W (O EOPPP ey W _’lJ

Saving Query Results
Use the following steps to save the results of a query to a text file.

Step 1  Select the log event(s) to be saved. To select more than one log event,
hold down the Ctrl key to select each event, or hold down the Shift key
to select a range of events.

Step 2 Click the right mouse button on the result(s) selected to open the
shortcut menu (Figure 4-17), and then do one of the following:

—Select Save Results with Event Data As to save the Log Events and
Log Event Data of the search results.

—Select Save Results without Event Data As to save only the Log
Events of the search results.

Refer to “Viewing Event Data” on page 4-14, for more information on
Event Data.

Step 3 Click Save.

Creating a Bookmark
Use the following steps to create a Bookmark:

Step 1 Click the right mouse button on the desired log event to set a bookmark.
A shortcut menu opens.

Step 2 Select Add Bookmark. An Add Bookmark dialog box displays
(Figure 4-18).
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Figure 4-18 Add Bookmark dialog box

Add Bookmark

Name | 4 |
Cancel |

The name of the bookmark you specify will appear in the
contest menu for the Query Results, Al bookmarks are reset
when a new Cuery iz started.

Step 3 Enter the name of the bookmark and click OK. The new bookmark is
saved and displayed in the Bookmarks on the shortcut menu
(Figure 4-19).

Opening a Bookmark

A Bookmark is available only when the query result is displayed.

Use the following steps to open a Bookmark.

Step 1 Select the Bookmarks from the shortcut menu to go to an existing
bookmark.

Step 2  Select the desired bookmark. The log results will scroll so that the
bookmarked event is visible and selected (Figure 4-19).

Figure 4-19 Selecting a Created Bookmark

Time | Severity | Application | Description

05/27/0909:.05:18.375 Info D&l konitor
05/27/0909:05:21.6586 Infa O&lManitar
05/27/0909:.05:21.796 Info O&lkonitor
05/27/0909:0%:22.296 Info Watch Dog
05/27/0909:.05:22 671 Info “Watch Dog
05/27/0909:05:24.875 Info Watch Dog
kS Mew Application has started logging: APF-AMS PID:

Hardwarek epCode="DC30 2E8930EOFEDT"
Mo Clustering License Found.

Service Started.

AbdS hes
LaunchéisService. W0 aiServer  Mew

Save Results with Event Data As. ..

05/27/09 09:05:28906 Info  ‘Wakch Dog Sery  33ve Results without Event Data As...
05/27/0909:05:29.015 Info 0A|Server.pbe. x409 e, Add Backmark
05/27/09 09:05:29.031 Info 0AlServer. pha internal Mew o

05/27/0909:05:29.045 Info
05/27/0909:05:29.04E  Info

0&lServerinternal Mew
0alServerinternal Logaing configured..
05/27/09 09:05:29.048 Info 0AlServerinternal Logaing configured..
05/27/09 09:05:29.04E  Info 0alServerinternal initializing ‘Windows security..

AF M7 00 N0.AF-90 0AC Leb MUALE ey vmr ke =] FERTHN HRE W R ISP e i

dl |
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Real-time Query Mode

Real-time Query Mode allows the user to search event information and
display the information in the event window. Connecting with the
OW5000 Log Server (OAI Monitor) displays the event information after
the time set for Start Auto Refresh is clicked.

Real-time display of event information

Use the following items to filter a search of logged events in the Log
Viewer.

e the application

¢ the log file severity type, such as Debug, Information, Warning, or
Error

o Text Filter

Start/Stop search

Step 1 Click the Configure button. After an Application Log Properties dialog
box displays, click the Maintenance tab.

Step 2 Click the Real-time Query radio button, configure the Max. Number of
Lines (if required), and then click OK.

Step 3 Select the application whose files you want to search from the
Application group box. To select more than one application, hold down
the Ctrl key while you click each application.

Step 4 Select one or more checkboxes in the Severity type group box: Debug,
Information, Warning, or Error.

Step 5 If you are searching for a particular event, extension, or pattern, type this
text in the Filter field.

Step 6 Start the event information search by clicking the Start Auto Refresh
button. The searched event information will be displayed in the event
information display area. The total number of the following will display in
the Search result display area, Debug, Information, Warning and Error.

Step 7 Click the Stop Auto Refresh button to stop the Real-time display.

You cannot change the search application during the Real-time display. To change
the application, stop the Real-time display, change the search application, and then
click the Start Auto Refresh button.

When the total number of lines displayed in the event information display area
exceeds the Max. Number of Lines, which is assigned using the Maintenance tab,
the oldest information in the event display area is deleted.

If the OAIL.LOG file reaches the maximum file size, the Real-time display will not
continue the back up process.
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) Real-time display is available only for the application which is connected with the
= OWS5000 Log Server (OAI Monitor), and also displayed in the Application Group box.

Finding a Specific Word or Phrase

Once the list of logged events are displayed, you can search or filter the
list for a specific word or phrase. To find a specific word or phrase in a
log file, follow the steps below.

Step 1 Type a word or phrase in the Find box.

Step 2 Click the Prev or Next arrow to scroll through the log events. Log Viewer
searches above or below the currently selected log event, depending on
the arrow you selected.

Filtering the list for a word or phrase

Step 1 Type a word or phrase in the Filter field to filter the list for a word or
phrase.

Step 2 Select the Also filter data check box if you want to filter the information
in the attached data.

Step 3 Click the Start Search button to begin the search. The log events from
your search that contain the specified word or phrase displays.

All events display when pressing the Enter key. You do not need a value
in Filter field.
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Configuration of OW5000 Application Log Level
OW5000 Log Viewer allows a user to set or change an event type of the
application that is connected to the OW5000 Log Server (OAI Monitor).

Step 1  Click the Configure button in the Log Viewer Main Window
(Figure 4-3). Figure 4-20 displays.

paad This feature is available only when the Log Viewer is connected to the OW5000 Log
= Server (OAI Monitor).
NOTE

Figure 4-20 Application Log Propetrties dialog box—Applications tab

Applications | Maintenance I

—Application Mame — Applications Dizplayed — Severity Filter
LA
DB T ool [” Cormected Only ] sk
IncamingCallssistant W Information
LaunchdsService WO aiServer ¥ Hide Apps With Mo Events
LaurichisS ervice. 0WRmid - V¥ waming
LocationStatus
OalMaritor =| v Eror

Ornly events that match the specified zeverity filter will be recorded for the selected application. To zet the
default zeverity filter for applications that have not logged, select “Mew Applications”

0k I Cancel Apply Help

Application Name Box

Displays the Application names that are connected to OW5000 Log
Server (OAI Monitor).

Applications Displayed Box

Using this configuration, applications strongly related to the OW5000
only will display.

Connected Only

This check box is available only when the application is connected with
the OW5000 Log Server (OAI Monitor).

When selected, only the applications that have a current log session
with the OW5000 Log Server (OAIMonitor) will be displayed. Usually
these applications get together with the applications which are currently
working. To display all applications, this check box should be
unchecked.
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Hide Apps With Only Application Headers

If this check box is checked, the applications that do not have an event
log will be hidden in the event information display area.

Severity Filter Box

The Severity Filter allows the user to set or change the display event
type of the applications selected in the Application Name box. There are
four event types (Debug, Information, Warning and Error) and can
be selected per application. Unchecked events are not logged nor
displayed in the event information display area.

Click Apply to save the configuration. The selected event type
configuration will be applied after this process in the log file (OAI.LOG),
which is created by the OW5000 Log Server (OAI Monitor).

Change Log Level Process

Select the application name from the Application Name box. The
current configuration of the selected application will display in the
Severity box. To select more than one application, hold down the Ctrl
key while you click each application. In this case, the last application
configuration displays.

Select one or more checkboxes in the Severity type group box: Debug,
Information, Warning, or Error.

Click Apply or OK. The same configuration is applied if more than one
application is selected.
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Log File Maintenance

The OW5000 Log Viewer allows the user to maintain a log file that is
created by OW5000 Log Server (OAI Monitor).
Step 1  Click the Configure button in Log Viewer Main Window (Figure 4-3).

Step 2 Click the Maintenance tab. Figure 4-21 displays.

Figure 4-21 Application Log Properties dialog box—Maintenance tab

Applications  Maintenance |

— Logfile Parameters

tawirnurm Log Size [MB] I
b airnurn Log Files |2 Backup Current Log |

— Standard/Realtime Query Configuration
%" Standard Queny

td &= Mumber of Fesults |5IJEI

" Realtime Query

bdax. Mumber of Lines IEDEI
0k I Cancel Apply Help

Logfile Parameters Box

The Logfile Parameter Box allows the user to set a maximum log file size
(OAIL.LOG), and a maximum number of files stored in the disk. You can
also create a manual backup.

The required maximum log file size can be changed based on the
feature and traffic. Choose the proper settings based on the servers’
available disk size and backup period of the log file.

gonas This feature is available only when Log Viewer is connected to the OW5000 Log
= Server (OAI Monitor).
NOTE

Maximum Log Size (MB) Field

Configure maximum file size of OAIL.IOG (MB)

The Default is 50MB and it is configurable between 1MB and 1024MB.
The configuration is applied when the Apply button is clicked. The
Backup file name format is OAI_MMDDYYYY_HHMMSSmmm.Log.

(MM:month, DD:day, YYYY:year, HH:hour, MM:minute, SS:second,
mmm:millisecond)
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The OAI.LOG file is stored in OW5000 Platform install folder. For
example, C:\Program Files\NEC\OW5000\Runtime Platform\

The Underline(_) is the path which is selected during OW5000 Platform
install step.

Backup files are stored in following path.
C:\Program Files\NEC\OW5000\Runtime Platform\archive

Maximum Log Files Field
Configure the maximum number of backup files.
The Default value is 2 and it is configurable between 2 to 999.

The Configuration is applied when the Apply button is clicked. The
oldest file is deleted when the backup files reach this maximum value.

Backup Current Log Button

Click this button to backup the OAIL.LOG file manually. The Backup file is
stored in the backup file folder as:
M_OAI_MMDDYYYY_HHMMSSmmm.LOG file format.

(MM:month, DD:day, YYYY:year, HH:hour, MM:minute, SS:second,
mmm:millisecond)

The following step is for a manual backup.

Step 1 Click Backup Current Log button. Figure 4-22 displays.

Figure 4-22 Delete Log File dialog box

Delete Log File

‘?(J Are you sure ko delete the current log?

Cancel |

Step 2 Click OK to delete the log file or Cancel to suspend this process.

Figure 4-23 displays, with the stored file path information, when a backup
is successful. If the backup fails, a Delete Log File—Delete NG dialog
box displays. Try executing again at a later time.

Figure 4-23 Delete Log File—Backup Copy dialog box

Delete Log File E

Current log file is deleted with a backup copy saved to C:iProgram FilesiNEC,OWS000YRuUntime PlatfarmtarchivelM_0OAI_05262009_223421906.L0G,

If the backup fails, a Delete Log File—Delete NG dialog displays. Try
again after a short period.
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Change Query Mode

The OW5000 Log Viewer allows a user to change the query mode by
clicking the Configure button in the Log Viewer Main Window
(Figure 4-3). An Application Log Properties dialog box displays.

Step 1  Click the Maintenance tab.

Standard/Real-time Query Configuration Box

Select Standard Query Mode or Real-time Query mode as the Log
Viewer query mode.

The following configurations are available for each mode.

Standard Query Radio Button

Select this options if the Standard Query mode is used.
This mode is selected when Log Viewer starts up.

Max. Number of Results Field

Set the maximum events number which displays in the Event
Information Display Area when in Standard Query Mode.

Click Apply after the proper value is set in the Max. Number of Results
field.

The default value is 500 and it is configurable between 1 and
4294967295.

Entering smaller numbers will allow users to view the query results
faster. However, if the time period of a search is too short, the desired
results may not be viewable due to the volume of events within the time
specified in the query. If this happens, either increase this number to
the desired size or narrow the window of time to retrieve fewer
matches.

Real-time Query Radio Button

Select if Real-time Query mode is used.

Real-time Query mode is available only when the Log Viewer is used on
the OW5000 platform server.
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Max. Number of Lines Field

Set the maximum events number which displays in the Event
Information Display Area in Real-time Query Mode.

Click Apply after the proper value is set in the Max. Number of Lines
field.

The default value is 500 and it is configurable between 1 and
4294967295.
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IM Archive Viewer

IM Archive Viewer is the application to manage IM (Instant Message)
archive files created by OW5000. The System Administrator can open
single or multiple IM archive files and query by the following conditions:
e Beginning Date/Time and End Date/Time

Sender SIPURI/Receiver SIPURI

Keyword in the message text

Delivered or not

This application can also search specific key words from a query result
and save it into a local file.

This chapter includes the following topics.

Chapter Topics: e Starting IM Archive Viewer
e Using IM Archive Viewer

Starting IM Archive Viewer

Please follow the steps below to start IM Archive Viewer.

Step 1  Select Start > All Programs > NEC OW5000 > IM Archive Viewer >
OWS5000 IM Archive Viewer. A Choose Archive Files dialog box
displays (Figure 5-1).

Figure 5-1 Choose Archive Files dialog box

!Ehoose Archive Files [ %]
Archive Files: Add
Femove |
Password:
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Step 2 Click the Add button to add IM archive files into the Archive Files field.
IM archive files can be added into this field using drag and drop. Note
that the total size of IM archive files must be less than 500 MB.

Step 3 Enter the password, which is specified by OW5000 Administrator to
create an archive, in the Password field and click Open. After decrypting
the archive files, Figure 5-2 displays.

pA3%) The Password for the IM Archive files is specified using OW5000 Administrator:
= OWS5000 > Instant Messages > Configuration page—IM Archiving Password
parameter.
NOTE
pa33) If added files require a different password, the IM Archive Viewer decrypts the files
= that use the specified password.
NOTE

Figure 5-2 IM Archive Viewer Main Window

B ows5000 IM Archive Viewer IH[=] B3

r— Search Criteria

Begin [T 2010/09/24 | Jioozzo =] End I [eoiosogser i | [FAEE] =

From URI: | ToURE: |

Message: I Delivered: IBDth j Search |
Save Fesult | ™ Daplight Saving Time Find: I j ON | < >|

| DateTime | From LRI | Ta URI | Meszage | Delivered | From Perzon Mame | To

1| | 3
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Using IM Archive Viewer

IM Archive Viewer can show IM information from the archive files by
specifying a condition. If a condition is not specified, the entire IM log is
shown.

The following topics are included in this section:

e Specifying a Search Condition

e Displaying IM Information
Saving IM Logs to a File
Daylight Saving Time

Keyword Searching from IM Text
Exiting IM Archive Viewer

Specifying a Search Condition

Use the following parameters to search the IM Archive Viewer log.

Begin date/time, End date/time

This parameter specifies the period of the IM log. To specify the period,
check each parameter then set the date time.

The Begin parameter shows the date/time of the first IM log and the
End parameter shows the last IM log in the archive as default.

Beain [ [2010/09/24 =l o7z = End I [aoto0s08:27 =l |na15:59 =

From URI To URI

Search by a specified SIPURI from the archive file. This parameter is
case insensitive.

From LRI | TolRL |

Message text

Search by a specified Message text from the archive file. This
parameter is case insensitive.

Meszage:
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Delivered flag

Select from Both, True or False. Each parameter searches by
message, whether it is delivered or not.

Both: Search both delivered and undelivered IM
True: Search delivered IM only
False: Search undelivered IM only

Delivered: IBDlh j

True
Falze
b

Displaying IM Information

IM logs, specified by a search condition, are listed in the IM information
fields (Figure 5-3).

Figure 5-3 IM Information Fields

D ateTime | From LRI ‘ ToURI ‘ Message Delivered From Person Name: To Person Mame Delivered DateTime

1 58 com | Ibamett, df Jol via Bamett Larmy

2 2010/09/24 10:07:28 | lhamett_im@sip.com |uzer_1_im@sip.com | 32412341234123412 True Barnett Larmy Jones Olivia 2010/09/24 05:07:28
3 2010/09/24 10:07:35 |user_1_im@sip.com |lbamett_im@sip.com |fgsdfgsdfgsdfgsdhfhighikahkbxcvbuezyz... | True Jones Olivia Bamnett Lamy 2010/09/24 05:07:35
4 2010/09/24 10:07:39 | Ibamett_im@sip. com |user_1_im@sip.com | 45235452345 True Barnett Larmy Janes Olivia 2010/09/24 05:07:39
5 2010/08/24 10:07:42 |user_1_im@sip.com | lhamett_im@sip.com | gikfgfdh True Jones Olivia Barmett Larmy 2010/08/24 05:07:42
[ 2010/09/24 10:07:47 | Ibamnett_imE@sip.com (user_1_im@sip.com | 5234634674846315123452345 True Barmett Lary Janes Olivia 2010/09/24 05:07:47
7 2010/09/27 09.15:40 | user_1_im{@sip.com |lbamett_im@sip.com | fasdfasdiasdiasdiasdf Tiue Jones Qlivia Bamnett Lamy 2010/09/27 04:15:40
8 2010/08/27 09:15:47 | lhamett_im@sip.com |user_1_im@sip.com | 41234231412341234 True Barnett Larmy Jones Olivia 2010/08/27 04:15:47
=] 2010/09/27 09:15:50 |user_1_im@sip.com |lbamett_im@sip.com | fasfsadfasdiasdfzadt True Jones Olivia Bamett Lamy 2010/09/27 04:15:50
10 2010409427 09.15:53 | Ibamett_im@Esip.com |user_1_im&sip.com | 232152345234523 True Bamett Lary Jones Olivia 2010/09/27 04:15:53
11 2010/09/27 09.15:56 | lbamett_im@sip.com |user_1_im&@sip.com | 5E7EEE7E5367E6 3463456 True Barnett Larmy Jones Olivia 2010/09/27 04:15:56
12 2010/09/27 09:15:59 |user_1_im@sip.com | lbamett_im@sip.com | asdfasdfasdiasdfza True Jones Olivia Barnett Lamy 2010/09/27 04:15:59

Saving IM Logs to a File

Search results can be saved as a local file. To save the logs, select the
desired IM logs to save and click Save Result. To select multiple logs,
click the desired logs using the CTRL key.

Save Result |

To select all logs, click in the left top of the list.

DateTime | Frarm LRI |

i|:|_ cam
2010/09/24 10:07-28 |Ibarmett_imiDzip.com |L
201040924 10:07:35 |uger_1_im@Esip cam |1
2010/09/24 10:07:39 [lbamett_imd&zip.com |L

- B e 4 e n

LD
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The Saved file is in CSV format and stores each field name and the IM
information.

The Saved file is not encrypted. IM Archive Viewer cannot open saved CSV file.

Daylight Saving Time

By checking the Daylight Saving Time box, the date/time information of
the search result is shifted as daylight savings time.

[T Daylight Saving Time

Keyword Searching from IM Text

The IM Archive Viewer can find an IM log by keyword using the search
option.

Find: | = own |

Step 1 Enter the desired word to search in the Find field and click OK. IM
Archive Viewer queries the search and highlights the word in yellow if the
word is found.

Figure 5-4 IM Search Results

B 0w5000 IM Archive Yiewer =]

[~ Search Criteria

Beghe [~ [aoins9:24 x| [reozza0 = End: | il F T R EEE] =|

From URI: | TolRE |

Message: I Deliverad: IEDlh j Search
Save Result | ™ Daylight Saving Time Find I- j OFF <|>»

Meszage Delivered | From Perzon Name

1 e asdf :

2 2010/09/24 10:07:28 | Ibarnett_im@sip.com (user_1_im@sip.com [3241234123412341 2 Tiue Barnett Larmy Jor
3 2010/09/24 10:07:35 |user_1_im@sip.com | lbamett_im@sip.com |fgzdigsdfgsdigsdhfhighilkghkbrevbxeva. | Tue Jones Olivia Ban
4 2010/09/24 10:07:39 | Ibarnett_imd@sip.com |user_1_im@sip.com |45235452345 Tiue Bamett Larmy Jone
5] 2010/09/24 10:07:42 |user_1_im{@sip.com | Ibarnett_imEsip.com | gikfgfdh Tiue Jones Olivia Ban
B 2010/09/24 10:07:47 | Ibarnett_im&sip.com |user_1_im@sip.com | 523463467 484631 5123452345 Tiue Barnett Larmy Jor
7 2010/09/27 09:15:40 |user_1_im@&sip.com |lbamett_im@sip.com |fazdiasdfasdiasdiasdt Tiue Jones Olivia Ban
) 2010/09/27 09:15:47 | bamett_im@sip.com |user_1_im@sip.com | 41234231412341234 Tiue Bamnett Lamy Jone
9 2010/09/27 09:15:50 |user_1_im@sip.com |lbamett_im®sip.com |fasfzadiasdizsdizadf Tiue Jones Olivia Ban
10 2010/09/27 05:15:53 | Ibarnett_im@sip.com |user_1_im@sip.com | 232152345234523 Tiue Barnett Larmy Jor
1 2010409427 09:15:56 | lbarnett_imE@sip.com |user_1_im@sip.com | 56785678536763463456 Tiue Bamett Larmy Jare
12 2010/09/27 09:15:59 |user_1_im@sip.com |lbamett_im®sip.com | asdiasdiasdiasdiza Tiue Jones Olivia Ban
4| »
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Step 2 Use the right allow button to jump to the next keyword and the left allow
button to jump to the previous keyword.

Step 3 Click Off to cancel the keyword search.

Exiting IM Archive Viewer
Step 1  Click the X button on the IM Archive Viewer to exit.
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DBTool is a utility in the OW5000 Platform in OW5000 R4. It provides a
system administrator the capability to import and export data between
the OW5000 databases and text files. The OW5000 Master database can
be populated in a number of ways, including OW5000 Administrator and
DBTool.

The following topics are included in this chapter.

OW5000 Administrator

DBTool (Database Import/Export)
DBTool

Data Mapping Quick Reference Tables

Chapter Topics:

OW5000 Administrator

OW5000 Administrator is part of the OW5000 Runtime Platform.
“Maintaining the OW5000 Directory” on page 2-69 describes how to use
OW5000 Administrator to enter and maintain records in the database.

DBTool (Database Import/Export)

The DBTool allows data to be imported and exported into OW5000
databases. Specifically, this tool imports Extension, License, Location,
Organization, Person, Route/Trunk, States/Provinces and SIPUA Group
data records from a text file into the specified OW5000 database (also
LDAP can be a source for import). The data fields can be mapped to
existing database fields. The configuration and field mapping settings
can be saved as a profile, so these operations can be easily repeated
manually for later single or repeated occurrences.
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Database Backup

It is recommended that you backup the database in the event that data
is imported incorrectly.

If you want to make a backup, you have to backup both "master" and "OW5000".

As for the "master” database, you should make a backup when you install/upgrade

OWS5000. Frequent backups are not necessary.

IMPORTANT
Backed up data can be reused (restored) only when the same version of the
OWS5000 Platform is used with the same computer name and the same IP address.
IMPORTANT Data before a version upgrade cannot be used when the OW5000 Platform is

upgraded, so backup the data again after the version upgrade.

Use the following steps to backup the OW5000 database.

Step 1

Step 2

Step 3

Log into the server where SQL Server 2005/2008 is in operation using an
account that has Administrator rights.

Click the Start button on the desktop, and then select All Programs >
Accessory > Command Prompt to enter the command below.

In the following example, connection is made to the default instance
name, SQLEXPRESS, of SQL Server 2005/2008 Express Edition.

SQL Server 2005 Express Edition case, move to following folder
C:\Program Files\Microsft SQL Server\MSSQL.1\MSSQL\Binn

SQL Server 2008 Express Edition case, move to following folder
C:\Program Files\Microsft SQL
Server\MSSQL10.SQLEXPRESS\MSSQL\Binn

C:sglcmd -S (local)\SQLEXPRESS
1>BACKUP DATABASE OW5000

2>TO DISK='ow5000.bak’
3>GO

After completing the backup, enter exit to end the SQLCMD command.
1>exit

A backup file (ow5000.bak) is stored in the Backup folder of SQL Server
2005/2008. The backup file is stored in the following folder:

SQL Server 2005 Express Edition case
C:\Program Files\Microsft SQL Server\MSSQL.1\MSSQL\ Backup\

To create an OW5000 database backup in another location, specify the
storage destination as follows:

SQL Server 2008 Express Edition case
C:\Program Files\Microsft SQL Server\MSSQL.1\MSSQL\ Backup\

2> TO DISK='D:\sqlbackup\ow5000.bak’
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To backup the master database, run the following command.

1> BACKUP DATABASE master
2> TO DISK="'master.bak’
3> GO

Database Restore

By restoring a backup file, the OW5000 database can be restored to the
same database condition as when the backup was created.

Backed up data can be reused (restored) only when the same version of the
OWS5000 Platform is used with the same computer name and the same IP address.

IMPORTANT Data before a version upgrade cannot be used when the OW5000 Platform is
upgraded, so backup the data again after the version upgrade.

Use the following steps to restore the OW5000 database:

Step 1 Log into a server where the OW5000 Platform is in operation using an
account that has Administrator rights.

Step 2 Click the Start button on the desktop, and select Control Panel >
Administrative Tool > Services to stop the following services in the
Service window. Use the order listed below.

e OWWatch Dog

e OW OAIMonitor*

e OWAccessServer (only when this is installed. Also, stop
Access Server installed in another server.)

e Remote Call Control (only when this is installed)
e World Wide Web Publishing Service

* Other related services are also stopped.

Step 3 End the Database Import Tool and Database Export Tool when they are
started.

Step 4 Log into the server where the SQL Server 2005/2008 is in operation,
using an account that has Administrator rights.

Step 5 Click the Start button on the desktop, and then select All Programs >
Accessory > Command Prompt to enter the following command.

In the following example, connection is made to the default instance
name, SQLEXPRESS, of SQL Server 2005/2008 Express Edition using
NT Authentication.

SQL Server 2005 Express Edition case, move to following folder
C:\Program Files\Microsft SQL Server\MSSQL.1\MSSQL\Binn

SQL Server 2008 Express Edition case, move to following folder

C:\Program Files\Microsft SQL
Server\lMSSQL10.SQLEXPRESS\MSSQL\Binn
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Step 6

Step 7

Step 8

C:sqlcmd -S (local)\SQLEXPRESS

1>USE master

2>GO

Enter the following command to delete the OW5000 database:
1>DROP DATABASE OW5000

2>GO

After deleting the database, enter the following command to restore the
OWS5000 database.

1>RESTORE DATABASE OW5000
2>FROM DISK="ow5000.bak’
3>GO

After restoring the database, enter the following command to enable
Service Broker:

1> ALTER DATABASE OW5000 SET ENABLE_BROKER
2> GO

Enter exit after the restore is completed.

1> exit

Start the services listed below, in the following order, on a server where
the OW5000 Platform is in operation.

e World Wide Web Publishing Service

e OWWatch Dog

¢ OAI Monitor

e OWAccessServer (when installed on another server)

e Remote Call Control (when installed on another server)
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DBTool
The DBTools application provides OW5000 customers the ability to
import and export data to and from the OW5000 Database. The
application combines functionality from the former DBImport and
DBExport tools into a single application. DBTool has a separate installer and
is able to install into a non-OW5000 platform server.
pa3%) An Import/Export file can be viewed at a remote PC, but the schedule will fail if the
é OW5000 system cannot access the file.
NOTE
P33 Available parameter validation is described in the “Specifications for OW5000
= Admin” on page Appendix C-1.
NOTE
Step 1  After clicking DBTool, the following login dialog box displays
(Figure 6-1).
Figure 6-1 DBTool Login dialog box
il DBTool LogIn H= B3
OW5000 Server/IP Address: || j
User name: I
Password: I
Step 2 Enter the information, as described in Table 6-1.
Table 6-1 DBTool Login fields
Field Description
OW5000 Server/IP Address | The OW5000 server in which to connect.
User name for OW5000.
User Name Note: DBTool privileges is required for the user. Refer to “User
Management Configuration” on page 2-100.
Password The Password for OW5000.
Validates the information and connects and closes the form to open
Connect
another.
P33 PBX configuration from OW5000 Administrator must be completed before starting
%} the DBTool.
NOTE

Step 3 Click Connect. A DBTool Main Screen displays (Figure 6-2).
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Figure 6-2 DBTool Main Screen

il DBTool - Import / Export Data _I_I- jm] 5‘
File Admin Help Log Out

DBTool provides the following feature set:

Import

Imports data from the text file or LDAP. Refer to “Import Data” on
page 6-6 for more information.

Export

Exports data from the OW5000 database to a text file. Refer to
“Export Data” on page 6-33 for more information.

Admin

The user is able to selectively delete Persons (by Role), Contact
Methods, and all other types available for Import/Export. Refer to
“Admin” on page 6-36 for more information.

Help

Indicates the version and database information. See “Help” on
page 6-39.

Import Data

Figure 6-3 shows the data import flow using the DBTool. In OW5000 R5,
the DBTool supports 10 import types. Both the file and LDAP are
available as an import source. Using the Settings configuration, the
DBTool can create default input values based on the definitions.
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Figure 6-3 Data Flow using DBTool

IMPORTANT

Calendar Link

General

Main
[ Screen || Import }
Open
Profile

Extension

Derivation
Rules
URI Generation
Rules

General

Contact Methods
URI Generation
Rules

SIPUA Group
Route/Trunk
States/Provinces

OrLgani%_ation
ocation
General

f Save
l Profile H Complete]

Import Procedure

Use the following procedures to Import data. Note that the Database
Import Tool cannot import all the items that can be set with OW5000
Administrator. Some settings differ depending on the functions to be
used.

Please assign the PBX and Access Server information in order to import the Person
data correctly from DBTool.

Table 6-2 DBTool Import Procedure

Number Import Type Dependency Note
1 Extension None
2 License Extension
3 Location Extension
4 Organization Extension, Location
5 (l_)"rgra;r;(i:zha;ion/ Location Extension, Location
6 SIPUA Group None
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Number Import Type Dependency
Extension, Location
7 Person Organization, and SIPUA
Group
8 Calendar Link Person
9 States/Provinces None
10 Route/Trunk None

Note

Available except for US
market and when UC700/
MC550 is installed.

Creating a New Profile

In OW5000 R5, a profile is not required when a user wants to import the
data using DBTool. However, by using this profile, the user does not
need to configure the mapping every time. DBTool allows the user to
confirm the mapping and save the information as profile data, or cancel
the settings when closing the tool or session.

Opening a Profile

Once the user creates a profile, anyone with DBTool privileges can open
the profile by selecting Open from File > Open > Import

(Figure 6-4).

Figure 6-4 Open Profile dialog box

=l
Profile:  |{sH Import
Table 6-3 Profile fields
Field Description
Profile List of profiles already created for import.

When you select New or load profile from the database, the following

import main screen disp

lays (Figure 6-4).
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Figure 6-5 DBTool Import Screen
_icix
| File Settings Log Out
Details Conrected fo. focalhosiHARMAISOL EXPRESS)
Profile: Import Type : lh
Source :
Contact Methods
[[] Assured Maobility WiFi -
[[] Alpha Pager
Add Photo [[] External Fax
#Authorization [[] External Primary Number
__ DisplayName [ External Tertiary Number
WFirst Name [] External Secondary Number
Ik Access Se..
Ik UR [ Fax
@ LastName [[] Home Email Address
Middle Marme [C] Home Phone Number
Note [C] Mabile Phone
Prefix ’:‘mféghnr Fmail addrece ﬂ
SIP Access 5
SIP URI{Pers..
SIPUA Group E Emp\nyees
Suffix ser
UserDefined 1
UserDefined 2
UserDefined 3
UserDefined 4
UserDsfined 5 EuiEETs
UserDefined 6
[[] Billing Addresses
[[] Home Addresses
[] Shipping Addresses
[[] Work Addresses
PR3 Before importing Person data, set the Office Code(PBX Id) using the PBX
= Management > PBX Settings page and entering the Server Name using the

name information is not required.

Select Import Type

Access Server page. If the SIP Presence feature is not used, the Access Server

Select the target import type from the Import Type drop-down menu.
(All unsaved mapping data will be cleared). Some Import Types, related
to the application, may not display if the application is not installed on

the server.

Select Source Import File

Click Source link on the main page. A Profile Import Source dialog displays

(Figure 6-6).
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Figure 6-6 Profile Import Source dialog

& Profile Import Source =1ox]

Source: @ File () LDAP

—File:

Input File : |

Column Delimiter: |Eomma [
[7] Use Quoted Fields
Mote: If you are logged into DBTool at a machine other than the OWS000 Server

and your intent is to create a Profile to be used by OWS000 Scheduler, the file must
be accessible from the OWS000 Server,

Table 6-4 Create Profile fields

Field Description

Source Select the import source. This can be File or LDAP.

The full path, including the file name, of the file that will be imported.

Input File If you use the Scheduler functionality, you must save the import file.

The following delimiters are available as an import file:

« Comma (,)

* Pipe (1)

* Space

+ Tab

Delimiter is automatically detected once the input file is selected.

Column Delimiter

Select this option if a double quotation mark () is used in the import
Use Quoted Field file. This is checked by default. If your selected file has double
quotation marks, this check box is checked automatically.

When LDAP is selected as the Source, LDAP related configurations are
required, as described in the section below.

LDAP

OW5000 DBTool LDAP Integration synchronizes the OW5000 directory
to an LDAP compliant directory, making it possible for an LDAP
compliant directory to be the source of employee directory data used in
the OW5000 directory. This eliminates the need for employee data
administration of the OW5000 server, as it automatically gets updated
information from the directory server. The LDAP Integration application
can load all data from the LDAP compliant directory, or changes since
the last synchronization if this feature is supported by the LDAP server.

OW5000 DBTool LDAP Integration lets administrators specify an LDAP
source to populate the OW5000 directory of employees and external to
populate the OW5000 directory of employees and external numbers.
Because the structure and elements of an LDAP directory can vary, a
user interface is provided for entering specific queries to retrieve key
data elements from the LDAP server. After the discovery process,
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returned fields can then be mapped to OW5000 fields. If supported by
the LDAP server (only LDAP V.3 is supported), queries can be formulated
to only get records that have been added or modified in a given time
interval since the query was last run.

The LDAP source name, query, and mapping can be saved and
scheduled through web-based OW5000 Administrator to run at
designated recurrent times. There is no limit to the recurrence. The
query can be run as often as once a minute or as little as once a quarter.

Because the LDAP source, query, mapping, and scheduling are stored as
a unit, it is possible to gather OW5000 data from multiple LDAP sources
or queries and schedule these queries independently.

Any LDAP v.3 compliant server will work as an OW5000 DbTool source,
including the following:

— IBM Tivoli Directory Server

— IBM Lotus Notes/Domino

— Microsoft Active Directory

— Microsoft Exchange Server

— Microsoft ADAM

— Novell eDirectory

Configuring LDAP

The LDAP menu is available when LDAP is selected as the source in the
Profile Import Source dialog box (Figure 6-6).

In order to use LDAP, you must register the LDAP license. Please refer to the
= OWS5000 installation Guide for more details. A license is not required for the Asian
and Russian market.
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Figure 6-7 LDAP Configuration dialog box

Profile: LDAP Example

LDAP Server Search Fitter

LDAPServer

|dap¥administrator

Search

Connection unsuccessful. J

To connect with the LDAP source, the following LDAP Server settings are
required.

e [DAP Server

e Base DN

e Other Settings

e Search Filter
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LDAP Server

Use the information below to set the LDAP server information. The
Username and Password is for the LDAP server, not OW5000.

Figure 6-8 LDAP Server dialog box

Table 6-5 LDAP Server fields

Field Description

Host The computer name of the LDAP server.
B The port number that the LDAP server is listening on for
connections. The default is port number 389.
Username/Password The user name and password to connect LDAP server for the query.
Tl Try to connect LDAP server. Connection successful is displayed
on the bottom of the window in green if it is connected.
Base DN

Figure 6-9 Base DN dialog box

Fetch DNs

Table 6-6 Base DN fields

Description

The distinguished name (DN) that identifies the starting point of a
search.

Base distinguished name

Fetch NDs Press the Fetch DNs button to discover possible Base DN’s.
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Other Settings

Figure 6-10 Other Settings dialog box

LDAP Server | Base DN | Other Settings | Search Filter

2009/04/23 |5 15:33:20 G

Table 6-7 Other Settings fields

Field Description

Denotes the date and time the last import occurred. If "Use Last
Import Time in Search" is checked, the Search Filter will
automatically be altered so that only those records changed since
the last import will be returned from the query. This option uses
Microsoft's Active Directory "modify Time Stamp" operational
attribute.

Indicates whether or not an import is currently being performed. Two
simultaneous searches for the same profile cannot occur because
an import will check this setting first before performing the search.
WARNING: Modifying this setting may result in overlapping
searches.

Use Last Import Time in Search

Import Status

Search Filter

Figure 6-11 Search Filter dialog box

LDAP Server | Base DN | Other Settings | Search Filter

(objectclass=*)

Table 6-8 Search Filter fields

Description

Enter a valid LDAP search filter. For example, to search for all users
in Active Directory, enter
"(&(objectcategory=person)(objectclass=user))."

e Directory "modify Time Stamp" operational attribute.

Search Filter
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gsas For more information about forming LDAP search filters, please refer to the article
.é y RFC2254.
NOTE

Search

Step 1  After entering all required configurations, press Search to discover which
attribute lists are available for the specified LDAP server. Next, select the
list of attributes for the desired import. If no attribute strings were
returned by the search, contact your LDAP directory administrator.

Step 2 Provide the necessary information in each section as described below.

Table 6-9 Search fields

Field Description

Available Attributes ﬁnli)sg rct>f fields in the LDAP directory that the user has not selected to

A list of fields in the LDAP directory that will be imported and shown

; in the DBTool GUI. This list will vary depending on the LDAP server
Seleoted Aftributes directory structure. Select the list of attributes appropriate for the
desired import.

Step 3 Click OK to add the new profile.

pa3%) If you cannot find the attribute string, please contact the LDAP Directory
= Administrator.
NOTE

Mapping Import Fields

The Data shown in Figure 6-12, displays an example of field mapping
from an import file to the OW5000 Database.

After selecting fields within the list of Source Field, select fields to be
mapped in the list of Database Fields, right click, and then click the Bind
button to perform the field mapping between the Source Field and the
OW5000 Database. Clicking the Bind All icon on the top left enables
batch mapping of fields whose name corresponds.
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To cancel mapping, select the field from the Database Fields list, right
click, and then click Unbind. Clicking the UnBind All icon, on the top
right, enables batch cancellation of mapping. Existing mappings are

unaffected when Bind All is selected.

Figure 6-12 Example of Import Field Mapping dialog box

2 DBTool - Import / Export Data - [Import Data Into OW5000 Database]

5 FHle settings Admin  Help

Details Connected fo. clusferb(CLUSTERBISOLEXPRESS)

profile:  Import People

Source @ ChPeoplelpeople.trt

Import Type & [person >

Mappings
Source Fields: !3 Database Fields:
E}Employea Confidentiality Status Add Phota

E)Emplnyea Is]
E)Emplnyea Location
E)Emplnyaa Organization
E)Employee Position

Confidentiality StatusiPrimary Exten..

Display Mame
Dterm Paszsword(Primary Extengion)
BEmplUyeE Confidentiality Status

Contact Methods

[7] Mabile Phone ~
7] other Email Address

[0 other Email Pager

[T other Wark Phone Murmb...
[ Personal Homepage

[C] Phone Pager

B Emplovee Type B Emplayes ID [#] Primary Extension
& Extension B Emploves Location [] secondary Extension
Fax B Ernplaves Organization [F] Tertiary Extension
B First Name B Ernplaves Position [] Text Messaging v
B Last Name B Emplayee Type
E)FirstName
I Access Server Roles
b URI
B LastName Employees
Middle Name [F] Guest
Mote [FlUser
Office Code{Primary Extension)
PFilot Murnber
Prefix
. oh Addresses

Priotity(Primary Extension)
SIF Access Server
SIP URI{Persony

[] Billing Addresses
[F] Home Addresses

SIPUA Group [] Shipping Addresses
Special Dial Code [ Work Addresses
Suffix

[T O S

Import Data

Table 6-10 Import Field Mapping

(o] Description

Attempts to bind Source Fields to DataBase Fields by matching

b names.

Removes all the bindings between Source Fields and DataBase

.3 Fields.

o Indicates that the associated field must be mapped.

Starts the importing.

Import Data
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Database Import Tool Functions

The following sections describe the functions of the Database import
tool. The Database import tool can be configured from the Settings page
and other parameters, which might be different depending on the
import type.

Calendar Link

General

To import settings from Calendar Link, select Setting > General. Figure
6-13 displays.

Figure 6-13 Calendar Link Settings
=loix)

—Import Type : Calendar Link

PBX: [sv7000-44 |

Exchange Server: I j

Table 6-11 Calendar Link Settings fields

Description

PBX PBX for the Exchange Server

Exchange Server Exchanger Server for the data

Extensions

General
To import extensions from Calendar Link, select Setting > Extensions.
Figure 6-14 displays.
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Figure 6-14 Calendar Link Extension Settings

PRIk
—Import Type : Extension
Default PBXs
PEX: |Sv7000-44 x| wireless PEX: [sw7o00-44 =l
OK

Table 6-12 Extension Settings fields

Description
PBX If a PBX is not specified when an Extension and person are imported, a
default value, selected here, is used.
Wireless PBX Not used in this version

Extension Derivation

Extension derivation rules can be created, deleted, or applied using the
Extension Derivation Rule.

Step 1 Click Setting > Derivation Rules. An Extension Derivation Rules List
dialog box displays (Figure 6-15).

Figure 6-15 Extension Derivation Rules List dialog box

' ExtensionDerivationRulesList
Applied | Rule Begins With
J @ OfficeExtension 3

Use Last Digits | Prefix PEX

& 30 SW7000-44
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Table 6-13 Extension Derivation fields

Field Description

é’ Edit the rule which is already created.
E Delete the rule which is already created.
Applied Check the rule which should be applied. Top rule is applied as
PP highest priority rule.
A Y Changes the priority of the applied rule.

Step 2 To create new rules, click the Add New button on the rules list page
(Figure 6-15). An Assign or Create Derivation Rules for Extensions
dialog box displays (Figure 6-16).

Figure 6-16 Assign or Create Derivation Rules for Extensions dialog box

' Assign or Create Derivation Rules for Extensions
Applied | Rule Begins With Use Last Digits | Prefix PBX
« | OfficeExtension 3 4 30 SW7000-44
ExternalExtension 2 4 21 SW7000-44

Rule Name: IExternaIExtensiun

Begins With: |2 Use Last Digits: |4
Help
Prefix: v PBX:  |Sw7000-44 [ -]
Help

oK Cancel

Table 6-14 Extension Derivation fields

Field Description

Rule Rule name of this derivation rule.
Begins with The target extension which begins with the value set in this edit box.

The number of available digits to use from the source number,
starting at the end. If the digits of the Extension is smaller than the
"Begins with" field value plus the "Use Last Digits" field value, the
Extension Derivation rule does not match.

Use Last Digits
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Description

Prefix Optional prefix to add to the beginning of the number.

If the Rule matches, the PBX which is selected from this drop-down
PBX is applied. This drop-down list shows the PBXs that were assigned
using OW5000 Administrator.

pA33) The PBX selected in this dialog box is used as the inserted value, not the query
§ parameter. The OfficeCode is selected as a mapping parameter. If the extension
NOTE matches this rule, this PBX is used as the OfficeCode.
gans If the imported Extension does not exist in the OW5000 Database, the DBTool
é decides on the PBX, based on the Extension Derivation Rule.
NOTE

If the imported Extension exists in the OW5000 Database, the current Extension in
the database is deleted and DBTool decides the PBX, based on the Extension
Derivation Rule.

pA33) Extension of URI Derivation means Primary, Secondary, and Tertiary Extension.

URI Derivation

Clicking the URI Derivation button on the Import Settings dialog box
(Figure 6-17) opens a URI Derivation dialog box (Figure 6-16).

Figure 6-17 URI Derivation dialog box

& ExtensionUrisList

Regular Expression Translation Pattern Appliedtel URl | Applied SIP URI
ﬁ W ~([0-9*#1{1,16 1% t0@necam.cam vy

Table 6-15 URI Derivation fields

Description
Add New When you click Add New to create a new rule, the field is cleared to
be able to create a new rule. The value cleared is not saved.
OK Closes the dialog.
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Figure 6-18 Assign or Create URIs for Extension

& Assign or Create URIs for Extension

Appliedtel URl | Applied SIP URI | Regular Bxpression Translation Pattern

i ~([0-9*#]1{1,16 1% t0@necam.com
~[0-9*#]{1,161)% £0@nec.com

Apply:
" Tel URI & SIP URI " Maone

Regular Expression ($0): I"([D—Q*#]{l,lﬁ})$

Translation Pattern: |$D@nec.cum

Table 6-16 URI Derivation fields

Field Description

(tel URIAcF))rng URI) Select which URI applies to this rule.

This determines the first half of the rule, to extract or modify the

Regular Expression ($0) extension

Gives an example of the URI generated after applying the rule. $0

Translation Pattern |20 be included if the telURL and SIPURI have both $0 and @.

Save Saves the rule to the list.
OK Save the rule and close the dialog.
Cancel Close the dialog without saving.

This form is used to create both telURIs and SIPURIs. The data grid
shows all rules, and distinction is made using the column type; either
telURI or SIP URI.

The rules entered through OW5000 Admin are also shown but cannot be
deleted or modified. The delete buttons are disabled when the selection
is on Admin rule.

The rule entered through Admin can only be applied for a Profile in
DBTool.

The Translation Pattern value demonstrates the type of values that will
be generated when the Rule is used. Only one rule may be applied to a
telURI or SIP URI at a time.
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Locations
Selecting Locations displays Figure 6-19.

Figure 6-19 Locations dialog box
' Import Settings !E[E

—Import Type : Locations

Default PBX: [sw7000-44 |

Hierarchy Selector

Choose one of the following hierarchies :

Table 6-17 Location fields

Description
PBX PBX for the location.
Hierarchy Selector Choose one of the predefined hierarchies from the list.
Hierarchies

When OW5000 is installed, a pre-determined set of hierarchies are
installed for Location and Unit (organization) data. Hierarchies are
discovered by querying the OW5000 database. After the user selects
Organization or Location as the IEType, the database will be queried to
find available values for either the Unit or Location hierarchies. The user
needs to map the fields from the file to these types. While importing,
the hierarchy structure is enforced on the data. The record not obeying
the hierarchy is rejected.

An example of a virtual hierarchy type for locations is shown below
(Table 6-18).

Table 6-18 Hierarchy Type For Locations

Building Room Bed Telephone Notes
BL1 A1 BD1 1001 Patient1
BL1 2000
BL1 A2 2001 Break Room
BL1 BD2 2002 Patient 2
BL1 A2 DB3 Patient 3

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



Database Operations 6-23

paad In the example above (Table 6-18), the 2nd to last record will be rejected during
= Import, as it is invalid.
NOTE
Organization

When OW5000 is installed, a pre-determined set of hierarchies are

installed for organization data. Organization has the same hierarchy
mechanism as locations.

gonss Please open the Settings page and click OK at least once; otherwise the Company,
= Division, and Department will not be imported.
NOTE

Figure 6-20 Organization dialog box

& Import Settings

ISIE E3

—Import Type @ Organization

Default PBX: [sv7000-44 =

Hierarchy Selectar

Choose one of the following hierarchies :

Mone j

Choose one of the following location types @

Mone j
oK

Table 6-19 Location fields

Description

PBX PBX for the organization.

Hierarchy Selector Choose one of the predefined hierarchies from the list.

Location Types Select the location type for this organization.
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Organization/Location Hierarchy Settings

The Organization/Location Hierarchy import type provides the import
capability of organization and location simultaneously with hierarchy.

Figure 6-21 Organization/Location Hierarchy Settings

& Import Settings [_ o]

—Import Type @ Organization/fLocation Hierarchy

Default PBX: |5u?uun_44 j

Hierarchy Selector

Choose one of the following hierarchies :

Mone j

Choose one of the following unit types :

None j

OK

Table 6-20 Organization/Location Hierarchy fields

Description
PBX PBX for this hierarchy.
Hierarchy Selector Choose one of the hierarchies from the list.
Unit Types Select the unit type for this hierarchy.
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Person

Figure 6-22 Person Settings dialog box

& Import Settings M= E3

—Import Type : Person

—General Options

Person Access Server: |N0t Assigned j
IM Access Server:  [Not Assigned |
Sync or Update Database: |Update j

—Case Conversion

1 Mixed 1 Upper ) Lower (@ Leave As Is

—Display Mame Generation

Last First, Capital on Last First Names :

|Update non-raodified Display Mames anly j

oK

Table 6-21 Person Settings fields
Group Name Field Description

Person Access | Set the default Person Access Server in the following
Server cases:

+ Person Access Server is mapped but the imported
value is incorrect.

+ Person Access Server is not mapped.

IM Access Server | Set the default IM Access Server in the following cases:

* IM Access Server is mapped but the imported value is
incorrect.

General Options * IM Access Server is not mapped.

Note: IM Access Server is not set when the user does
not have an IM URI.

Sync or Update |Select the desired method of synchronization.
Database + Update: Only adding/modifying the data which is in the
Profile source.

+ Sync Method 1: Every Person that was deleted from
the Profile source is deleted from the database.

+ Sync Method 2: Every Person not in the Profile source
is deleted from the database.
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Group Name

Case Conversion

Display Name
Generation

Field

Description

The case conversion options allow the user to decide if
the records in the database will be in mixed case, only
upper case, only lower case, or left as they are when
imported.

+ Mixed: Imports names with the leading character in
uppercase (capitalized).

+ Upper: Converts the mapped fields to all upper case
characters.

+ Lower: Converts the mapped fields to all lower case
characters.

* Leave As Is.

Note: This feature is applied to First Name, Last Name
and Middle Name.

This option defines how to create the Display Name from
the Display Name Generation dialog box, using the drop-
down menu.
+ Update Display Names in all records
This selection looks at a flag in the database to
determine if the existing Display Name has been
modified. If so, then it is not updated during the import.

+ Update non-modified Display Names only
This results in the regeneration of Display Name based
on the import data regardless of the modified flag.

+ Do not update the Display Names
When this option is selected, the Display Name is not
built from Full Name for any matching employee.

Note: Updates non-modified Display Name only and
does not update the Display Names. Works only
when DBTool can determine the target Person.

Assigning an Organization or Location to a Person

The roles associated with a Person can have an organization and/or
location assigned to them (Employee, Physician, and so forth). To make
an assignment using DBTool, the following two things must be
considered:

¢ The location or organization must already exist in the database. A

Person import will only make an assignment between the role and
organization/location.

¢ A Fully Qualified Name of the Organization and Location must be

specified in the Import File. This is required for DBTool to determine
accurately which organization or location the role will be assigned.

For example, if a Person belongs to an organization department

Admin and is under the division Retail, which is under the company
AAA Corporation, the field should be specified in the input file as
follows:
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AAA Corporation~Retail~Admin.

gonss The delimiter to specify the hierarchy here is ~ (tilde). This is treated as one value or
= a single column.
NOTE

If the fully Qualified name is incorrect or DBTool is unable to find an organization
= following the exact hierarchy in the database, an assignment is not made.

Update and Synchronization

The OW5000 database may be synchronized with customer data
sources. This means that users can choose to have records that were
previously available in a data source to automatically be deleted by
DBTool.

Data synchronization occurs as a part of importing data. The most
significant differences when comparing Update mode to Synchronization
mode is that a unique identifier (Unique Id) is required for
Synchronization mode and data may be deleted in Synchronization
mode. In Update mode, mapping the unique identifier is optional.

Synchronization mode is only available for Person import type.

The following example shows how to specify the Uniqueld from the
Person Import Type.

Figure 6-23 Select Uniqueld

Internet Address (Text Messaging)
Internet Address (Work Email Address)

A£dd Photo
Authorization Code

Internet Address (wWork Email Pager) Dizplay Mame

Iz Tuvn Way(slpha Pager) A First Mame

Last Mame Ik Access Server
I LRI

Pdiddl dpk AR astName

M ahil Set Unigueld L4 OW5000 Defined le Mame

Mate User Defined

NTLR Lagin ID B Prefic

Unique ID Type Description

: Select this definition when the user will use the DBTool exported
OWS3000 Defined data as the import file.

Select this definition when the user will use their own import data as
User Defined the import file and use one of the parameters as Uniqueld, such as
employee ID, login ID.
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Figure 6-24 Update Mode

Jr. Entered by OW5000 Administrator
S

a Imported by DBTool
(Profile name is “Team”)

NOTE: Person A is not there in the Team source

Update
Only adding/modifying the data which in the Profile source

33 a

Person C is removed from Team source
file, after updating......

» @ @
Person Cis still in the OW5000 database
(No delete functionality for Update)

Figure 6-25 Sync Method 1

Sync Method 1

Every Person that was deleted from the Profile source is deleted from database
5 3 3

Person C is removed from Team source
file, after synching .....

e

Person C removed from OW5000 database

Figure 6-26 Sync Method?2

Sync Method 2

Every Person not in the Profile source is deleted from database
5 3 3

Person C is removed from Team source
file, after synching .....

Person A and C removed from OW5000 database
NOTE: If Person A is also in the Team source file, Person A will not be removed

DBTool determines whether or not the person exists in the OW5000
database using the following logic.
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Figure 6-27 OW5000 Database Check

Check if exists

Yes

Unique Id is same?

No or not bound

Yes

Email Address is same?

No or not bound

Yes

Same Login Id?

No

/" FullName + Primary Extension N
or
First Name + Last Name + Primary
Extension
\_ issame? Yy,

Yes

No or not bound

Yes

(Person) SIP URI is same?

No or not bound

New .
[ ] [ Existing Person ]
Person

pa3%) Only the Work Email Address is checked. Home Email Address and Other Email
= Addresses are not checked.
NOTE

Figure 6-28 Person Contact Method Settings dialog box

&l Person Contact Method Settings

— Extension Contact Method Settings :

—Default PEXs

PBX: |5W7000-44 j Wirelass PEX:  |Sw7000-44 j

—Password
Password already encrypted? () ves @ No

OK Cancel
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Table 6-22 Person Contact Method Settings fields

Person Contact Method Setting

PBX

Extension
Contact
Method
Settings

Password already
encrypted?

If a PBX is not specified when a Contact Method and
person are imported, a default value selected here is
used.

*PBX
+ Wireless PBX (Not used in this version)

This setting is applied only when importing extension
contact methods for a Person like Primary or Secondary
Extensions, and when a DTerm password is mapped.
Also this is applied only in the following cases:

* PBX is mapped but imported PBX value is incorrect.
+ PBX is not mapped.

It is used by the user to indicate whether or not the
source password for the Extension is encrypted.

If the setting is selected as "NO", the source password is
not encrypted so DBTool will encrypt the password using
encryption OW5000 algorithm (not SHA-1) before
storing it.

If the setting is selected as "YES", the password is
assumed to have been previously encrypted with
OW5000 algorithm so it is not modified.

Figure 6-29 Person URI List dialog box

' PersonUrisList

DerivationString TranslationPatiem

Applied IMURI | Applied SIP URI

ﬁ T Loginld
ﬁ T Prefix + Primary Extension

$0@necam.com
$0@nec.com

L

Table 6-23 Person URI Derivation Icons/Buttons

Field Description

5? Edit the rule which is already created.

ﬁ Delete the rule which is already created.
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Description

When you click the Add New button to create a new rule, the field

Add New is cleared in order to create a new rule. The value cleared is
not saved.
OK Close the dialog.

Figure 6-30 Person URI Derivation

i Person URI Derivation

DerivationString TranslationPatiem Applied IMURI | Applied &
Loginld £0@necam.com "4
Prefix + Primary Extension $0@nec.com «

Apply:
(@ IM URI () SipURI () None ‘

Key URI Parameter ($0): ILuginId j

Translation Pattern : |$D@necam.cum

Figure 6-31 Person URI Derivation fields

Field Description

Apply IMURI Select applying rule from the created rule.
Apply SIPURI Select applying rule from the created rule.

Provides a list of available Key parameters.

* First character of First Name + Last Name
+ First Name

+ Last Name

* Loginld

* Prefix + Primary Extension

* Primary Extension

Note: Primary Extension and Prefix + Primary Extension keys are
only available and displayed in the US Market.

URI Key Parameter

Gives an example of URI generated after applying rule. $0 and @

U must be included in this field.
Save Saves the rule and adds to data grid.
OK Save the rule and close the dialog.
Cancel Close the dialog without saving.
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If Login ID is selected as the URI Key Parameter in Person URI Derivation, User
roles must be selected for creation in Import Settings so that the Login ID database
field can be mapped to a Login ID column in the Input File. This column MUST
contain unique Login IDs for each person being added or updated. If an input record
specifies a Login ID that is already in use in the OW5000 database, data associated
with the existing Person can be overwritten by the data that's being imported for that
Login ID. Please ensure that if you are attempting to add a new Person to the
database, that the specified Login ID is unique relative to existing Login IDs in the
database and relative to other Login IDs in the DBTool Input File.

Importing Data
After mapping all of the fields, data can now be imported.

Step 1 Click Import Data (Figure 6-12) to start an import operation. Depending
on the selected Import Type and the number of fields mapped, the import
operation may take several minutes for the import operation.

Step 2 Click the Stop button to cancel the import when changing a mapping or
when canceling an import. The main screen of the import displays. When
an import is stopped, data processed up to that point will remain in the
database.

Step 3 When the import is finished, Done is displayed in the Import Progress
dialog. From the bottom of the dialog, the user can know how much data
has been correctly stored in the database.

: Import Progress =] 3

Import
Feading from Import Source and writing to database.

Progress:

6 outofb records saved successfully.

Read: & Processed: & Saved: 6 Zlapsed Time: 00:00:00 .

Step 4 Click Done to return to the import main screen. If an error occurred,
check the import log via OW5000 LogViewer and recheck the import file
format.
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Export Data

Figure 6-32 shows the data export flow using DBTool. In OW5000 R5,
DBTool supports 10 export types, which are the same as import.

Figure 6-32 Data Export using DBTool

Main
Screen H Export ]‘

Calendar Link
Setting
Person
%| Open |> :
Profile
SIPUA Group
g
Setting
Route/Trunk
etting
Setting
States/Provinces
Setting
Organization
Location
: Mandatory Hierarchy
() owten { save
Profile

H Complete ]

If UC700/MC550 is not installed and it is a Japanese market, States/Provinces, User
Privileges and Person Addresses are not displayed.

Open Profile

Once the user creates a profile, anyone with DBTool privileges can select
the profile by selecting Open from Export > Profile > Open.
Figure 6-33 displays.

Step 1
(Figure

6-33).

Figure 6-33 Open Export Profile dialog box
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Profile:

To create or open a profile for export, click Export on the menu bar

_ |0

Cancel

X




6-34 Database Operations

Table 6-24 Profile fields

Description

Profile Name List of profiles already created for export.

Figure 6-34 DBTool Export Screen

{ DBTool - Import / Export Data - [Export Data From DWS000 Database *]
f® File Settings

Detail Connected fo: focalfrosi O USTEABISOLENPRESS)
Praofile: Export Type : [Eom
Cutput File :

CollaborationExtension

E164 Country Code

E164 Murnber

Emergency Mumber xhL
Emergency Mumber XML Version
Extension

ls Monitored

Office Code{PEX Id)

Phone Type

Sip Access Server
SIP URI
Gubline
Tel URI
Tenant

Export Data

Table 6-25 Exported Data fields

(o] Description

Moves the DataBase Field selected to Exported Fields list box,
indicating this field would be exported.

Moves the Exported field selected to DataBase Fields list box,
indicating this Field would not be exported.

Moves the selected field in Exported Fields up in the list box.

@. Indicates the order in which columns would be exported.
Moves the selected field in Exported Fields down in the list box.
@. Indicates the order in which columns would be exported.
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Icon Description

Removes a field from Exported Fields list box and adds it back to the
Q DataBase Fields list box indicating the field would not be exported.

Starts the Exporting.

Table 6-26 Export Settings fields

Icon Description

I Determines whether or not a header (column names) should be
Write File Header added to the beginning of the file.

Output File Output file path and name.

Choose one of the predefined hierarchies from the list.

This parameter displays only when Location, Organization or
Organization/Location Hierarchy is selected as the Export Type.
Select the correct hierarchy based on the configuration.

Hierarchy Selector

Select the location type for this organization.

This parameter is displayed only when Organization is selected as
the Export Type. Select the correct location type based on the
configuration.

Location Types

Select the unit type for this organization/location hierarchy.

This parameter is displayed only when Organization/Location

Unit Types Hierarchy is selected as the Export Type. Select the correct unit type
based on the configuration.

Figure 6-35 Export Complete dialog box
& RunExport =] E3

Export
Feading from 05000 databaze and writing to output file,

Export completed.

Read: 66 Exported: 66 Time Elapsed: 00:00:00

When the export is finished, Export Completed is displayed in the
Export Progress dialog. The amount of data correctly written in the file is
displayed at the bottom of the dialog box.
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Step 2 Click Done to return to the export main screen. If an error occurs, check
the export log via OW5000 LogViewer.
gonas) When you select an existing file name, the file is overwritten by the Exported file.
NOTE
Admin

The Delete Options screen (Figure 6-36) shows the Admin flow using
DBTool. In OW5000 R5, two delete functions are supported.

Figure 6-36 Delete Options

+People
+Contact Methods
+Other Import types

Main
Screen

E Mandatory
(] option

Profile «Profiles
Delete

Bulk Delete

To delete records using bulk delete, a Delete Options dialog box displays
(Figure 6-37). The objects are segregated by category.
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s File  Admin

Options dialog box

DBTool - Import / Export Data - [Admin - Bulk Delete]

Help

Connected fo: focathosCLUSTERBISQLEXFRESS)

Choose from the following to delete:

Database Operations
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logQut _ o X

[T]Peaple

Other Import Types

[[1 Employee
[ user

[C] Extension

[7] Licenses

[C] rRoute/Trunk

[] states/Provinces
[7] s1PUA Group

[7] user Privileges
[7] Locations

[T Oiraznizatinn

ontact Methods

[[] Alpha Pager

[] Assured Mobility WiFi

[7] bual Mode Number

[ External Fax

[[] External Primary Number
[C] External Secondary Number
[[] External Tertiary Number
[ Fax

[] Free Form

= -

|»

Step 1

Parameters displayed in Figure 6-37 are different depending on the market and
conditions.

Select the desired objects and then click Delete. A Delete Confirmation

dialog box displ

ays (Figure 6-38).

Figure 6-38 Delete Confirmation dialog box

Step 2

Step 3

£ DB Tool Message

You are about to delete 1951 Employees, 1951 User. Are you

sure you want to continue?

No

=101

Click Yes to delete or No to cancel the deletion. The process begins. The
process is interruptible, but any deletes that have occurred to that point
will be committed.

Click Done to fi

nish the process.
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Delete Profile

Selecting Delete Profile displays Figure 6-39.

Figure 6-39 DbTool Profiles Deletion dialog box

il Delete Profile

= B3

Select the Profiles to delete:

| [Profile Name

Type
i ExtensionExport Export
- Qrganization Import Import
- Personlmport Impart

Step 1  Click the desired profile to delete and then click Delete. Figure 6-40

displays.

Figure 6-40 Delete Profile Confirmation dialog box

& DB Tool Message

= B3

Are you sure?

No

Step 2 Click Yes. A Confirmation dialog box displays (Figure 6-41).

Figure 6-41 Confirmation Display dialog box

il DB Tool Meszage

=101

o' 2 out of 2 selected Profiles deleted sucessfully.

Step 3 Click Ok to finish.
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Help

Selecting Help from the DBTools Options dialog box (Figure 6-2)
displays basic version information in an About dialog box (Figure 6-42).

Figure 6-42 About dialog box

i Abo ) DETool

Component Version

DETocl 6.6.0.210

Database 0806.27.0

Met Framewaork 2.0.50727.3603
Database Server GALACTICAENSQLEL.
O'wW5000 Server GALACTICABS

Table 6-27 Help fields

Field Description

DBTool OW5000 DBTool software build version
Database OW5000 database version
.NET Framework .NET Framework version used by DBTool
Database Server The SQL Server instance name.
OW5000 Server The name of the OW5000 server.
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Data Mapping Quick Reference Tables

Database Field Reference

Database fields are described for each type.

Table 6-28 Calendar Link

Type SubType Database Field
Email Server

Extension

First Name

Calendar Link Last Name

Loginld

Office Code

Work Email Address

Table 6-29 Extension Type Database Fields

Type SubType Database Field
CollaborationExtension

Country

DID Number

Emergency Number XML (Note)
Emergency Number XML Version (Note)
Extension

Is Monitored

Office Code(PBX Id)

Phone Type

Extension

SIP Access Server
SIP URI

Subline

Tel URI

Tenant

The Emergency Number XML and Emergency Number XML Version are for US
= market only.
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Table 6-30 License Type Database Fields

Type SubType Database Field
API

CSTA

Extension

License GCP

Office Code (PBX Id)
PRESENCE

SOAP

Table 6-31 Locations Type Database Fields

Type SubType Database Field
Office Code(PBX Id)
Number
Notes
. Hierarchies Area
Locations

Hotel Building | Hotel Room

Campus

Hospital | Nurse Station | Room | Bed
Office

Unknown Location

Table 6-32 Organization Type Database Import Fields

Type SubType Database Field
Office Code(PBX Id)

Number

Is External

Notes

. . Company | Division | Department
Hierarchies Hotel

Organization
Locations Types Area

Campus
Hospital

Hotel Building
Office

Unknown
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Table 6-33 Organization/Location Hierarchy

Type SubType Database Field

Organization/Location '
Hierarchy Office Code(PBX Id)

Number

Is External

Notes

Hierarchies Hotel

Company

Area

Area Extension

Area Note

Area Office Code
Campus

Campus Extension
Campus Note
Campus Office Code
Office

Office Extension
Office Note

Office Code

Hospital

Nurse Station

Room

Bed

Hospital Extension
Hospital Note
Hospital Office Code
Nurse Station Extension
Room Extension
Nurse Station Note
Room Note

Nurse Station Office Code
Room Office Code

Bed Extension
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Database Field
Bed Note
Bed Office Code
Table 6-34 Person Type Database Fields
Type SubType Database Field
Person Base Add Photo
Authorization Code
Display Name
First Name

IM Access Server
IM URI

Last Name

Middle Name

Note

Prefix

SIP Access Server
SIP URI(Person)
SIPUA Group
Suffix

Unique Id

User Defined 1
User Defined 2
User Defined 3
User Defined 4
User Defined 5
User Defined 6
Employee Employee Confidentiality Status
Employee ID
Employee Location
Employee Organization
Employee Position
Employee Type
Patient Allow Visitors

Nurse Desk Location
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Type SubType Database Field
Nurse Desk Unit

Patient Account

Patient Admit Date

Patient Birth Date

Patient Confidentiality Status
Patient Discharge Date
Patient Gender

Patient Location

Patient Number

Patient Unit

Physician Confidentiality Status
Physician End Date
Physician Location

Physician Organization
Physician PID

Physician Specialty
Physician Start Date
Student Student Confidentiality Status
Student Number

Student Start Date

Student Suspend Date
Guest Do Not Disturb

Guest Address Line1

Guest Checkln Date

Guest Checkout Date

Guest City

Guest Company

Guest Confidentiality Status
Guest Confidentiality Status Code
Guest Country

Guest CS FileName

Guest Folio

Guest Group Name

Guest Group Number
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Type SubType

User

Contact Methods  |AMW
AMW
AMW
AMW
AMW
AP
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Database Field
Guest Language
Guest Room
Guest State Name
Guest Status
Guest Status Code
Guest Suite Id
Guest Type
Guest Type Code
Guest Unit Name
Guest UserDefined1
Guest UserDefined2
Guest UserDefined3
Guest UserDefined4
Guest UserDefined5
Guest UserDefined6
Guest Zip
ISNRG
IsVIP
Room Extension
Room Office Code
Login ID
NTLM Login ID
Password
Password (Encryption Key)
Password (Hash Value)
UC700 Privilege (NOTE)
MC550 Privilege (NOTE)
User Confidentiality Status
Assured Mobility WiFi
Confidentiality Status (Assured Mobility WiFi)
Dterm Password(Assured Mobility WiFi)
Office Code(Assured Mobility WiFi)
Priority(Assured Mobility WiFi)
Alpha Pager
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Type
Contact Methods (cont'd)| AP
AP
AP
AP
AP
AP
EF
EF
EF
EF
EPN
EPN
EPN
EPN

EXN

EXN
EXN
EXN
ETN
ETN
ETN
ETN
FAX
FAX
FAX
FAX
FAX
HEA
HEA
HEA
HPN
HPN
HPN
HPN

SubType

Database Field
Confidentiality Status(Alpha Pager)
Country(Alpha Pager)
Priority(Alpha Pager)

Is Two Way(Alpha Page)
PIN(Alpha Pager)

Provider(Alpha Page)
Confidentiality Status(External Fax)
Country(External Fax)

External Fax

Priority(External Fax)
Confidentiality Status(External Primary Number)
Country(External Primary Number)
External Primary Number
Priority(External Primary Number)

Confidentiality Status(External Secondary
Number)

Country(External Secondary Number)
External Secondary Number
Priority(External Secondary Number)
Confidentiality Status(External Tertiary Number)
Country(External Tertiary Number)

External Tertiary Number

Priority(External Tertiary Number)
Confidentiality Status(Fax)

Dterm Password(Fax)

Fax

Office Code(Fax)

Priority(Fax)

Confidentiality Status(Home Email Address)
Internet Address(Home Email Address)
Priority(Home Email Address)
Confidentiality Status(Home Phone Number)
Country(Home Phone Number)

Home Phone Number

Priority(Home Phone Number)
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Contact Methods (cont'd)| MP
MP
MP
MP
OEA
OEA
OEA
OEP
OEP
OEP

OWPN

OWPN
OWPN
OWPN
OWPN
PE

PE

PE

PE

PE
PHP
PHP
PHP
PP

PP

PP

PP

SE

SE

SE

SE

SE

TE

TE
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Database Field
Confidentiality Status(Mobile Phone)
Country(Mobile Phone)

Mobile Phone

Priority(Mobile Phone)

Confidentiality Status(Other Email Address)
Internet Address(Other Email Address)
Priority(Other Email Address)
Confidentiality Status(Other Email Pager)
Internet Address(Other Email Pager)
Priority(Other Email Pager)

Confidentiality Status (Other Work Phone
Number)

Dterm Password (Other Work Phone Number)
Office Code(Other Work Phone Number)
Other Work Phone Number

Priority(Other Work Phone Number)
Confidentiality Status(Primary Extension)
Dterm Password(Primary Extension)

Office Code(Primary Extension)

Primary Extension

Priority(Primary Extension)

Confidentiality Status (Personal Homepage)
Internet Address (Personal Homepage)
Priority (Personal Homepage)
Confidentiality Status (Phone Pager)
Country (Phone Pager)

Phone Pager

Priority (Phone Pager)

Confidentiality Status (Secondary Extension)
Dterm Password (Secondary Extension)
Office Code (Secondary Extension)
Priority(Secondary Extension)

Secondary Extension

Confidentiality Status (Tertiary Extension)

Dterm Password (Tertiary Extension)
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Type SubType Database Field

Contact Methods (cont'd)| TE Office Code (Tertiary Extension)
TE Priority(Tertiary Extension)
TE Tertiary Extension
™ Confidentiality Status (Text Messaging)
™ Internet Address (Text Messaging)
™ Priority (Text Messaging)
WEA Confidentiality Status (Work Email Address)
WEA Internet Address (Work Email Address)
WEA Priority (Work Email Address)
WEP Confidentiality Status (Work Email Pager)
WEP Internet Address (Work Email Pager)
WEP Priority (Work Email Pager)
WL Confidentiality Status (Wireless)
WL Office Code (Wireless)
WL Priority (Wireless)
WL Wireless

Addresses Billing Address Billing Street
Billing City
Billing State

Billing CountryOrRegion
Billing Postal Code
Home Addresses Home Street

Home City

Home State

Home CountryOrRegion
Home Postal Code
Shipping Addresses Shipping Street
Shipping City

Shipping State

Shipping CountryOrRegion
Shipping Postal Code
Work Addresses Work Street

Work City

Work State
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Database Field

Addresses (cont'd) Work CountryOrRegion
Work Postal Code

Table 6-35 Description of Contact Method Name

AMW Assured Mobility WiFi
AP Alpha Pager
EF External Fax
EPN External Primary Number
EXN External Secondary Number
ETN External Tertiary Number
FAX FAX
HEA Home Email Address
HPN Home Phone Number
MP Mobile Phone
OEA Other Email Address
OEP Other Email Pager
OWPN Other Work Phone Number
PE Primary Extension
PHP Personal Homepage
PP Phone Pager
SE Secondary Extension
TE Tertiary Extension
™ Text
WEA Work Email Address
WEP Work Email Pager
WL Wireless

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



6-50 Database Operations

Table 6-36 Route/Trunk Type Database Fields

Type SubType Database Field
Beginning Trunk

Emergency Notification Route (NOTE)
Ending Trunk

Office Code(PBX Id)

Route Name

Route/Trunk Route Number

Tenant

User Defined 1

User Defined 2

User Defined 3

User Defined 4

pA3%) Emergency Number Route is for US market only.

NOTE

Table 6-37 SIPUA Group Type Database Fields

Database Field

SIPUA Group Group Name

Table 6-38 States/Provinces

Database Field

States/Provinces Country Name/Description
Name

State/Province Code

ganas) Fields in bold are mandatory parameters.

) —
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OWS5000-MA4000 Integration

OW5000 consists of a base platform (OW5000 platform) and a suite of
applications that utilize this platform. The base platform consists of the
OW5000 database, the OW5000 web administrator tool, and various
system services and web services. The applications include UA5200, On-
Call, Message Center, Procedure Manager, Room Direct, Calendar Link,
and UC700.

The OW5000 platform requires an administrator to enter the PBX,
extension and user information into the OW5000 Administrator web
application to populate the OW5000 database. The MA4000 already has
information that the OW5000 needs. When OW5000 is integrated into
UC Suite as a participating application (PA), this information can be
obtained from MA4000. OW5000 can be notified of changes in order to
keep the data current. The following topics are included in the chapter.

Integration Configuration
Synchronization Entities
Organization

VoiceMail Server

User

Chapter Topics:

The OW5000 database synchronization (DBSync) service for MA4000
Integration is installed with the OW5000 platform. The following entities
and sub-entities in MA4000 will be synchronized into OW5000, as shown
in Table 7-1 and Table 7-2.

Table 7-1 MA4000 to OW5000 Integration

MA4000 Entity OWS5000 Entity

PBX PBX
Extension TelephoneNumber (Extension)
User Person
Organization Unit (Organization)
Voicemail Server VoiceMail Server
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Table 7-2 MA4000 to OW5000 Integration—Sub-Entity

MA4000 Sub-Entity OW5000 Sub-Entity

Line appearance on an Extension Sub-line on an Extension

VoiceMailbox of a User VoiceMail subscriber ID of a Person

ganas) Only one OW5000 server can be integrated to any given MA4000.

The availability of an MA4000 and OW5000 server is critical. If an
OW5000 Server is not running, change notifications from the MA4000

may be missed and a full-sync must be performed again to sync the
OW5000 with the MA4000.

Integration Configuration

To configure the MA4000, select MA4000 Integration as shown in Figure 7-1.

ganas) Before setting up MA4000 Integration, OW5000 Administrator should make sure all
= OW5000 admin logins are also in the NEC CAS (Centralized Authentication
Service). Please ensure that the passwords are the same for a login in both OW5000
NOTE and CAS.

Figure 7-1 OW5000 Options—MA4000 Integration

NEC 556

OVrs000  UAS200
Platform

Applications

Directory

Application Data
Settings

Scheduler

MA4000 Integration

Version Information

An MA4000 Integration Configuration dialog box displays (Figure 7-2).

pD If this is the first time you are logging into the OW5000 Administrator, use the default
—2 login ID admin and the default password admin.
NOTE
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Figure 7-2 MA4000 Integration Configuration dialog box

MAA4000 Integration

Current State: Enabled
Synchronization Status: Current

¥ Enable MA4000 Integration

OW5000

OWED00 Base URL: | pttp-/AMBASSADOR32/0W5000 |

MA4000

* MA4000 Base URL: | http://AMBASSADOR32/MA4000 |

* Login:| admin

*Password: | eseseess

MECCAS URL: http:/fambassador32/NECCAS/

MA4000 SQL SERVER

* Server Name: | AMBASSADOR32
Server Instance:

* Login: | reader

*Password: | essssses
* Database Name:| MA4000

DATABASE SYNCHRONIZATION

* DB Sync Listen Port: 9657

Synchronize Prime Lines in MA4000 as Extensions in OW5000
& In Ascending Order (Primary is lowest number for each Person)
" In Descending Order (Primary is highest number for each Person)
MNote: The ordering can be manually changed for any extension.

W Synchronize Line Appearances in MA4000 as Sublines in OW5000

& Only ringing Line Appearances
" All Line Appearances

ICEN 1124000 Database Mapping

The information below describes the MA4000 Integration Configuration
dialog box (Figure 7-2).

Current State

This will have a value of either Enabled or Disabled depending on the
state of the integration.
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Synchronization Status

Synchronization Status displays the current status of the data
synchronization between MA4000 and OW5000. The status can have the
following three values:

Disabled - the integration is disabled.
In-Progress - the full synchronization is in progress.

Current - the full synchronization is complete and the OW5000
database is current. In this mode, the synchronization is listening to
change notifications from MA4000 and will update the corresponding
data. For example, the change notifications can include User update and
Extension update in OW5000, as they are received.

Enable MA4000 Integration

To enable MA4000 integration with the OW5000, click the Enable
MA4000 Integration check box.

OW5000 Connection

This is the OW5000 URL of the format http://%SERVER_NAME®%/
OW5000. This URL is registered with MA4000 and used by MA4000 for
deep links.

Deep Links in MA4000

A Deep Link is a link in the MA4000 application for a PBX, Extension, or
a User. When selected, the user is taken to the corresponding OW5000
page. In MA4000, the deep link appears as Edit in OW5000.

Figure 7-3 Deep Link in MA4000

Edit User

Edit in OWS000
ARl Fetun to Search

BASIC INFORMATION ASSISTANT INFORMATION

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



OW5000-MA4000 Integration 7-5

MA4000 Connection

Fields in the MA4000 section are described below:

MA4000 Base URL - This is the URL to the MA4000 application. For
example, http://<servername>/MA4000).

Login - A login with Administrator privileges is required.
Password - The password for the above login.

The default value for both the login name and the password is admin.

NOTE
MA4000 SQL Server Connection
The OW5000 needs the MA4000 SQL Server details and a read-only SQL
Server Login. This login is used by the OW5000 database
synchronization service to read the MA4000 database.
The following information describes the MA4000 fields in Figure 7-2.
Server Name - The server name where the MA4000 SQL Server is
located.
Server Instance - The named instance of the SQL Server where the
MA4000 Database is installed. If this is the default instance, the value is
not required.
Login - A login for the SQL Server which has read-only user access to
the MA4000 database.
Password - The password for the SQL Server login.
Database Name - The MA4000 database name.
Database Synchronization
DB Sync Listen Port - This is the port where the OW5000 DBSync is
listening to the change notifications from MA4000. This is an http port
hosted by the DBSync service itself and is not IS dependent.

pa3%) If MA4000 and OW5000 are installed on different servers, the firewall will have to be

é opened on this port for incoming connections in the OW5000 server.

NOTE

Synchronize Prime Lines in MA4000 as Extensions in OW5000 - Prime
line extensions can be imported into OW5000 in ascending or descending
order. In ascending order, the Primary Extension in OW5000 will have the
lowest number for the Person. In descending order, the Primary Extension
will have the highest number. For example, if extensions 2001 and 1001

are assigned to User A in MA4000 and the user is imported as Person A in

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



7-6

OW5000-MA4000 Integration

OW5000, the Primary Extension will be either 1001 if it is ascending order,
or 2001 if it is in the descending order.

The ordering of the extensions for each person can be changed in OW5000 using
the Person page.

Synchronize Line Appearances in MA4000 as Sublines in OW5000 -
The line appearances in MA4000 can be ringing or non-ringing
appearances. Line appearances on an extension in MA4000 are imported
as sub-lines on the extension in OW5000. This allows the option of either
importing only ringing line appearances or all line appearances.

UCE Attendant (UNIVERGE UA5200) and UCE Desktop Client
(UNIVERGE UC700) sublines and subline sync options must be properly
configured in order to avoid their deletion on synchronization with
MA4000.

If the attendant/user sublines are configured to ring in the voice
platform, select the Only ringing Line Appearances option.

If the attendant/user sublines are non-ringing, check the option
Synchronize Line Appearances in MA4000 as Sublines in
OWS5000, and select All Line Appearances.

If it is not advisable to sync non-ringing sublines for the entire system. Uncheck the
Sync with MA4000 check box for the attendant/user extensions, to prevent the
subline from being removed on sync.

Testing the Configuration

The configuration must be tested before it can be saved. After entering
all the appropriate values, click the Test button. This Test runs four
separate tests for verification.

Verify the MA4000 URL - This is done by the system connecting to the
MA4000 web services to retrieve the NECCAS URL. If the MA4000 URL is
not specified or is invalid, this test will fail.

Verify the MA4000 login and password - This is done by connecting
to the MA4000 private web services. This test is executed only if the
MA4000 URL is verified successfully.

Verify the SQL server machine name, instance name, login, and
password - This is done by the system connecting to the SQL server
and querying the SQL server version. There is no connection to the
MA4000. If the SQL connection information is not specified, this test will
fail.

Verify the MA4000 database name - This is done by connecting to
the SQL server and querying a value from the MA4000 database. This
test is only executed if the SQL server information was verified
successfully.
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When the test is complete, the results are shown for each piece of
information. For example, the MA4000 URL may have passed but the
MA4000 login and password failed. In this case, the MA4000 URL will be
shown as valid and the MA4000 login and password will be shown as
invalid.

Clicking Save without performing a successful test displays an error and
the configuration will not be saved.

—A configuration failure displays as a red X icon.
—A correct configuration displays as a green check-mark icon.

OW5000 performs a registration with MA4000 when the test is
successful. The menu structure, deep links, database change
notification URLs, and other integration information is registered with
MA4000. If the registration is successful, the integration information will
be stored in the OW5000 database and the database synchronization
service will be notified of the change.

The synchronization time depends on the number of Users newly defined or modified
= in MA4000 since the last synchronization.

MA4000 Database Mapping

This link is enabled only after the basic configuration settings in the
MA4000 Integration are applied and saved. This link opens another page
and provides options to map MA4000 fields to the OW5000 fields.

Contact Method Email - The email address for the user in MA4000 is
mapped to this email address field in the OW5000 database for the
Person.

Contact Method Extension 1 - The first available extension for the
user in MA4000 is mapped to this field in the OW5000 database for the
Person.

Contact Method Extension 2 - The second or next available extension
for the user in MA4000 is mapped to this field in the OW5000 database
for the Person.

Contact Method Extension 3 - The third or next available extension
for the user in MA4000 is mapped to this field in the OW5000 database
for the Person.

) if the Contact Method Extension 1 is not mapped, the first extension will be mapped
= to Contact Method Extension 2. The 1, 2, and 3 signifies the order of the extensions
being assigned first.

Unit Type Hierarchy - In MA4000, organizations are created as Org
Levels and there is no type associated with them. OW5000 Orgs or Units
are defined as a certain type—for example, Company or Division. The
hierarchy of the Org in OW5000 has to follow a rigid type defined in this

page.
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This allows you to select the unit type hierarchy when Org is imported to
OW5000. If this option is not set, the Org will not be imported from
MA4000. Refer to “Organization” on page 7-13.

UC700 Users

This section of Figure 7-2 allows you to enable the automatic creation of
UC700 users during the import of MA4000 users.

) This option is not available unless UC700 is installed on the OW5000 Server.

The SIP and IM Access Servers should be defined in “Access Server
Configuration” on page 2-48.

The SIP and IM URI parameters and translation patterns are defined in
“Person Management” on page 2-81.

Additional Mapping Fields

This section allows the various User Defined Fields or Custom Fields
(UDF) for a User in MA4000 to a predefined set of OW5000 fields of a
Person. The same MA4000 UDF fields can be mapped to more than one
OW5000 field.

For example, a custom field called DID can be imported to the External
Primary Number of an OW5000 person.

MA4000 supports LDAP integration. This allows certain employee-
related data to be imported into MA4000 as custom fields, which can
then be imported into OW5000 fields using the above mapping. The
data can include Employee Title, Position, Type, Mobile phone number,
or home phone number.

The Override Blank/Null data option allows blank data in MA4000 to be
overwritten in the OW5000 database.

The "...From MA4000" drop-down entries are populated from the User Defined Field
= names in MA4000. If they are empty, refresh the page or navigate to it again.
Sometimes the entries may take a minute or two after the integration is enabled and
applied on the main integration page.

Synchronization

When a configuration is applied or saved in the MA4000 Integration
page or MA4000 Database Mapping page, a full synchronization is
initiated. A full re-sync will happen if it was already synchronized before.
The entities will be synchronized as per the rules and matching
algorithms.

If a full synchronization was completed, at least once before, and when
a full re-synchronization is initiated again, the following will apply:
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1 The link between the MA4000 entity and OW5000 entity is lost until the full
sync is completed again. When the link is lost, any update to the MA4000
entity may or may not update the same OW5000 entity created by the
previous sync. It will follow the matching algorithms again. For Example:
During the first sync User A in MA4000 is created as Person A in OW5000.

During a full re-sync, if you change any field in User A that participates in the
matching algorithm like FirstName or LastName, and when the link is not yet
re-established, then the matching algorithm may not match the User A record
with Person A. Instead, it will match it to Person B, or create a new Person if a
match is not found.

2 All the matching algorithms for PBX, Extension, User, Org, and so forth are
executed again.

For additional fields mapping for custom fields (UDF), the values
imported by the old mapping rules will remain in OW5000.

Synchronization Entities

PBX

The PBX is the most basic entity in both the OW5000 and MA4000
application. All the other entities are either directly or indirectly
dependent on the PBX. The PBX holds specific attributes like IP address
and OfficeCode.

PBX Matching Algorithm

e MA4000 PBX is matched by the IP address with a PBX in the OW5000
database. Multiple MA4000 PBXs with the same IP address are
matched to the same (single) PBX in OW5000.

e If no matching PBX is found using the IP address, it is matched by
PBX name. The PBX Name is unique in OW5000. This OW5000 PBX
should not already be matched to a different MA4000 PBX.

¢ If no match is found, a new OW5000 PBX is created.

Table 7-3 Fields Mapping—PBX

MA4000 Field OW5000 Field
Data Type/Length Comment
Name Name String / 50
Name RMIBindName String / 50 Formed as “OaiServer: +
PBXType PBXType N/A Predefined types in OW5000
HostIP or OaiHostIP |IPAddress String / 15 ﬂzgﬁ PO iiiﬂgzg? i 1l
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MA4000 Field OW5000 Field

Data Type/Length Comment

OfficeCode is unique in

: . . OW5000. The value is set only
PBXOfficeCode  |OfficeCode String / 4 if 2 new PBX is created in
OW5000.
CallForward IsSplitCallForward Bool

Finds the max in OW5000 DB
N/A PBXClientServerPort  |Int and increments it by 1. If none
is found, assign 44000.

Other Import Rules and Algorithms

PBX Type Matching

Regardless of a PBX being created or updated in OW5000, the type of
the PBX is matched to the type in MA4000.

If MA4000 PBX Type = 71 (PBX 2000), Then
Match it to NEAX 2000 IPS in OW5000.
If MA4000 PBX Type = 51 (SV7000 MPS)
Begin
If IsMPS flag is set Then
Match it to SV7000 MPS in OW5000
Else
Begin
If LicensedPirCount = 0 And LicensedVpimCount =0 Then
Match it to NEAX 2400 IPS in OW5000
Elself LicensedPirCount is between 1 and 4
And LicensedVpimCount is between 1 and 16 Then
Match it to SV7000 in OW5000
End
End
If MA4000 PBX Type = 81 (5V8100)
Begin
Match it to SV8100 in OW5000.
End

pa3%) The PBX type is not supported if it is not matched by the above algorithm. The PBX
= will not be imported when the PBX type is not supported.
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OfficeCode Import

The Officecode value is set in OW5000 only when a PBX is being
created. If the PBX is being updated, it will retain the existing value.

Officecode is unique in OW5000 and is set to the PBXOfficeCode in
MA4000. If the value of Officecode is already set for another PBX in
OW5000, a new, unique Officecode is formed and set in OW5000.

A unique Officecode is created by taking the first 4 characters of the PBX
name. If that officecode already exists, a unique 4 digit number starting
from 1234 is assigned.

Extension

The Extension is dependent on a PBX. The same extension humber can
exist on multiple PBXs. Before synchronizing an extension, the DBSync
will synchronize the PBX of the extension. Other attributes of the
extension are also imported—for example, phone equipment type and
line appearances (sub-lines).

Extension Matching Algorithm

e The MA4000 extension is matched to OW5000 by the number and the
PBX it belongs to.

e The Extension number is unique in a PBX.

o If the extension humber for the PBX does not already exist in
OW5000, a new extension is created.

Table 7-4 Fields Mapping—Extensions

MA4000 Field OW5000 Field
Data Type/Length Comment
For PBX Type = 51
Number/NetworkNumber gﬁ:ﬁ%?v?/grrk,l\\llﬁg)é ezf'igo)'
/ Physical Number /  |Number String / 32 dIf ilab]
Station Number used. If not available,
PhysicalNumber(Station

Number) is used.

Tenant Tenant int
Number /
StationNumber gﬁ;\'gﬁg‘lmmggv
StationNumber
Line Appearance Sub-line String / 32
Phone Type Phone Equipment Type |N/A (F;R/e\/%%f(i)%ed typesin

Not visible in OW5000

. Admin; used by the E-
E Data Location| NENA E Dat el
mergency;(MaLa ocation il mergency Data OSN application

(Emergency On-Site
Notification).
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Other Import Rules & Algorithm
Conference Extension Import

If an Extension in MA4000 is a conference extension, it is not imported
to OW5000.

Phone Equipment Type Matching:
If MA4000 Phone Type ID = 1 or 50 or 51 (Analog) Then

OW5000 Phone Equipment type of the extension is Analog.
ElseIf MA4000 Phone Type ID = 38 (SP30) Then

OW5000 Phone Equipment type of the extension
is SP30(SIP).

ElseIf MA4000 Phone Type ID = 43 (SIP-BASIC) Then

OW5000 Phone Equipment type of the extension is SIMPLE.
ElseIf MA4000 Phone Type ID = 14 (DTR-16D) Then

OW5000 Phone Equipment type of the extension is DTerm.
ElseIf MA4000 Phone Type ID is any other Then

OW5000 Phone Equipment type of the extension is DTerm.

Line Appearances (Sub-lines)

The line appearances in MA4000 can be ringing or non-ringing
appearances. Line appearances on an extension in MA4000 are imported
as sub-lines on the extension in OW5000.

Depending on the settings in the MA4000 integration page in OW5000
Admin, either only ringing or all line appearances are imported for an
extension. Refer to “Database Synchronization” on page 7-5 for more
information.

If the extension already exists in OW5000, the sub-lines are exactly
matched with the MA4000. Therefore, depending on the pre-existing
sublines on the extension, sub-lines may be added or removed from the
extension in OW5000.

For each extension on the Extension page in OW5000 Admin, there is an
option called Synchronize Subline from MA4000. If this setting is
turned OFF for an extension, the MA4000 line appearances are not
imported as sub-lines in OW5000 for that extension. Refer to “"Extension
Management” on page 2-17 for more information.

NENA Emergency Location Data

MA4000 captures location information for an Extension for emergency
purposes. The location data is stored as XMLs in the NENA format.
Currently, only NENA versions 2.1 and 3 are supported.

The location XML is stored 'as is’in the OW5000 DB. Certain fields are
parsed out and stored separately as well. The fields ANI, Address
(formed by linking various fields like house number, street, city, state,
zip and so forth), Location Name, and Comments are parsed out from
the XML and stored separately.
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This data is not shown on the OW5000 Admin. It is only available to the
E-OSN application (Emergency On Site Notification). The E-OSN client
displays these details.

Organization

Organization in MA4000 is defined as the Organization-Level. It is a
hierarchical representation of the orgs. The user is assigned to an org in
MA4000 and the corresponding person in OW5000 is assigned after
importing.

In MA4000, organizations are created as Org Levels and there are no
types associated with them. In OW5000, Orgs or Units are defined as
certain types, such as Company, Division and so forth. The hierarchy of
the Org in OW5000 has to follow a rigid type defined in the Unit Type
Hierarchy page.

To import Orgs into OW5000, the Unit Type Hierarchy should be selected
in the MA4000 Integration page in OW5000 Admin. Refer to *“MA4000
Database Mapping” on page 7-7.

The number of levels of the Orgs that are imported from MA4000
depends on the number of levels selected that the type hierarchy
actually supports.

For example, assume MA4000 contains a 5 level org hierarchy as
follows:

NEC
NEC America
CTG
Enterprise Apps
Development

In OW5000, a unit type hierarchy of Company | Division | Department is
selected.

After the sync, OW5000 will only have 3 levels of the Org since the unit
type hierarchy supports only 3 levels. The root Org NEC will be created
as type Company, NEC America will be created as type Division and
CTG will be as type Department. The next two levels Enterprise Apps
and Development will not be imported. A 5 level unit type hierarchy
should be selected in order for them to be imported.

Organization Matching Algorithm

The root Org level is matched by the Org Name to a root level Unit(Org)
in OW5000.

All other orgs are matched to the name and parent org in that particular
level.
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Table 7-5 Fields Mapping—Organization

MA4000 Field OW5000 Field
Data Type/Length Comment
Name UnitName String /100
Description Note String / 1000
Assigned based on the
N/A UnitType N/A Unit Type Hierarchy
selected.
Parents should be the
Parent Parent N/A T

Other Import Rules & Algorithm

Unit Type Hierarchy - If a Unit Type Hierarchy is not selected in the MA4000
Integration page, the Orgs are not imported.

Employee Role - In OW5000, the Orgs are assigned to the Person via
Employee Role.

VoiceMail Server

VoiceMails in UC can be stored in external NEC voicemail server systems
or 3rd party voicemail server systems. Every User is assigned a
VoiceMail box which is associated with a VoiceMail server.

VoiceMail Server Matching Algorithm

The criteria to match an MA4000 voicemail server to OW5000 is the
name of the voicemail server.

If a voicemail server does not exist, a new voicemail server is created in
OW5000. The name is unique in OW5000.

The type of voicemail server is also imported to OW5000. OW5000 only
supports the following VoiceMail server types. All other VoiceMail server
types are stored as "Other" when synchronized from MA4000:

—UNIVERGE UM8500 (Exchange-based)
—UNIVERGE UM8500 (SQL-based)
—NEAXMail AD-64

—NEAXMail AD-120

—UNIVERGE UM4730

—Other
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Table 7-6 Fields Mapping—\VoiceMail

MA4000 Field OWS5000 Field

Data Type/Length Comment

Description

Assigned based on the
voicemail server types.

VMS Type VoiceMailServerType

User

Users in MA4000 are imported as Persons in OW5000. The extensions
assigned to a User in MA4000 are imported as Contact Methods in
OW5000, depending on the mapping defined in the Database Mapping
section in the MA4000 Integration page in OW5000 Admin. Refer to
“"MA4000 Database Mapping” on page 7-7 for more information.

The Custom Fields or UDF defined in MA4000 can also be imported to
OW5000 to one or many of predefined fields in OW5000.

User Matching Algorithm

A MA4000 User is matched to an OW5000 Person by the combination of
FirstName, LastName and the extension assigned in MA4000. If the
extension is not empty in MA4000, then find the person in OW5000 with
same FirstName, LastName and Extension and in unsynchronized state.
Any one extension of the MA4000 user can match to any extension of
the OW5000 person.

If not found, or if there is no extension for the MA4000 user, find a
person with the same FirstName, LastName and no extensions (no
primary, secondary or tertiary) and in unsynchronized state.

If no matching Person is found, or if the Person is already associated
with a different User of MA4000, then a new OW5000 Person is created.

If no matching User is found, or if the matched Person is already
associated with a different User of MA4000, a new OW5000 Person is
created.
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Table 7-7 Fields Mapping—User

MA4000 Field OWS5000 Field
Data Type/Length Comment
FirstName FirstName String / 30
Middlelnit MiddleName String / 30
LastName LastName String / 30
Email ContactMethod Email  |String / 100 His mapped basedon e
. Extensions are assigned
Extension ?gtnary/ Secondary / String / 16 depending on the contact
lary extension method defined.
Organization of the
OrgLevel Employee Role or any
other role

VoiceMail bpx subscriber

id VoiceMailBoxNumber  [String / 16

Values are imported
Custom or User Defined |, ,. . Vs based on the mapping of

Fields VErTBLe REE I DAL Additional Fields in the
Admin.

UC700 User: UserRole
with UC700 security
N/A UserRole authorizations; SIP and
IM URIs are also
assigned.

Extension Assignment Algorithm

Extensions in MA4000 are imported as Primary, Secondary or Tertiary
Extensions in OW5000. The order and mapping is determined by how
the Contact Method for Extensions is mapped in the MA4000 integration
page in OW5000 Admin. Refer to "MA4000 Database Mapping” on

page 7-7 for more information.

If an extension for an MA4000 user is a virtual extension and if it is a
sub-line of another prime-line extension for the same user, it will not be
assigned separately as an extension.

If certain extensions are assigned to an OW5000 person but are not part
of the MA4000 user, they are removed from the OW5000 person.

If an extension is already assigned to the OW5000 person before
synchronizing with MA4000 as one of the Primary, Secondary or Tertiary
extensions, their order of assignment will not be changed irrespective of
the MA4000 database mapping for the contact methods. For example,
Person A has extension 2555 as Primary and 3555 as Secondary
extension in OW5000 and the corresponding User A in MA4000 has
3555 as the first extension and 2555 as the second. In this case, the
extension assignment of Person A in OW5000 is preserved. The order of
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extensions assigned follows the database mapping rules only for newly
imported persons and not for the existing persons in the OW5000.

Other Import Rules & Algorithm

Empty FirstName and LastName not Imported - If an MA4000 user
has both first and last names blank, the user is not synchronized to
OwW5000.

Empty LastName - If an MA4000 user has only the last name blank,
the last name in OW5000 is formed as "x" + extension number.

NEW USER not Imported - If an MA4000 user has the first name as
NEW USER, the synchronized is not imported to OW5000.

Employee Role - If a Person is added to OW5000, by default the
Person in OW5000 is associated with an EmployeeRole.

If the Person exists in OW5000 and has a Role other than Employee Role
associated with it (like Physician Role, Student Role, Patient Role and so
forth), the Employee Role is not assigned to the Person.

MA4000 Publish To Directory Option - MA4000 has a global option

called Show a Publish checkbox for each User in the MA4000 Setup.
If this option is not checked, all users are published and are candidates
for synchronization with OW5000.

If the option is checked, each user in MA4000 has an option called
Publish To Directory. If this option is set as ON, the user is a
candidate to be synchronized to OW5000. If the option is set as OFF, the
user is not synchronized to OW5000.

UC700 Users

A UC700 user can be automatically created if the settings described in
“MA4000 Database Mapping” on page 7-7 are configured. A UC700 user
is created by adding a UserRole for a Person in OW5000 and assigning
the credentials.

Voice Mailbox

OW5000 supports only one Voice Mailbox per person and it should be
unique. It cannot be shared with another person.

In MA4000, if there are multiple users associated to the same mailbox
or multiple mailboxes for the same user, then OW5000 will generate
errors in the Error Log during synchronization. To correct, go to MA4000
and remove the extra User associations for the offending mailboxes.

Custom Fields or User Defined Fields (UDF)

Custom fields defined for a User are imported and assigned to the
OW5000 person, provided they are mapped using the Additional Fields
Mapping section in the MA4000 Integration page in OW5000 Admin.

Custom fields in MA4000 can be mapped to one or many of the following
OW5000 fields (Table 7-8).
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Table 7-8 Fields Mapping—Custom Fields

OW5000 Fields Comments

Employee ID
Employee Position If this field does not exist in OW5000, it is dynamically created.
Employee Type The Employee Types must be predefined in OW5000.
Title Prefix
Title Suffix

External Primary Number
External Secondary Number
External Tertiary Number
Fax
External Fax
Mobile Phone Number
Home Phone Number
Work Email Address
Home Email Address
Other Email Pager
UserDefined1
UserDefined2
UserDefined3
UserDefined4
UserDefined5
UserDefined6

- This is assigned to the UserRole only if the UC700 user auto
NTLM Login ID creation is enabled.

Work Address
Work City
Work State State should be predefined using OW5000 Administrator.
Work Zip
Work Country Country should be predefined using OW5000 Administrator.
Home Address
Home City

Home State State should be predefined using OW5000 Administrator.
Home Zip

Home Country Country should be predefined using OW5000 Administrator.
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OW5000 Fields Comments

Billing Address
Billing City
Billing State
Billing Zip
Billing Country
Shipping Address
Shipping City
Shipping State
Shipping Zip
Shipping Country

State should be predefined using OW5000 Administrator.

Country should be predefined using OW5000 Administrator.

State should be predefined using OW5000 Administrator.

Country should be predefined using OW5000 Administrator.
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Acronmys and Descriptions

3rd Party SIMPLE
Terminal

Access Server

BLL

DAL

ML-SIP Terminal

The terminal which communicates with Access Server via Standard SIP/
SIMPLE Interface.

The SIP Terminals communicate with this server.

Business Logic Layer - A code repository where common functionality is
added to reduce duplication by increasing re-use.

Data Access Layer - A set of code-generated DLLes that provide simple
physical database access and manipulation.

The terminal which communicates with SV7000 via Extended SIP Multi
Line Interface. Means DtermSP30 (SIP).

OW5000 Administrator

Presence Server

STD-SIP Terminal

UNIVERGE SIP

Terminal

WL-SIP Terminal

Refers to an individual who has access privileges to system
configuration features in OW5000.

Total system of the presence server which consists of single or multiple
Access Servers and single DB Server (OW5000 Platform).

The terminal which communicates with SV7000 via Standard SIP
Interface.

Indicates both WL-SIP terminal, ML-SIP terminal, and STD-SIP terminal.

The terminal which communicates with SV7000 via Extended SIP Single
Line Interface. Include MH250, FOMA N900iL and FOMA N902iL.

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



Appendix A - 2 Acronmys and Descriptions

UCE Application Platform (UNIVERGE OW5000) Configuration Guide



Appendix B - 1

Regular Expressions

The normalization rules are created using regular expressions. Table
Appendix B-1 lists representative regular expressions.

Table Appendix B-1 Regular Expressions

Regular Expression Meaning

A The line head is matched.

$ The line end is matched.

0 Means to group, record, and call the content in the parentheses
later.

I One character in the brackets is matched. A range can be specified
using a hyphen.

Any one character is matched.
One character string or another is matched.

The immediately preceding expression appears zero or more times.

+ The immediately preceding expression appears one or more times.
? The immediately preceding expression appears zero or one time.
{m} The immediately preceding expression appears m times.
{m,} The immediately preceding expression appears m times or more.
imn} ;Ifhe immediately preceding expression appears m times or more, n
imes or less.
\d Digits 0 to 9 are matched. Same as [0-9].
\s A space character is matched.

When a special character used in regular expressions, ~, $, [, 1, *,
+,7?, |, (, or)is to be treated as a normal character, each one
needs to be preceded by \ as follows: \., \*, \$, \[, \], \*, \+,\?,\|, \(,
or\). When a special character is treated as a normal character
within [ ], \ need not be appended (except for\, ~, and ]). When - is
used as a normal character within [ ], it is represented as \-.

A character string grouped by () can be referenced by $n. $n means
that the nth group from the line head is to be referenced. $0 means
that the whole line is to be referenced.

Table Appendix B-2 and Table Appendix B-3 show examples of
normalization rules, which are only for reference and need not be
followed to create the normalization rules for your system.
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Regular Expressions

Regular Expression

"0([0-9K10h)%

*0([0-9K9)$

A0(\d\d)-(\d\dd\d)-(\d\d\c\d)$

MO0\
J\d\d\d\d)$

N+(\d)-(\d\d\d)-(\ddd)-(\ce\d\d)$

A0(\d)-(\d\d\d\d)-
(did\d\d)\sX(\d\d\d\d)$

Table Appendix B-2 Normalization Rules (Global Numbers)

Conversion

+81$1

+81%1

+81$1$283

+81$1$283

+$1$28394

+81$1$283;ext=54

Examples

09012345678
->+819012345678

0312345678
-> +81312345678

090-1234-5678
->+819012345678

03-1234-5678
-> +81312345678
(03)1234-5678
-> +81312345678
03(1234)5678
-> +81312345678

+1-212-345-6789
-> +12123456789

03-1234-5678 X2000
-> +81312345678;ext=2000

Regular Expression
N[0-9"#){41)$

"2([0-9"#1{4})$

"8([0-9"#K7}$

A8-(\d\d)-([0-9*#]{5})$

"$

Table Appendix B-3 Normalization Rules (Local Numbers)

Conversion

$1;phone-context=nec.com

2$1;phone-context=nec.com

$0:phone-context=nec.com

8$1%$2;phone-context=nec.com

notknown;phone-context=nec.com

Examples

2000
-> 2000;phone-context=nec.com

20000
->20000;phone-context=nec.com

81070000

->81070000;phone-
context=nec.com

8-10-70000

->81070000;phone-
context=nec.com

No caller number (anonymous)
-> notknown;phone-
context=nec.com

A$indicates a blank line. When the caller number cannot be acquired at
termination, the regular expression for a blank line is matched. When
the conversion result is tel:notknown;phone-context=~, "unknown" is

displayed on the MOC.
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Appendix C OW5000 Configuration Speci

Available Char Sales Regions
< g g z > >
Input Is B z z £ = o 5
Group Application Tab Name Button Name Parameter 2 < =z Default Value = ) 3 Remark
Method Mandatory =y s > 3 =
=3 2he 3 =2 B
< 2 2 2 3 S
S 5 =2 >
3
"ASCII onl
SIPUA Group |Add New Group Group Name input M A - X X X X Casersenshive”
Deny as Default Check ] Sl -l -l -] -] - - - Off X X X X
Access Control Show Allow List Select M S I I I e - - X X X X
Group Access Control -~ —
Show Deny List Select M Sl -l -l -] -] - - - X X X X
PBX based Control " Show Allow L.ist Select M S I I I e - - X X X X
Show Deny List Select M Sl -l -l -] -] - - - X X X X
- PBX Select M e - - - X X* X* X* UC700/MC550
Bridge Name Input M X[ x| x| x|-]- 25 - X X* X* X* UC700/MC550 [ASCII only
Tenant Input M X[{-1-1-1-1- 2 1-63 X X* X* X* UC700/MC550
Ports Input M X[-1X-|-1- 16 - X X* X* X* UC700/MC550 &Z;(‘:{u&izfr;?r;cns is 32
Is Host Controlled Check o o I I e I - - Off X Z Z Z UC700/MC550
Input M X| - X|-]-]- 16 - X X X X 0-9, #, *, 16 chars
PBX Select M - - - - - - - Top of the list X X X X
Phone Type Select M - - - - - - - Dterm X X X X
Tenant Select M S I I A A 2 1-63 1 X X X X
Country Select M - - - - - - - JP X X X X
DID Number Input ) x| x| x| x]-]- 50 - X X X X oo
|Add New Extension telURI Input o x [ xx [ x]-] -] 128 - X X X X B
SIPURI Input (] X|X|X|X]| -] - 50 - X X X X “only one " must be required Case-sensitive"
SIP Access Server Select ] Sl -l -l -] -] - - - NotAssigned X X X X
Collaboration Check o S I I A e - - off X X X X
(Ce Select ] -l - -] -] - - - X X X X
Extensions - Is Monitored Check o S I I A e - - On X X X X
Subline input ° sl I Il I I i ) X X X X &:j:u;tzrcgfa;?blmes is 3
PBX Select M Sl -l -l -] -] - - - Top of the list X X X X
Tenant Select M S I I I e 2 1-63 1 X X X X
Range Delete —
Starting Extension Input M x| -Ix[-1-71- 16 - X X X X
Ending Extension Input M X[ -] x| -|-]- 16 - X X X X
Fx(enswon pattern regular expression(for telURI) Input o x| x| x| x|-]- 100 ~ A[0-9%1(1,16)$ X X X X Default value should be_ ([0-9,#,*]{1-16})$ same as the validation rule ¢
Extension page Extension edit bo:
Platiorm UR! Format |Iranslanun pattern regular expression(for telURI) Input o x| x| x| x|-]- 100 ~ X X X X Fon-edl!ab\e
Extension pattern regular expression(for SIPURI) Input o x| x| x| x|-]- 100 ~ A[0-9%1(1,16)$ X X X X EeVaull value should be_ N[0-9,#,*I{1-16})$ same as the validation rule ¢
Extension page Extension edit bo:
Translation pattern regular expression(for SIPURI) Input o X|X[X|X]-|- 100 - X X X X Non-editable
Enable PBXs - Enabled Check o S I I I e - - off X X X X
PBX Select M Sl -l -l -] -] - - - Top of the list X X X X
Check All Check o S I I I e - - off X X X X
SOAP Check o e - - Off - X - -
Licenses Enable Extensions - CSTA Check o S I I e A - - off - X - -
GCP Check o T-T-1-1T-1- - - Off - X - -
PRESENCE Check o T-T-1-1T-1- - - Off X X X X
API Check o T-T-1-1T-1- - - Off X - X X
Licensed -- -- - X - X Display license information (non-editable)
Name Input M X - - - US Market Only
TAP Dialup(1-Way) Input ] X - - - US Market Only
Pager Providers Add New Pager Provider TAP Dialup(2-Way) input o X ~ ~ ~ US Market Only
SNPP Host Name Input o X - - - US Market Only
Port (Number) Input ] X - - - US Market Only
MAX Length Input M X - - - US Market Only
PBX Name Input M x| x x| x]-]- 40 - X X X X a-z, A-Z, 0-9, - (dash), -(period)
[P Address Input M xl-]-1+«1-1]- R X X X X 'E’O»:‘nlﬁ::?ls:;szggslseare not checked)
Office Code(PBX Id) Input M XXX X]-|- 4 - X X X X [ASCII only
Client/Server Port Select M - - - - - - - Top of the list X X X X
PBX Type Select M - - -] - - - - Top of the list X X X X
Special Dial Code Select o S I I I I - - None X - - - US Market Only
Split Call Forward Check o o I I e - - Off X X X X
PBXs PBX Settings. [Add New PBX Locations Select o -1 - - Top of the list X X X X
Pbx Reconnect Delay Select o -0 1 - - Top of the list X X X X
Heartbeat Timeout Select (] Sl - - - - - - - Top of the list X X X X
UGN (User Group Number) Check (] Sl - - - - - - - Off X X X X
Prefix Input o x| - x|-]-]- 16 - X X X X 0-9, #, *, 16 chars
SIP Server IP Address Input o x| -|-1+]-]- ~ X X X X P Addre_ss(Ranges are not checked)
[*:Only " is available
SIP Server IP Address (port) Input o X1 -{-1-1-1- - - 5060 X X X X 1-65535
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Group

Application

Tab Name

ation (Cont'd)

Button Name

Parameter

Input
Method

Is
Mandatory

Available Char

Alphabet
2byte KANA

1byte KANA

Default Value

BOLIBWY YLION

Sales Regions

(1ay10) BISY

uoneaddy

Remark

Location Name Input M x| x|x|x]|-|-] s0 - X X X X "ASCilonly
Case-sensitive
Country Code Input M X[ - XxX|-|-1- 10 - X X X X
City/Area Code Input ] X[ - xX|-|-1- 24 - X X X X
Locations Add New Location Long Dist Access Code Input 0 X| - [ x| -|-|-| 24 B X X X X
Local Access Code Input ] X[ - XxX|-|-1- 24 - X X X X
Int. Direct Dial Code Input o X{-1X{-1-1- 24 - X X X X
National Code Input ] X[ - xX|-|-1- 24 - X X X X
- Locations Select M -l -l - - -] - - - Top of the list X X X X
 Target City/Area Code Input M X[ - xX|-|-1- 24 - X X X X
AreaCode Rules |Add New AreaCode Rule Target Exchange Input ] X1 - (X -1-1- 24 - X X X X
PBXs Direct Dial Code Input o X1 - X -1-1- 24 - X X X X
(cont) Include City/Area Code Check [ - - -] -] - - - X X X X
Destination PBX Select M -l -l - - - - - - Top of the list X X X X
[Add New Destineation PBX Dialing Prefix Input ] X|-|X|-]-]- 50 - X X X X
PBX->PBX Dialing beginning with Input o X1 - (X -1-1- 16 - X X X X
|Add New Source PBX Source PBX Select M -l -l - - - - - - Top of the list X X X X
Incoming Prefix Input ] X|-|X|-]-]- 50 - X X X X
Number Input M X[{-1-1-1-1- 16 - X X X X 0-9, #, *, 16 chars
Reserved Numbers Add New Monitored Number Tenant Input M X{og-1-1-1- 2 163 X X X X
Reserved Type Select M -l -l - - -] - - - Monitored Number X X X X
Application Select ] -l - - - -] - - - Un-assigned X X X X
Platform Voice Mail Pilot Numbers ~ |Add New Pilot Number Pilot Number Input o x| -[x]-[-7- 16 - X z z z UC700/MC550
(contd) Route Number input M X[ [ [-[-[-[ 3 1-899 X - - - US Market Only
Name Input M XXX X] -]~ 30 - X - - - US Market Only
Beginning Trunk Input M X|-1-1-1-1- 3 1-255 X - - - US Market Only
[Ending Trunk Input M X -1-1-1-1- 3 1-255 X . . . US Market Only
|PB>( Select M -l - - - -] - - Top of the list X - - - US Market Only
Route/Trunks " |Add New Trunk [ Tenant Number Input M 1-63 X US Market Only
Is EOSN Check ] -l -l - - -] - - - Off X - - - Displays only when EOSN is installed and user login has EOSN Admin role
UserDefined 1 Input o X[ X X[ X[X]X 50 - X - - - US Market Only
UserDefined 2 Input o X[ X X[ X[X]X 50 - X - - - US Market Only
UserDefined 3 Input o X[ X X[ X[X]X 50 - X - - - US Market Only
UserDefined 4 Input o X[ X X[ X[X]X 50 - X - - - US Market Only
Serial Port Select M o R e N - 1 X - - - US Market Only
Baud Rate Select M o R e N - 300 X - - - US Market Only
. . DataBits ID Select M - - -] - 7 X B B - US Market Only
Serial Ports - Add New Serial Port Py Soea i o e - - = . . . TS Marke only
Stop Bits. Select o -l - - - - - None X - - - US Market Only
Flow Control Select M -l -]l -] -] -] - - HardWare X - - - US Market Only
Name Input M X Z Z Z UC700/MC550
Voice Mail Servers - |Add New Voice Mail Server Type Select o e e = = X z z z UCT00MES50
System ID Imput ] X Z Z Z UC700/MC550
Base URL Imput ] X z z z UC700/MC550
Server Name Input M X[ X[ x|[x|-]- 40 - X X X X a-z, A-Z, 0-9, - (dash), .(period)
IP Address
.(period)?>
1P Address Input M Lo e T I I - X X X X Ig)Addrlss(Ranges are not checked)
*:Only " is available
Listen Port Input M X{-1-1-1-1- 5 - 6060 X X X X 1025-65535
Legacy Port - - X{-1-1-1-1- 5 - 62000 X X X X 1025-65535
General Settings Add New Access Server RPC Listen Port Input IfAS, M X[ -[-[-[-]- 5 N 60002 X X X X 1025-65535
00-FF
T0S Input 1fAS, M Lo T I I 2 - 00 X X X X *: From 'A' to 'F' are available
Access Server Keep Alive Input IfAS, M X - -|-]-]|- B B 1800 X X X X 180-72000
Timer T1 Input If AS, M X[{-1-[-1-]- - - 500 X X X X 500-4000
Is PSGW Check o -l -l - -] - - - - Off X X X X
Binding Type Select If PSGW, M -l -l - -] - - - - TCP/IP X X X X
|Routing Rule Input 0 X | X | X | x| -] -] 100 X X X X
1P Address 0.0.00- 1P Address(Ranges are not checked)
Add New Routing Rule input ° I 255.255.255.255 X X X X *:Only " is available
Applications Routing Info Port Input o x| -] -1-]-]- 5 1024-65535 X X X X
Translation Pattern Input o XX X[X]-]- 100 X X X X
Test Routing Rule Test Routing Rule Input e} X x| x|x|-|- 100 X X X X
Applications Message Service |- - [ TCP Service Poirt Input M X[--1-1-1- 5 1024-65535 5425 X X X X
ICA Name Input o X X* X X* UC700/MC550/UA5200
Legacy TCP/IP Port Input M X{-1-1-1-1- - 1025-65535 5424 X X* X* X* UC700/MC550/UA5200
Name Display Enabled in PBX Check o o R e N - - On X X* X X* UC700/MC550/UA5200
Show External Number Check o o R e N - - Off X X* X* X* UC700/MC550/UA5200
Show DID Information Check o o R e N - - Off X X* X* X* UC700/MC550/UA5200
Server Settings - Password Required Check o o R e N - - Off X X* X* X* UC700/MC550/UA5200
Incoming Call Assistant Chime on Incoming Call to Subline Check o o R e - - Off X X* X* X* UC700/MC550/UA5200
Outbound Call Log Size Input o X1 -{-1-1-1- 9 - 100 X X X X* UC700/MC550/UA5200
Inbound Call Log Size Input o X1 -{-1-1-1- 9 - 100 X X* X* X* UC700/MC550/UA5200
Max Idle Time (seconds) Input o X1 -{-1-1-1- 5 - 15 X X* X* X* UC700/MC550/UA5200
Name Display Format for Employee Match Select ] -l -l - - -] - - - Employee Display Name X X* X* X* UC700/MC550/UA5200
Redirect Configurations Add New Redirect C PBX_ Select o S T S E S - - X X X X UCT00/MCE50/UAS200
Redirect Number Select o o I e N - - X X* X* X* UC700/MC550/UA5200




Available Char Sales Regions

Input Is

Method Mandatory Remark

Default Value

Application Tab Name Button Name EEEC

2byte KANA
1byte KANA

Alphabet
Special Chars
©OLIBWY YLION
adoing'eiensny

PBX Select M o I I I I - - Top of the list X X* X* X* UC700/MC550/UA5200
Force Port Select M o I I I I - - Yes X X* X* X* UC700/MC550/UA5200
Heartbeat Select M o I I I I - - Yes X X* X* X* UC700/MC550/UA5200
Selected Check o o I I I I - - X X* X* X* UC700/MC550/UA5200
Incoming Call Assistant (Cont'd) |[PBX Settings - Incremental Retry Delay Select M -l -] -] - - - 30 seconds X X* X* X* UC700/MC550/UA5200
OAI Timeout Select M S I A I A - - 10 minutes X X* X* X* UC700/MC550/UA5200
Max Retry Delay Select M X|-1-1-1-]- - 1-65535 5 seconds X X* X* X* UC700/MC550/UA5200
Data Mode Select M o I I I I - - X X* X* X* UC700/MC550/UA5200
LED Number Select M o I I I - - X X* X* X* UC700/MC550/UA5200
LS| Name Input o XXX X]|X[X 40 X X* X* X* UC700/MC550/UA5200
Legacy TCP/IP Port Input M X1 -{-1-1-1- - 1025-65535 5421 X X* X* X* UC700/MC550/UA5200
Server Settings - Display Status Check o o I I e - - On X X* X* X* UC700/MC550/UA5200
Password Required Check (] Sl - - - - - - - Off X X* X* X* UC700/MC550/UA5200
Max Idle Time Input o X1 -{-1-1-1- - 0-999 15 X X* X* X* UC700/MC550/UA5200
Default Online Select M S I I I A - - Online X X* X* X* UC700/MC550/UA5200
Default Offline Select M o I I e N - - Offline X X* X* X* UC700/MC550/UA5200
Default Idle Select M - - - - - - - Away from Desk X X* X* X* UC700/MC550/UA5200
- Default Busy Select M - - - - - - - In a Meeting X X* X* X* UC700/MC550/UA5200
Message Setting Default Out of Office Select M B I I I - - Out of Office X X* X* X* UC700/MC550/UA5200
Default Dterm Select M S I I I A - - Available X X* X* X* UC700/MC550/UA5200
Location Status Information Default Mobility Select M Sl -l -l -] -] - - - Available X X* X* X* UC700/MC550/UA5200
System Presence Input (] X|X| X| X]|X]|X 50 - X X* X* X* UC700/MC550/UA5200
Add New Meesage
SIP Presence Select o o I I e - - NONE X X* X* X* UC700/MC550/UA5200
PBX Select M o I I I N - - Top of the list X X* X* X* UC700/MC550/UA5200
Force Port Select M o I I I N - - Yes X X* X* X* UC700/MC550/UA5200
Heartbeat Select M o I I I N - - Yes X X* X* X* UC700/MC550/UA5200
Selected Check o o I I I N - - X X* X* X* UC700/MC550/UA5200
PBX Settings - Incremental Retry Delay Select M o I I e N - - 30 seconds X X* X* X* UC700/MC550/UA5200
OAI Timeout Select M S I I I A - - 10 minutes X X* X* X* UC700/MC550/UA5200
Max Retry Delay Select M X -1-1-1-]- - 1-65535 5 seconds X X* X* X* UC700/MC550/UA5200
Data Mode Select M o I I I N - - X X* X* X* UC700/MC550/UA5200
LED Number Select M o I I I N - - X X* X* X* UC700/MC550/UA5200
PBX Select M - - - - - - - Top of the list z - z z MC550
Selected Check o S I I I I - - On z - z z MC550
Data Mode Select o S B B A A - - 4 - Z Z MC550
Applications (Contd) LED Number Select o S B B A A - - 4 - Z Z MC550
Database Refresh Time (min) Input (] X -1-1-1-]- - 5 z - z z MC550
[VMMA Short Timer Input ] X -1-1-1-]- - z - z z MC550
[VMMA Long Timer Input ] X -1-1-1-]- - z - z z MC550
PBX Settings - SMFN Version Input o X1 -{-1-1-1- - 2 Z - Z Z MC550
Special Outbound Dial Prefix Input ] X| - | X|-]-]- 16 - M[0-9*#]{1,16})$ z - z z MC550
MC550 Server Default Outbound Caller ID Input 9] x| - x[-]-]- 16 ~([0-9*#1{1,16])$ z - z z MC550
Send Caller ID for Outbound Dial Check o S B B A A - - Z - Z Z MC550
Calling Name Override from Database Check (] - - - - - - - z - z z MC550
Telephony Status Change Success Announcement Input ] X -1-1-1-]- - 1-58 2?2 z - z z MC550
 Telephony Status Change Failure Announcement Input (] X|-1-1-1-]- - 1-58 2?2 z - z z MC550
RESERVED LINE SETTINGS Select o o I I I - - Z - Z Z MC550
Connect to Call if answered after Select o S I B A I - - 0 Z - 4 4 MC550
Connect to Call if answered before Select o S I I A - - 0 4 - 4 Z MC550
User Settings - Caller id to be Displayed for Click to Call Input 0 x| - x[-]-]- 16 - ~([0-9*#{1,16))$ z - z z MC550
SMS Voice Mail Check o S I I I A - - 4 - 4 4 MC550
RESERVED LINE STATUS OVERRIDES Select o o I I e N - - Z - Z Z MC550
Server Settings -- OAI Tenant Number Input M X|-1-1-1-]- 2 0-63 0 X X X X
PBX Select M - - - |- - |- - - Top of the list X X X X
Force Port Select M S I B A e - - Yes X X X X
OaiServer Heartbeat Select M S I B A e - - Yes X X X X
PBX Settings - Selected Check o o I I e N - - On X X X X
Incremental Retry Delay Select M - - - - - |- - - 30 seconds X X X X
Max Retry Delay Select M - - - - - |- - - 10 minutes X X X X
Enable Free Locatoin Facility Check (] - - - -] - - - X X X X Use tenant 1
General Settings -- Listen Port Input (] X|-1-1-1-]- - 1-65535 0 X X X X RCC runs on 5060
Country Code Select (] X|-|X|-]-]- 3 - X X X X
Add New Phone pattern regular expression Input (] X|-|X|-]-]- 100 - X X X X
Translation pattern Input (] X|-|X|-]-]- 100 - X X X X
Comment Input (] X|X|X|X]| -] - 100 - X X X X
Remote Call Control Normalization Rule Test dialed number Input o X|X|Xx|x|-|-| 16 - X X X X ?S,xﬁ ::E:Vailable
Translated number(for test number) Input (] - -] -] - - X X X X Not editable
Test Rule Test ANI Input o x| x| x|x|-]-] 1 - X X X X ﬁ@@ﬁfﬁv ailable.
Destination PBX Select o - - - X X X X
Translated number(for test ANI translation) Input o - -] - - - - X X X X Not editable
ACD Break Modes - (click pencil) Enter the description for break mode X Input o x[{x|x|[x|-]- 32 - z z z z UC700/UA5200
(click pencil) Category Name Input (o] X|X|X|X]| -] - 32 - T T T T
Mode Name Input M x| x| x| x|-]- 50 - T - - - for UC Agent Only
. ACD Split Modes - § Description Input M X | x| x|[x|-]|- 50 - T - - - for UC Agent Only
Directory Add New Split Mode
ACD Name Select M B N I I e - T - - - for UC Agent Only
ACD Pilot Number Input o x| -{x|-1-]- 50 - T for UC Agent Only
Enter the description for work mode X Input o x[{x|x|[x|-]- 32 - z z z z UC700/UA5200
[ACD Work Modes - (click pencil)
Is VIP Wake-up Processing work mode Check (o] R B N B B - - z z z z UC700/UA5200
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Available Char
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= z = L
Application Tab Name Button Name Parameter Input IS 2 [} <Z( <Z( Default Value E s g' ;‘: Remark
Method Mandatory % s i‘) i‘) > 5 :ﬁ Q
& 3 E =
Categories A Add New Category Name Input M X[ x| x|x|x]|x 50 X - - - US Market Only
Category Description Input M X[ x| x| X|X[Xx 100 X - - - US Market Only
Name Input M x[x[x[x]x[x] so X - - - US Market Only
DIDs - Add New DID pBX Select M -l - -] -] - X - - - US Market Only
Extension Select M - - - - X - - - US Market Only
Company Select M - - -] - - X - - - US Market Only
Name Select M X[ x]x X[ X 50 X X* X* X* UC700/MC550/UA5200
Type Select o -l - -] - - - Not Set X X* X* X* UC700/MC550/UA5200
Locations - Add New Notes Input (e} X|X|X|X]|X]|X 1000 X X* X* X* UC700/MC550/UA5200
PHONE NUMBERS Add New Select o -l -] - - X X* X* X* UC700/MC550/UA5200
[ADDRESS Add New Select [} e X X* X* X* UC700/MC550/UA5200
Name M X | X|X X | X 50 X X* X* X* UC700/MC550/UA5200
Type M e - X X* X* X* UC700/MC550/UA5200
Organizations - Add New Notes o X | X[ X]|X]X[X 1000 X X* X* X* UC700/MC550/UA5200
LOCATIONS Add New Select ] e X X* X* X* UC700/MC550/UA5200
PHONE NUMBERS Add New Select o -l -] - - X X* X* X* UC700/MC550/UA5200
First Name Input M X|X|X|X]|X]|X 30 X X X X
Last Name Input M X[ X x| x| X[Xx 30 X X X X
Middle Name Input (e} X|X|X|X]|X]|X 30 X X X X
Display Name Input o x| x| x| x|[x]x] 16 X X X X
Prefix Select o S I B A A - X X X X
Suffix Select o e - X X X X
SIP URI Input o X x| x| x| x]|x 50 X X X X "only one "'@"" must be required Case-sensitive"
SIP Access Server Select o e - Not Assigned X X X X
SIPUA Group Select o e - Not Assigned X X X X
IM URI Input o X[ X[ X X|X[X 50 X X* X* X* UC700/MC550/UA5200 only one "@" must be required
IM Access Server Select o e - Not Assigned X X* X* X* UC700/MC550/UA5200
Voice Mail Server Select o e - X X* X* X* UC700/MC550/UA5200 Not before Voice Mail Server setting
Person iber ID Input o - -] -] -] - - X X* X* X* UC700/MC550/UA5200 Not Voice Mail Server setting
Special Dial Code Input o X X* X* X* UC700/MC550/UA5200
Add Photo Input o e - X X* X* X* UC700/MC550/UA5200
UserDefined1 Input (] UserDefined1 X X* X* X* UC700/MC550/UA5200
UserDefined2 Input o UserDefined2 X X* X* X* UC700/MC550/UA5200
UserDefined3 Input (] UserDefined3 X X* X* X* UC700/MC550/UA5200
UserDefined4 Input o UserDefined4 X X* X* X* UC700/MC550/UA5200
UserDefined5 Input (] UserDefined5 X X* X* X* UC700/MC550/UA5200
UserDefined6 Input ] UserDefined6 X X* X* X* UC700/MC550/UA5200
Note Input o X|X[X]|X]X[X 1000 X X X X
ORI Format URI key parameter Select o N ~ Primary Extension X X X X [:F(’Jrllllz‘v:rr\;gEl;etZ r::salgrbe selecte
Translation pattern regular expression Input o x[x[x[x]-T-] 200 X X X X
LoginID Input M X[ X[ X X|X[X 50 X X X X
New Password Input M X[ x| x| x|-]- - X X X X 8chars or longer, includes 1 number, 1 capital, 1 small, 1 special
Confirm New Password Input M X[ x| x| x|-]- - X X X X Same as above
NTLM Login ID Check o X z z z UC700/MC550
User Login is disabled Check o e X X X X
people Password never expires Check ] Sl -l -l -] -] - X X X X
Db Tool - Import/Export OW5000 Data Check ] Sl -l -l -] -] - X X X X
Role Add Role (OW5000 Administrator Check o Sl - - - Off X X X X
Ci Status Select o e - X X X X
EmployeelD Input M x [ x| x| x]x]x] 20 X X X X
Employee Position Select M Sl -l -l -] -] - - X X* X* X* UA5200
Employee Emplo.yee‘ Type Select ] Sl -l -l -] -] - - X X* X* X* UA5200
O Select ] e - X X X X
Location Select o S I I A I - X X X X
Ct Status Select o e - X X X X
Priority Select M EHN N T R B - 1 X X X X
PBX Name Select M E R R N B - Top of the list X X X X
Primary Extension Extension Select M E I N N - Top of the list X X X X
Secondary Extension
Tertiary Extension * Pilot Number Select ] -l - - z z z z uc700 * Primary Extension only
Dterm Password Input [} X[x| x| x|-1- - X X* X* X* UA5200
Confidentiality Status Select (o] E R R N B - X X X X
Priority Select M S N B R I - 1 X X* X* X* UC700/MC550/UA5200
Contact Method Add New Contact Method PBX Name Select M S I B A - Top of the list X X* X* X* UC700/MC550/UA5200
Assured Mobility WiFi
Other Work Phone Number Extension Select M -l - - - Top of the list X X* X* X* UC700/MC550/UA5200
ireless Dterm Password Input o XXX X]-|- - X X* X* X* UC700/MC550/UA5200
Confidentiality Status Select [} S N B R I - X X* X* X* UC700/MC550/UA5200
Priority Select M E R R N B - 1 X X* X* X* MC550
PBX Name Select M EHN N T R B - Top of the list X X* X* X* MC550
Dual Mode Number
Extension Select M E R R N B - Top of the list X X* X* X* MC550
Confidentiality Status Select o EHN N T R B - X X* X* X* MC550




Appendix C OW5000 Configuration Specification (Cont'd)
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Default Value

Group Application Tab Name Button Name Parameter

Alphabet
2byte KANA
1byte KANA

BOLIBWY YION
(1ay10) BISY
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Country Select M EIN I T R B - - Depend of the E164 counetry X X* X* X* UC700/MC550/UA5200
Number Input M X X* X* X* UC700/MC550/UA5200
Priority Select M e - - 1 X X* X* X* UC700/MC550/UA5200
Alpha Pager
PIN Input M X X* X* X* UC700/MC550/UA5200
Is 2-wgay? Select o e - - No X X* X* X* UC700/MC550/UA5200
Pager Provider Select M Sl -l -l -] -] - - - None X X* X* X* UC700/MC550/UA5200
Confidentiality Status Select ] Sl -l -l -] -] - - - None X X* X* X* UC700/MC550/UA5200
Country Select M EHN I N R B - - Depend of the E164 country X X* X* X* UC700/MC550/UA5200
External Fax Number Input M X| - X|-1-]- 50 - X X* X* X* UC700/MC550/UA5200
External Primary Number
External Secondary Number N ! . . . y "
External Tertiary Number Priority Select M B N B I B - - 1 X X X X UC700/MC550/UA5200
Contact Method (Cont'd) |Add New Contact Method (Cont'd)|Hone Phone Number
Mobile Phone
Phone Pager Confidentiality Status Select o - -] -] - - - None X X* X* X* UC700/MC550/UA5200
Internet Address Input M X[ XX X|X[X 50 - X X* X* X* UC700/MC550/UA5200
Home Email Address Priority Select M R O A (O A - - 1 X X+ X+ X+ UC700/MC550/UA5200

Instant Messageing
Other Email Address
Other Email Pager
Personal Homepage
Text Messagin
People (Con'td) Voice Mail one Confidentiality Status Select o E R R B A - - None X X* X* X* UC700/MC550/UA5200
Work Email Address
[Work Email Pager

Address Type Select M -l - - - - - X z z z UC700/MC550
Country/Region Select ] -] -] - - - Default Country Code X z z z UC700/MC550
Addresses Add New Address Street Imput M X|X[X]|X]X[X X Z Z Z UC700/MC550
Directory (Cont'd) City Imput o X[ x| x| x| X[Xx X z z z UC700/MC550
State/Province Select o S B I A A - - X 4 4 4 UC700/MC550
| Zip/Postal Code Imput o X[-1-1-1-1- 9 X z z z UC700/MC550
From Input M x| x| x|x|x]| 128 - X X X X éssg:n"sl'zsmveu
- Range Delete "ASCI only
To Input o x| x| x| x|x]|x| 128 - X X X X Cave-insensitive”
UserDefined 1 Input M X|X[X]|X]|X[X 25 - X X* X* X* UC700/MC550/UA5200
UserDefined 1(Required) Check o - - X X* X* X* UC700/MC550/UA5200
UserDefined 2 Input M X|X[X]|X]X[X 25 - X X* X* X* UC700/MC550/UA5200
UserDefined 2(Required) Check o -l -] -] - - - X X* X* X* UC700/MC550/UA5200
UserDefined 3 Input M X|X[X]|X]|X[X 25 - X X* X* X* UC700/MC550/UA5200
" ManageC UserDefined 3(Required) Check o -l -] -] - - - X X* X* X* UC700/MC550/UA5200
UserDefined 4 Input M X|X[X]|X]X[X 25 - X X* X* X* UC700/MC550/UA5200
UserDefined 4(Required) Check o -l -] -] - - - X X* X* X* UC700/MC550/UA5200
UserDefined 5 Input M X|X[X]|X]|X[X 25 - X X* X* X* UC700/MC550/UA5200
UserDefined 5(Required) Check o -l -] -] - - - X X* X* X* UC700/MC550/UA5200
UserDefined 6 Input M X|X[X]|X]|X[X 25 - X X* X* X* UC700/MC550/UA5200
UserDefined 6(Required) Check o -l -] -] - - - X X* X* X* UC700/MC550/UA5200
Full Name Format Full Name Format Select M S I I A A - - X X* X* X* UC700/MC550/UA5200
positions _ Add New Position Title Input M X X* X* X* UC700/MC550/UA5200
Abbreviation Input o X X* X* X* UC700/MC550/UA5200
- /Add New Specialty Description Imput M X X* X* X* UC700/MC550/UA5200
User Check o X|X[X]|X]X[X X - - - US Market Only
User Privileges
Employee Check (] X | x| x| x[x]x X - - - US Market Only
LoginID Input M X[ X[ X X|X[X 50 X X X X
New Password Input M X|X|X| x| -]- - - X X X X 8chars or longer, includes 1 number, 1 capital, 1 small, 1 special
Confirm New Password Input M X[ x| x| x|-|- - - X X X X Same as above
NTLM Login ID X Z Z Z
Users -~ - Login is Disabled Check o I R I - - X X X X
Password never expires Check (] - - - - - - - X X X X
Employee Name Input M - - - - - - - X X X X
DbTool - Import/Export OW5000 Data Check (] - - - - - - - X X X X
OW5000 Check o o I I e - - X X X X
Application Data - - -- Value Input M 2000 X X X X
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Tab Name

Button Name

Parameter

Input
Method

Is
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Available Char

Alphabet

Special Chars

2byte KANA

1byte KANA

Default Value

©OLBWY YLION

Sales Regions

z
o
s
»
m
3

3
3

Remark

Select the default country code Select M Sl -l -l -] -] - - - JP X X X X
Reporting Services URL Input M Sl -l -l -] -] - - - http://(server)/ReportServer X X X X
Select the default home page Select M Sl -l -l -] -] - - - X X X X
Password never expires Check M Sl -l -l -] -] - - - X X X X
Default Password Validity Period Input M X[-1-1-1-]- - - X X X X
0.0.0.0 -
» IP Address / Name Input M X[-1-1*|-1- 255.255.255.255 X - X -
General Settings Port Input M - 1-1-1-1-1 s 102565535 X - X 5
SMTP Server Name Input (] X|IX|-]-1-]- - X US Market Only
Server SMTP Port Input (] X|-1-1-1-]- - 1-65535 25 X - - - US Market Only
SMTP Secure Port Input (] X|-1-1-1-]- - 1-65535 X - - - US Market Only
Username Input (] X | X| X| X]|X]|X - X - - - US Market Only
Password Input ] X[ X x| X|X[X - X - - - US Market Only
Sender Email Input ] X[ X x| X|X[X - X - - - US Market Only
Description Input M X|X| X| X]|X]|X 80 - X z z z UC700/MC550
. Country Code Input M XXX X X[X 3 - X Z Z Z UC700/MC550
Add New C g
Countries & States Is Default For Install Check o S I I A X Z Z Z UC700/MC550
Is Default For CountryCode Check (] - - - - - X z z z UC700/MC550
Add New Name Input M XXX X]|X[X 50 X Z Z Z UC700/MC550
Code Input M XXX X]|X[X 50 X Z Z Z UC700/MC550
Profile which has been created by DBtool are listed. The profile which has
Profiles Select M P [ I I I - - X X X X schedule information is NOT listed up. It is selectable when click Schedule
Profile, but not for clicking pencil case
Enabled Check M o I I I e - - X X X X
Recurring Type Select M B EEEE - - Recurring X X X X
Start Date Edit with cale|M X{-{-[-[-1- X X X X
Start Time Select M e 0:00-23:59 X X X X
Recurrence Pattern Occurs Select M Sl -l -l -] -] - Daily X X X X
Daily T-T-1-1T-17- X X X X
Every X Day(s) Select Sl -l -l -] -] - X X X X
X Input X{-1-1-1-1]- 2 1-366 X X X X
Weekly Sl -l -l -] -] - X X X X
Recur every X weeks on: Input o x{-1-1-1-1- X X X X
Sunday Check ] Sl -l -l -] -] - X X X X
Monday Check ] Sl -l -l -] -] - X X X X
Tuesday Check ] Sl -l -l -] -] - X X X X
Wednesday Check ] Sl -l -l -] -] - X X X X
DBTool
Thursday Check ] Sl -l -l -] -] - X X X X
Friday Check ] Sl -l -l -] -] - X X X X
Saturday Check ] Sl -l -l -] -] - X X X X
Monthly Sl -l -l -] -] - X X X X
Day A of every B month(s) Select ] Sl -l -l -] -] - X X X X
A Input o x[-1-1T-1T-1- 2 1-31 (blank) X X X X
B Input o x[-1-1T-1T-1- 2 1-12 (blank) X X X X
The C D of every E month(s) Select ] Sl -l -l -] -] - X X X X
[ Select o o I I I I first X X X X
D Select ] Sl -l -l -] -] - Sunday X X X X
E Input o x[-1-1T-1T-1- 2 1-12 (blank) X X X X
Duration of Recurrence X X X X Available only when #13 is selected
No end Date Select o o I I I e X X X X Default
Profile End By X Select o -1 X X X X
(or click pencil) —
X Edit with cale{O X{-1-1-1-1]- X X X X
Start Date Edit with cale|M X{-[-[-[-1- X X X X
Start Time Select M o I I I e X X X X
Retention Days Input M x[-1-1T-1-1- - - 14 X X X X
File Name Input M X[ X[ X X|X[X - - X X X X
Enabled Check M S I I A I - - X X X X
Recurring Type Select M B EEEE - - Recurring X X X X
Start Date Edit with cale|M X{-{-[-[-1- X X X X
Start Time Select M e 0:00-23:59 X X X X
Recurrence Pattern Occurs Select M Sl -l -l -] -] - Daily X X X X
Daily T-T-1-1T-17- X X X X
Every X Day(s) Select Sl -l -l -] -] - X X X X
X Input X{-1-1-1-1]- 2 1-12 X X X X
Weekly Sl -l -l -] -] - X X X X
Recur every X weeks on: Input o x{-1-1-1-1- X X X X
Sunday Check ] Sl -l -l -] -] - X X X X
Database BackUp Monday Check o Sl -l - -] X X X X
Tuesday Check ] Sl -l -l -] -] - X X X X
Wednesday Check ] Sl -l -l -] -] - X X X X
Thursday Check ] Sl -l -l -] -] - X X X X
Friday Check ] Sl -l -l -] -] - X X X X
Saturday Check ] Sl -l -l -] -] - X X X X
Monthly Sl -l -l -] -] - X X X X
Day A of every B month(s) Select ] Sl -l -l -] -] - X X X X
A Input o x[-1-1T-1T-1- 2 1-31 (blank) X X X X
B Input o x[-1-1T-1T-1- 2 1-12 (blank) X X X X
The C D of every E month(s) Select ] Sl -l -] -] - X X X X
C Select o e first X X X X
D Select ] Sl -l -l -] -] - Sunday X X X X
E Input o x[-1-1T-1-1- 2 1-12 (blank) X X X X
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c
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Group Application Tab Name Button Name Parameter Default Value

Alphabet
*
2byte KANA
1byte KANA
BOLIBWIY YLION
(1ay10) BISY
uoneslddy
paey

Duration of Recurrence X X X X Available only when #13 is selected
No end Date Select o S I I A I X X X X Default
y Database Backup (Cont'd) |Schedule Profile (or click Pencil it End By X Select o S B B H S X X X X
Settings (Contd) X Edit with cale|O x[-1-1T-1T-1- X X X X
Start Date Edit with cale|M X{-[-[-[-]- X X X X
Start Time Select M S I I A I X X X X
History -- -- - X X X X
 Template Type Select M Sl -l -l -] -] - X X X X
[ Template Name Select M Sl -l -l -] -] - 100 X X X X
SIP Access Server Select o S I I I e X X X X
IM Access Server Select o S I I I e X X X X
SIPUA Group Select ] Sl -l -l -] -] - X X X X
Prefix Check o o I I I I X X X X
Suffix Check o e X X X X
Voice Mail Server Check o o I I I I X X X X
1D Check o e X X X X
Special Dial Code Check ] Sl -l -l -] -] - X X X X
Add Photo Check o o I I I I X X X X
Note Check o o I I I I X X X X
UserDefined1 Check o o I I I I X X X X
UserDefined2 Check o o I I I I X X X X
UserDefined3 Check o o I I I I X X X X
UserDefined4 Check o o I I I I X X X X
Templates Template Management [Add New Template UserDefined5 Check ] e X X X X
UserDefined6 Check o o I I I I X X X X
Employee Check ] Sl -l -l -] -] - X X X X
Guest Check o S I I I e X X X X
Patient Check o S I I I e X X X X
Physician Check ] Sl -l -l -] -] - X X X X
Student Check o S I I I e X X X X
User Check o S I I I e X X X X
Primary Email Check ] Sl -l -l -] -] - X X X X
ExchangeServer Select ] Sl -l -l -] -] - X X X X
[ACD Login Check o e X X* X* X*
[ACD Server Name Select o e X X* X* X*
CONTACT METHODS Check o e X X X X
Billing Check ] Sl -l -l -] -] - X X X X
Home Check o o I I I e X X X X
Shipping Check ] Sl -l -l -] -] - X X X X
\Work Check o o I I I e X X X X
Enable MA4000 Intagration Check M Sl -l -l -] -] - X - - - US Market Only
OW5000 Base URL Input M X - - - US Market Only
MA4000 Base URL Input M X - - - US Market Only
Login Input M X - - - US Market Only
Passeord Input M X - - - US Market Only
Server Name Input M X - - - US Market Only
N - Input ] X - - - US Market Only
Login Input M X - - - US Market Only
Passeord Input M X - - - US Market Only
Database Name Input M X - - - US Market Only
. DB Sync Listen Port Input M x[-1-1T-1T-1- X B B B US Market Only
MA4000 Integration |- Synchronize Prime Lines in MA4000 as Extensions in OW500) Select o T-T-1T-1T-1T-1 - - In Ascending Order X . . . US Market Only
zm;gg;mze Line Appearances in MA4000 as Sublines in (S:QI(::I: o oo . . Only ringing Line Appearances X R R R US Market Only
Contact Method Email Select o AR - - X - - - US Market Only
Contact Method Extension 1 Select ] -] -] - - - X - - - US Market Only
Contact Method Extension 2 Select (] -] -] -] - - X - - - US Market Only
Contact Method Extension 3 Select [] Sl -] -] - - - X - - - US Market Only
- ) Unit Type Hierarchy to import MA4000 Units Select o T-1T-1T-1T-1- - B X - - - US Market Only
Auto Create UC700 Users Check (] -l -] -] - - X - - - US Market Only
SIP Access Server Select (] -l - - - - - - X - - - US Market Only
IM Access Server Select o -] - - X - - - US Market Only
Version Information |-- - - - X X X X




Appendix C OW5000 Configuration Specification (Cont'd)

Available Char Sales Regions
z
_ < < g G > >
Input Is T z z a = o 8
Group Application Tab Name Button Name Parameter -1 < < Default Value = = ® =Ny Remark
Method Mandatory =y i‘) i‘) > B 3 D
= 28 3 = 23
< 3 3 g r 3 st
] 3 5 5 g S
3 B
@
Start Date Select o R I I I e - - X X X X
End Date Input ] Sl -l -l -] -] - - - X X X X
View Logs - Sender IM Uri Select o -l - - - - - - X X X X
Receiver IM Uri Check o S I I A I - - X X X X
IM Text Input o - - - X X X X
IM Log Age Input M x[-1-1T-1-1- 3 X X X X
Maximum File Size Input M X[-1-1-1-]- 3 1-500 X X X X
IM Archiving Password Input M X[ x| x| x|-]- - X X X X
Enabled Check M S I I A I - - X X X X
Recurring Type Select M B EEEE - - Recurring X X X X
Start Date Edit with cale|M X{-[-[-[-]- X X X X
Start Time Select M e 0:00-23:59 X X X X
Recurrence Pattern Occurs Select M Sl -l -l -] -] - Daily X X X X
Daily T-T-1-1T-1- X X X X
Every X Day(s) Select ] Sl -l -l -] -] - X X X X
X Input o X{-1-1-1-1]- 2 1-12 X X X X
Weekly Sl -l -l -] -] - X X X X
Recur every X weeks on: Input o x{-1-1-1-1- X X X X
Sunday Check ] Sl -l -l -] -] - X X X X
. Monday Check o e X X X X
IMs IM Archiving Management
Tuesday Check ] Sl -l -l -] -] - X X X X
Wednesday Check ] Sl -l -l -] -] - X X X X
Configure
Thursday Check ] Sl -l -l -] -] - X X X X
Friday Check ] Sl -l -l -] -] - X X X X
Saturday Check ] Sl -l -l -] -] - X X X X
Monthly Sl -l -l -] -] - X X X X
Day A of every B month(s) Select ] Sl -l -l -] -] - X X X X
A Input o x[-1-1T-1-71- 2 1-31 (blank) X X X X
B Input o x[-1-1T-1-1- 2 1-12 (blank) X X X X
The C D of every E month(s) Select ] Sl -l -l -] -] - X X X X
[ Select o S I I I e first X X X X
D Select ] Sl -l -l -] -] - Sunday X X X X
E Input o x[-1-1T-1-1- 2 1-12 (blank) X X X X
Duration of Recurrence X X X X Available only when #13 is selected
No end Date Select o S I I I e X X X X Default
End By X Select ] Sl -l -l -] -] - X X X X
X Edit with cale{O X{-1-1-1-1]- X X X X
Start Date Edit with cale|M X{-{-[-[-1- X X X X
Start Time Select M o I I I I X X X X
History - - - - - O O R R e e - X X X X
General Settings - (When Outlook Expires Select M Sl -l -l -] -] - z z z z UC700/MC550
Email Server Type Select M -] -] - - - z z z z UC700/MC550
Exchange Server Input M X | X | X|X 255 z z z z UC700/MC550
Admin Input M X[ X|XxX]Xx 255 z z z z UC700/MC550
Admin Input M 255 z z Z z UC700/MC550
Calendar Link Calendar Link . ~ -
Emalil Servers Add New Email Server Link Admin Email Input o X | X[ Xx]Xx 255 z z z z UC700/MC550
Domain Controller Input M X | X | X|X 255 z z z z UC700/MC550
Active Directory User Input M X[ X]XxX]X 255 z z z z UC700/MC550
Active Directory User Password Input M X | X | X|X 255 z z z z UC700/MC550
Domino Server Input M X[ X|XxX]X 255 z z z z UC700/MC550
Client Settings - -- z z z z UC700
Allow clients to search for employees in Select ] -] -] - - All Companies z z z z UC700
Display Home Phone Select (] -l - - - - - - Never z z z z UC700
General Settings - -
Display Mobile Phone Select ] -] -] - - - Always z z z z UC700
Ping Interval Input M Xl -1-1-1-1- 2 1to 60 10 z z z z UC700
Collaboration Support Select [] - - - - ) - Enabled z z z z UC700
uc700 - Server Protocol Select o Sl -l - -] - HTTP Z Z Z Z UC700
Collaboration Settings -
Server URI Input o X[ x| x| x|-|- - - z z z z UC700
Server Port Input o X1 -{-1-1-1- 5 1025 - 65535 80 z Z Z Z UC700
. Enable UC700 Conferencing Select o - Enabled z z z z UC700
Conference Configuration
Conferencing Server Port Number Input (o] Xl -1-1-1-1- 5 1025 - 65535 8731 z z z z UC700
ACD server name Select M Sl -] - z - - - uc700 US Market Only
ACD Accounts -
ACD Login Input M x[-1-T-1T-1- - 1- z - - - UC700 US Market Only
X |Supported
X* [Display but supported only for the application described in Related Application
Z |Display only when the application described in Related Application is installed
- |Not Supported
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Appendix D - 1

OW5000 Administrator

Configuration Specification

Appendix D-1 Configuration Specification

OW5000 API usCSTA
Application  TabName ~ Cal Comtrol APl = OWSO00APL ) oq/n0gngeqra. SIMPLE
PP Call Notifications Information API ; g Sip Presence
AP tion
SIPUA Group - - -
Wait maximum 30 min or
Access Control Grogglﬁf(;ess - - - Restart All
OWAccessServers
PBX Based Control - - -
Applied Immediately
(except Phone Type and
. . . . . SIPURL. Ifth I
Extensions - Applied Immediately Applied Immediately modifi ed,wai(tasrﬁa\;aimﬁ;agg
min or Restart All
OWAccessServers.)
External Numbers - - - -
Restart (Remote Call
Enable PBXs - Control)
i Wait maximum 30 min or
icenses Enable Extensions Applied Immediately Restart Al
Platform OWAccessServers.
Licensed Information - - -
Pager Providers ) ) ) )
PBX Settings Restart System
Locations Wiait maximum 60
min or Restart IIS
AreaCode Rules and OWTelephony Restarggﬁggte Call
PBXs PBX >PBX Dialing | Event Notification
Reserved Numbers
Voice Mail Pilot ) ) )
Numbers
Route/Trunks - - - -
Serial Ports - - - -
Voice Mail Servers - - - -

UCE Application Platform (UNIVERGE OW5000) Configuration Guide




Appendix D - 2 OW5000 Administrator Configuration Specification

OW5000 API usCSTA
o Call Control APl OW5000 API SIMPLE
Sl AT DLELES Call Notifications Information API LCSIO(:iilzntegra- Sip Presence
API
Access Server(Local) - - Wait maximum 30 min or
Restart All OW/
Access Server(REMOTE) - - - AccessServers
Restart OW5000
Access Server(PSGW) - - - Application Message
Service
Wait maximum 30 min or
Routing Info - - - Restart All OW/
AccessServers
o Conference ) ) )
Applications | o terence Server Manager
PBX Settings - - -
Server Settings - s -
Incoming Call Redirect
Assistant Configurations
PBX Settings - - -
Server Settings - s -
Location Stat :
‘)I%?O'?nq aSti glnus Message Settings - - -
PBX Settings - - -
) Server Settings ) - -
OaiServer - Restart (OaiServer)
PBX Settings
General Settings - -
Remote Call Control 9 RestargRimFte Cal
Normalization Rule - - ontrol)
Categories - - - -
DIDs - - - -
Locations - - - -
Organizations - - - -
) Applied Immediately
Person Applied Immediately
Role
People Contact Method Applied Immediately
Directory Addresses - - -
Full Name Format - - -
Positions - - - -
Specialties - - - -
Organizations - - -
o Locations - - -
User Privileges
Roles - - -
Security - - -
Users - Applied Immediately -

UCE Application Platform (UNIVERGE OW5000) Configuration Guide
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OWS5000 API usCSTA

Application Tab Name CElCmAE A Dl LCS/OCS Integra- =L

Call Notifications Information API
API

tion Sip Presence

Application Data - - - - -

General Settings - s -
Schedule - . -

Settings -

MA4000
Integration

Version
Information

UCE Application Platform (UNIVERGE OW5000) Configuration Guide
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